


T
THERE IS A joke going on around the country, and it
is called broadband.

It has been a joke for quite some time now, but
what grabs our attention is that companies selling
‘broadband services’ are actually going to town about
how fast their speeds are, and how cheap their rates
are. The lowest quoted rates “start at Rs 240.”

The definition of Broadband, according to the new
Broadband Policy of the Indian Government, is a
service that is capable of “minimum download speeds
of 256 Kbps.”

Here is the real deal, the bitter truth. In almost all
cases, home broadband in India has always meant
speeds of 128 Kbps. And we are not even talking last
mile here, as users of cable Internet have found to
their chagrin for quite some time now.

So who are the so-called broadband service
providers fooling? Well… you.

Call up any Internet service provider in India, and
the well-trained, well-accented customer service rep-
resentative would say that his company provides
broadband services at speeds of 128 Kbps.

I asked a national-level service provider: “Will I
always get speeds of 128 Kbps?” 

Their reply: “No Sir, not always. But most times,
definitely. It would depend on traffic on that partic-
ular day. It could range from 64 Kbps to 128 Kbps.”

Next question: “Do you know that the government
of India has specified that the minimum download
speed at the last mile should be 256 Kbps for your
service to even be called broadband?”

The reply: “Umm, maybe, Sir. But I am only going
by what has been told to me, Sir.” Click. Hang up.

In the US, 51.42 per cent of all home users of the
Internet have broadband, while a mind-boggling 79.06
per cent of all office users have at least a T1 line to
access the Internet. The corresponding figure for
India? 0.02 per cent, according to the Department of
Telecommunications.

The US figures were not created by magic, but
because bandwidth has been freed up, and the gov-
ernment does not interfere with implementation.

Broadband is not a luxury. It is the fuel for growth,
the seed that needs to be watered for a wide variety of
personal and business applications. Lives can be saved

when hospitals implement telemedicine over broad-
band; companies save lakhs in travel costs by imple-
menting video-conferencing; international calls could
be made cheaper, boosting business.

These applications are only the tip of the iceberg.
Service providers are making a mockery of broad-

band in this country, losing customer trust each day.
When real broadband providers enter the home
market, it will be scepticism that will greet them. It
will not be a happy situation.

The joke going on around the country—called
broadband—it’s on us.

How Broad Is Your Broadband?

Editorial

“Who are the
‘broadband’ service
providers fooling?

Well... You”

Sachin Kalbag Executive Editor

sachin_kalbag@jasubhai.com
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We show you how you can set up a
professional Web site for as little as 
Rs 400 a year
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52 Second Chances
Don’t lose your data! Back it up. We test backup
solutions to help you choose

49 Making Sense Of The Mad Ad World
Find out how providing web-based advertising
solutions can turn into a moneyspinner 

36 Banks On Technology
Louiz Banks, The God of Jazz, talks
about music and technology

44 Masters Of The Game
Fourteen boys from Bangalore and
their 3D game. Watch out, world!

Digital Tools

70 Ten Great Things Your Fixed 
Wireless Terminal Offers
Wondering what’s so special about a fixed
wireless terminal? Find out

37 The b3nd!ng ov the rul3z
Will the English language survive the
onslaught of technology? 

42 Geek Dreams
How about a fully-functional
computer in your pocket? Dig into 
the OQO Model 01!

66 New & Notable
Reviewed this month: the Toshiba e400
Pocket PC, the O2 Xda II PDA/phone, the
Nokia 7610, and more!
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A comprehensive listing of all the cell
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Any story related to
communication
will have this logo
displayed alongside
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119 IT Cuts Red Tape
Find out how ELCOT, the IT department of
Tamil Nadu, went paperless using a software
tool called “e-Administration”

122 Laser-Sharp
Your businees needs a printing solution. We
help you pick the best laser printers

136 Business
On Your Mobile
Mobile service
providers are
increasingly 
customising their
offerings to suit
your needs

134 Dial IP For Internet
Internet Telephony can save you a lot of money. 
We demystify the technology involved
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Telemedicine can make the
dream of healthcare for all 
come true

All You Wanted To Know About Buying Cell Phones!
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GAMERS

DOOM 3 Demo
462 MB Demo: One of the most
awaited game demos of this year.
Whether you run Windows or Linux, we
provide you with the demo and latest
updates for DOOM 3

UT2004 ECE Bonus Pack 
The Editor’s Choice Edition bonus pack
for Unreal Tournament 2004 — 84.4
MB; six new characters; three new
vehicles; four new maps

DEV TOOLS
J2SE 5.0 Runtime Engine (JRE)
Windows / Linux
Java 2 Standard Edition 1.5 (J2SE 5.0)
Documentation
J2SE 5.0 Software Developer Toolkit
(JDK) Windows / Linux
Borland’s JBuilder
Borland C# Builder Personal 1.0

GAME VIDEO
Prince of Persia 2 - Free Form Fighting

GAMERS
Latest Retail v1.1 update/patch for
DOOM 3—both Windows and Linux

GAME VIDEO
Vampire the Masquerade - Bloodlines

SOFTWARE
Resource Hacker 3.4.0
MaSaI Editor 1.6.16 
SwisSQL - SQL Server to Oracle Edition 1.8

CONTRIBUTIONS
World Time
Madhyam
Colour Studio
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NNoottee  11:: Grey areas show the content available on the CD. The DVD contains all that is on the CD
NNoottee  22::  If you do not want to boot from the CD, remove it from the drive at startup
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MULTIMEDIA
■ ACDSee PowerPack 7.0
■ Media Audio Cutter 1.0
■ IPIX Interactive Studio 1.3
■ 3D-Album PicturePro 3.14
■ Paint Shop Pro 9.0

INTERNET
■ 3B Browser 1.0
■ DownloadStudio 2.0
TIPS & TRICKS SINCE JANUARY 2003
PAST 13 ISSUES OF DIGIT IN PDF

SYSTEM
■ Latest Nero 6 updates 

(four packages) 
■ CyberScrub AntiVirus Lifetime Edition 
MOBILE
■ Adobe Reader 3.05 (Palm OS)
■ Palm Desktop 4.0.1
■ Oxygen Phone Manager II for Nokia
Phones 2.2.2

■ Hero Commando (Limited Level Version)
■ Pocket Quake (ARM) 0.062
■ Mobile PhotoPleasure 1.7
■ Polyphonic Wizard 3.7
■ PocketFMS 0.9.52

FROM THE MAG
■ mIRC
■ Trillian 0.74i
■ Messenger Plus 3.2
■ Invision 2.0 Build 3515
■ Yahoo! Messenger 6.0.0.1643
■ ICQ 4 Lite and ICQ Pro 2003b

MULTIMEDIA
■ Audiophiler 1.3.3
■ Dr.Tag Plus 2.0.1
■ Bravo Player 1.2
■ ACDSee PowerPack 7.0

INTERNET
■ KazaaGhost 2.0
■ SpyBlocker 8.1
■ Maxthon (formerly MyIE2) 1.1.035
■ 27 Tools-in-1 Wichio Browser 3.5

SYSTEM 
■ Antiy Ghostbusters Professional
■ VIA Envy24 Family Driver 3.24c
■ Kaspersky Anti-Virus Personal 5.0

PLUS
Learn how to design better Web sites!
Look for the free Web Design tutorials
from ImageOnline

OPEN SOURCE
FreeBSD 5.2
Touted as the next step
up from Linux, try your
hand at FreeBSD—the
most stable and trusted
Open Source OS there is
today. It’s perfect for
both Server and
Desktop
implementation. We
provide you with both
ISOs for a full free
install, with all the
originally bundled
applications

PRODUCTIVITY TOOLS
Microsoft OneNote
2005
Microsoft Office OneNote 2003 gives
you an easier way to organise, and find
your notes and
information.
With OneNote
2003, you get
the flexibility to
do even more.
Capture
virtually any
type of
information
and share it
easily 

WHITE PAPERS
Fast Ethernet
■ Network Performance Evaluation on
an IBM e325 Opteron Cluster
■ Cisco Nonstop Forwarding and Timer
Manipulation for Fast Convergence 
■ Cisco ONS 15302 and ONS 15305
Ethernet Over SDH Connection Services 
■ Maximizing Performance of a Gigabit
Ethernet NIC Interface 
■ 10-Gigabit Ethernet Technology Brief 

PRODUCTIVITY TOOLS
■ WorkgroupShare for Outlook 1.5.6
■ SERglobalBrain Personal Edition 1.7.1
■ NewWayService 2.18

BIG GAMES
Tribes Vengeance
The Empire of the Tribes is back. We
give you the 374 MB demo

Scrapland [287 MB]
Over 40 hours of single-player gameplay
and fantastic multiplayer action

MOVIE TRAILERS
■ Cellular
■ The Incredibles

BIG GAMES
Shade: Wrath of Angels
Miracles and murder; all leading to Hell
on Earth

MOVIE TRAILERS
■ Ju-On: The Grudge
■ Resident Evil: Apocalypse

BY DEMAND
■ Winamp skins
■ Desktop themes

MUSIC
Full Free Soundtrack from the game:
The Chronicles of Riddick: Escape from
Butchers Bay

World’s most

popular

MMORPG

Goof-up:
Last month’s DVD with the ELX Biz Desktop
4.0 ISO was supposed to have the following
disclaimer mentioned:
“This is an evaluation copy of ELX BizDesktop
4.0 for non-commercial use only. To use ELX
products for business and commercial use,
visit www.elxlinux.com or e-mail
info@elxlinux.com.”
Our apologises to ELX and our readers for any
inconvenience caused by the oversight
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By Demand
You get to choose what goes on Digit
Interactive. This month, you chose:

Desktop themes
Winamp skins
Nero 6 updates

Online Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit. com

Last Month’s Question:

Apart from making and receiving phone
calls, what else do you use your mobile
phone for?

Digit Reader Poll

This Month’s Question

How much did you spend
on technology (computers,
phones, audio equipment,
etc.) this year so far?

Less than Rs 10,000
Rs 10-20,000
Rs 20-50,000
More than Rs 50,000

Log onto www.thinkdigit.com
and vote

General Discussion
From Linkin’ Park to Doom III, 
it’s all here

Digit Discussion
Your feedback on the Magazine, the

DVD, the CD and the Web site

QnA
Thousands of answers to every 

hardware or software query you have

Bazaar
Have money, will buy! Buy 
or exchange hardware or
software

DIGIT NOVEMBER 2004

taste technology at www.thinkdigit.com

Subscribe
No more snail-mail! No need to visit
post offices! All you have to do is log on
to www.thinkdigit.com/subscribe and 
use your Credit Card to make sure you
never miss another issue of your
favourite magazine!

November 2004

Software Discussion
Discuss software—from the best
tools to the greatest games

Hardware Discussion
The hangout haven for 
hardware geeks

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum
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He’s A Sony
Kapil Dev
Cricketing Legend

He led India to its sole
World Cup win in 1983,

and ended his 16-year long
career as the highest wicket
taker in test cricket. He now
commentates and plays golf.
What does technology mean
to you?
It means progress.

Technology gives you
knowledge; the

evolution of man
from a caveman to
a master of
machines shows its

effect on our living.
How do you use

technology in
everyday life?
I am an SMS-freak, and my
office uses technology to the
maximum. Thanks to my PC,
and the Internet, I get
reports in no time.
How has technology
influenced sports?
Cricket has benefited a lot.
Run-out decisions have been
eased, thanks to Hawkeye.
Also, we get a better
perspective of any match,
unlike the old times where
there was just a replay
mechanism for viewers. 
Can technology ever replace
umpiring?
The instant reaction that one
gets from an umpire can
hardly be replaced by any
machine. Technology will
always assist umpiring. It is
fun to see the umpire’s hand
going up rather than wait for
the red light to flash.
Who is more tech savvy—
your wife or daughter?
My daughter Amya is growing
up with technology and so I
think she is way ahead of
both of us when it comes to
using technology. 

Aparna Krishnakumar

DREAM ROBOT

Hi-fi Through Wi-Fi
Creative’s “Sound Blaster Wireless Music” uses a Wi-Fi
network to stream your MP3s to your stereo. The idea
is that you keep your PC and wireless access point in
one room, the receiver and the stereo in another,
while you sit with your remote in a third room.

ATMs At Worm Risk?
Some anti-virus firms, including Trend Micro and
Computer Associates, are trying to create a new
market for themselves—by persuading banks, that
ATMs running Windows need protection from
worms. Rival companies are questioning this.

It’s a cross between the
Asimo and the Aibo: it’s

humanoid, like the Honda
Asimo, and it’s a pet, like the
Sony Aibo. It’s QRIO, Sony’s
“Dream Robot”—a “Small
Biped Entertainment Robot”
under development by Sony
Corporation.

Walking
properly, not
falling, and so
on, are feats
amazing in
themselves; but what is
probably most
fascinating about QRIO
is that it recognises
and understand 
spoken sentences, and
responds through
voice and body
gestures. 

How cool is that?
As if that were not
enough, QRIO can also
distinguish individuals by
vocal and facial features! By
memorising and using
information specific to an
individual, QRIO will
actually be able to hold
“intimate” and “rich”
conversations.

So has the future finally
arrived? A little pet
“entertainment” robot that
holds conversations sure
sounds like the future.

QRIO is capable of
sensing and understanding
its environment in three
dimensions. It can locate the
direction of a sound. It can
walk avoiding obstacles,
courtesy its stereo camera.
With suitable landmarks
around, QRIO will be able to
kick a football. It can adapt
to “inclined and irregular

terrain.” It can walk,
swagger, and dance. It will
re-stabilise itself when
“external forces affect its
balance.” And when it does
fall over, it can bend over
backwards to minimise the
shock of the fall.

With such a
repertoire, we are

tempted to call QRIO
a “he” rather than
an “it” (He
definitely looks
male). QRIO is
powered by three
64-bit RISC
processors, and
just three 64 MB
DRAM sticks. He

weighs about seven
kilos with his battery.
We’re wondering how
much he will cost if
and when he hits the

shelves.

MUKESH AMBANI

The Most
Influential
Person In
Telecom

Mukesh Ambani,
chairman of Reliance

Infocomm and now,
chairman of FLAG Telecom,
has won this year’s
prestigious World
Communication Award as
the “most influential person
in telecommunications in
2004”. Ed McCormack,
Executive Vice President,
Corporate Development,

FLAG Telecom, received the
award on the night of
October 11 on behalf of
Ambani at a ceremony at
London.

The World
Communications Awards are
sponsored by the leading
global telecom publication,
Total Telecom. The most
influential person in
telecommunications is
chosen by the publication’s
readers.

Acknowledging the
honour, Ambani said in a
statement: “The award is …
associated with a
recognition of the rapidly
growing influence of India
in the global telecom arena.

“In India, Reliance
Infocomm is spearheading a
massive telecom revolution
with the vision to become a

major global player over the
next decade.  Also, the
strategic acquisition of FLAG
Telecom will place India at
the forefront of the global
broadband revolution.”

Here’s the interesting
part for the rest of us:

Enter

Mukesh Ambani, is the “most
influential person in telecom-
munications”
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Ambani said that today,
Reliance Infocomm has
already constructed a pan-
India optical fibre network,
which will expand to over
100,000 kilometres of optical
fibre, and which will connect
nearly 5,000 cities and towns
by the year end. The network
will provide broadband
connections to millions of
homes and offices, offering
the latest technology and
direct connectivity to the
rest of the world via the
FLAG Telecom global
network.

India’s teledensity—fixed
and mobile—is currently at
less than nine per cent.
Future growth potential is,
therefore, staggering.

SERVER SOFTWARE

Microsoft vs
Linux. Again!

Microsoft is preparing to
hit Linux where it hurts.

By designing server software
that is secure, modular and
affordable, Microsoft hopes
to be more competitive
against Linux variants.
Microsoft’s Longhorn—the
codename for the successor
to its Windows XP operating
system—is designed to be very
modular in nature. 

This should give
Longhorn advantages that
Linux currently enjoys. Being
modular lets a company
either use or discard
components it does not need. 

This flexibility facilitates
not just speed of deployment,
but also security. Currently,
Microsoft’s server and
desktop operating systems

are based on the same
unifying architecture. This
leads to extraneous features
for a server system, which is
an unnecessary security risk.

By virtue of such a
design, Microsoft also aims
to be more affordable—both
in terms of initial
investment as well as total
cost of ownership, as per
maintenance costs. The
biggest attraction of Linux is
that it is open to tinkering.
Governments and
businesses can create
customised operating
systems from the Linux
kernel by adding to or
dropping services and
features they do not need.
This flexibility has seen
Linux gain a foothold
within the market;
Microsoft’s Longhorn hopes
to flatten the competition.

LOGGING PERSONAL
INFORMATION

Is India
Going The
China Way?

All around India,
governments are

considering edicts, which, if
passed, will make it
compulsory for cyber-cafés
to log personal information
about their customers. First
up, the Karnataka
Government is seriously
mulling over such an act. If
passed, a user will need to
supply personal
information—name and
address, to begin with—and
show an ID card when using
the services of a cyber-café,

failing which the person
concerned will need to be
photographed. The
information gathered will
need to be maintained for at
least one year, during which
period it will be open to
regular scrutiny by the
police force.

The idea is to curb
cybercrime. The reaction to
this has been largely
negative. Apart from the
inconvenience it will cause
potential customers, the
effectiveness of such a 
register has itself been
questioned.

Ashish Saboo, cyber-café
owner and President of the
Association of Public
Internet Access Providers,
opines, “…keeping this type
of register is completely
ineffective to fight
computer fraud or cyber-
terrorism.”

The Web site of the
Calcutta police was recently

Mihir Hardikar, MumbaiAsmita Parelkar, Mumbai
Amit Tankaria, Mumbai

Cell phones
According to
Gartner,
cellular
connections in
India will reach
56 million by
the end of
2004, a 96 per

cent growth over 2003

Landline phones
India today
has more
mobiles than
landline
phones at this
point in time (end-October).
By September-end, landlines
(43.82 m) were slightly more
than mobiles (42.97 m)

Ahh, that’s supposed to beKilobytes per secondFrankly, I do not know what it stands for

It’s Kilobytes per second, for sure!

Oh yes, it’s Kilobytes per sec,that’s easy!
It’s Kilobytes per second

Ramaswamy Kuppuswamy ,

Hyderabad

Suraj Anand, Pune

Security Watch

Microsoft Word
Vulnerability

The Problem
On October 7, it was made
public that a buffer
overflow can be exploited in

a Microsoft Word document.
An attacker could create a
Word document that causes
Word to crash when you
open the document. What
compounds the problem is
that it’s very likely that
someone will open a Word
document that comes as an
e-mail attachment. Also, IE
often opens Word
documents in a browser
window without asking the
user if he wants to open it.
The vulnerability has been
confirmed in Microsoft
Word 2000, but has also
been reported in MS Word
2002.

Damages
Secunia rates this as “highly
critical.” An attacker could
gain access to your system
and launch DoS attacks.

Precautions
Open only trusted Word
documents. IE users, set the
security level for the
“Internet” security zone to
“High,” or disable the “File
download” setting. At the
time of going to print, there
was no patch available.

One Silly Question What is KBps?
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Online Education Courses

www.egurucool.com
This Web site offers online Maths and
Science tutorials for CBSE, ICSE and
IIT-JEE. You need to buy the courses.
The “Course Catalogue” runs you
through the varied tutorials along
with their price. Once the quote is
bought, just follow the steps given to
activate it and you are all set to go.

www.netvarsity.com
This NIIT-run site offers a range of
courses in IT, soft skills and project
management—from the cost-effective
90-day “silver” subscription to the
value-added six-month “platinum”
subscription. The courses train you
in leadership skills, prepare you for
IT-certified courses, etc.

www.bbc.co.uk/learning/courses/in
dex.shtml
This is one place that offers its
courses for free. Be it basic
computer skills, gardening, history
and journalism, you will find it all
here. Make it a point to visit the
Languages section. the modules
here are ordered, and concise
enough to arouse interest.

egurucool.com

Netvarsity.com

BBC Learning

hacked and
turned into a
porn site.
Following that
incidence, a
Calcutta
proposal will
make it
mandatory
for a cyber-
café to not
only register their
customers, but also log the
Web sites they visit.

The Mumbai police, too,
are considering a similar
diktat. Under the proposed
system, a cyber-café will
need a license to operate.
The licensing norm will
entail café owners shelling
out an annual fee, and only
those with a photo-identity
will have access to cyber-
cafés. Registering of
customers, and maintenance
of customer details will then
need to be submitted to
Mumbai Police HQ. 

Apart from cybercrime,
officials are also keen on
cutting down on
pornography by mandating
the use of software filters at
the expense of café owners.

Most cyber-café owners
are small entrepreneurs
looking to make a low-

margin living in
an increasingly
competitive
space—estimates
put the number
of cafés in India
at 3 lakh.  

Regulations
such as these

will only remove
from the bottom-line

of most of these small
businesses. Saboo says,
“These new measures are
likely to dissuade many
Internet users from going to
cyber-cafés, and could lead
to the closure of almost half
of them.”

WINDOWS XP STARTER
EDITION

Emasculated
Windows For
India

Microsoft has announced
plans to introduce

Windows XP Starter Edition
to India in 2005—this is the
low cost, feature-light
variant of its Windows XP
operating system. The
underlying theme, of course,

GERMANY

CHINA

UNITED KINGDOM

A Round-up of Technology News from Across the GlobeThe Digital World

UNITED STATES

According to newly published research,
total US household spending on
wireless services has overtaken land-
line spending, to account for the bulk of
dollars spent on telecom services

According to a far-reaching UK
education report, technology should be
moved to the heart of the school
curriculum. Former Chief Inspector of
Schools, Mike Tomlinson’s review has
called for the most radical changes to
teaching in 50 years

Nico Morawa hurled his handset a
distance of 67.5 metres. He is claiming
the title of “World Mobile Phone-
Chucking Champion.” This was set in a
cell phone chucking event on October
17. Morawa beat 70 other contestants

BRAZIL

Police arrested 53 people for allegedly
stealing $30 million from online bank
accounts. The suspects targeted
thousands of online banking customers
by sending e-mails containing Trojan
horses, a type of virus able to collect
information on Internet bank accounts

October 18, Zhang Qingwei, President of
the China Aerospace Science and
Technology Corp (CASC), said that China
will launch its second manned space flight
next year. The spacecraft, the Shenzhou
VI, will spend five to seven days in space
with more than one person aboard

IRAQ

Three Incredibly Useful Sites

John Martinkus, an Australian
journalist, was freed by his captors
on October 17 after they Googled his
name to check if he was telling the
truth about his affiliation with public
broadcaster SBS

Illustrations Harsho Mohan Chattoraj
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is the low cost; Microsoft
hopes to cut down on
rampant piracy of its
operating systems. Sources
suggest the price will be in
the vicinity of Rs 2,000.

Starter Edition will be
light on features and is
aimed solely at entry-level
systems from computer
makers Acer, Hewlett-
Packard, HCL and Wipro.

The variant will not
compete with its higher
priced brethren—the ability
to do home networking has
been cut off. So has the
feature that allows more
than one user to use a
single PC. Additionally, the
OS will only allow a
maximum screen
resolution of 800 x 600.
Most importantly, a user
will be limited to multi-

tasking solely between
three open windows or
foreground applications.

When it comes to
regional languages, the
Starter Edition will initially
only support Hindi; the
company says it might add
additional languages in the
future. It will also sport
some seemingly inane
“features” such as localised
wallpapers and screensavers
(perhaps the rolling green of
a default XP installation will
be replaced by a picture of
the Taj Mahal?)

Windows XP Starter
Edition seems like a sweet
deal to OEMs, so that they
are not tempted to look to
Linux for cheaper solutions.
Microsoft is apparently
content with targeting first-
time users of computers
instead of offering
genuinely low-cost and
feature-rich solutions to a
price-sensitive market. The
effectiveness of the Starter
Edition to curb piracy
remains to be seen—how
soon will a user switch to a
“cheaper” and fully-featured
Windows XP? 

As soon as his or her
friend hands over a copy, we
imagine.

REAL-WORLD APPLICATIONS
CONTEST

ZDNet India
Developer
Challenge

ZDNet India
(www.zdnetindia.com),
India’s leading

technology portal, has
announced the country’s
first ever Linux and Web
Services developer contests

on the IBM Platform. The
contest is open to both teams
and individual developers.

The ZDNet India
Developer Challenge
comprises two different
contests—a Linux
Development Contest and a
Web Services Development
Contest for Windows. A
panel of judges from the
Industry will evaluate entries
based on functionality,
elegance and other factors.
The first three entries in
each category will be
awarded an IBM ThinkCentre

Pulse

Digit Caption
Sachin! How’s the elbow?

Every month, Digit will carry a
funny caption for a photo. Come
up with something funnier, and
beat them at their own game!

Photograph Mexy Xavier

Headphones
Rediff.com has a
huge range of
headphones to
offer. 

From stereo
headphones to
mono headsets for

cellular phones, Rediff.com offers a
healthy variety. Check the site out for
some good deals. 

Right from the HB Dynamic
stereo headphones that cost as little
as Rs 295 to the wireless variety
from Portasound that start from Rs
799. If 5.1-channel headphones are
what you are looking for, you can buy
them as well for as little as Rs 2,199. 

MP3 Players
While still on
Rediff.com, choose
from a range of
MP3 players.

Save Rs 1,250
as you snap up the
Che-ez MP3 player

or opt for the high-end anti-shock
VCD/ MP3/CD player, complete with
a remote and headset for as little 
as Rs 1,595. 

Then there’s the ultra-slim
TechSound DVCD, MP3, SVCD, VCD
Player for as little as Rs 1,799 and
the Mitashi MX 3000 (Rs 2,840)
which is a VCD, DVCD, and an 
MP3 player.

A Selection Of Best Offers From Popular E-commerce Sites

Last Month’s Winner!
Unfortunately, no one could
send in a caption witty enough
to be adjudged winner. Better
luck this time!

Send your captions to
beatthat@thinkdigit.com and
win a book.
Computer Systems
A Programmer’s Perspective
By Randal E
Bryant and
David O’
Hallaron
Published by
Pearson
Education
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A50 817MQB (first prize), an
HP Officejet 4255 (second
prize), and a World Space
Radio (third prize).

There are no restrictions
on what problems
contestants need to crack.
Programmers can choose to
build a Linux and/or Web
Services application in the
area of their interest and
competence. There will be
prominent display for the
winners on the ZDNet India
Web site.

While the contest
opened online on October
20, the last date for
submission of entries is
December 20. 

The winners will be
announced on January 5,
2005. For more information
and registration details,
visit www.zdnetindia.
com/devcontest/

GERMAN INNOVATION

Electronic
Underwear
And Heart
Attacks

We’ve already seen
devices that tell

people when they
are about to have a
heart attack. These
include mobile
phones that
you hold in
front of your
heart; and
portable
electrocardiograms,
that require
electrodes covered with gel
stuck to the wearer’s skin.

Now comes a German
invention that removes the
inconvenience those
devices pose: electronic
underwear that can detect
imminent heart problems.
The underwear is sensitive
to fluctuations in the

wearer’s heart rate. It has
been developed by the
Philips Research facility 
in Aachen.

The garment can
automatically call
emergency services when,
for example, the wearer
suffers a cardiac arrest. So
how does it work? Sensors
are woven into the fabric
of the garment. These
detect electrical
fluctuations on the skin
surface, which can tell how
rapidly and how hard the
wearer’s heart is beating.
Not only that, the garment
also records activity and
stress levels, which are
important predictive
factors in determining
someone’s risk of a 
heart attack.

The underwear concept
is fantastic, because it is not
only convenient—it is also
an elegant solution. Heart-
rate fluctuation detectors
need to be in contact with
the skin, and underwear
always is. Besides, this way,
the patient does not need to
wear or hold anything that
does not integrate with his
lifestyle.

There is one hurdle to
be overcome, however—
there needs to be software
that enables the device to
distinguish between heart-
rate fluctuations due to an
impending attack, and
fluctuations due to normal
stress or physical activity.

INTERNET DOMINANCE

Of Google,
Microsoft,
Browsers
And OSes

The idea of the Internet as
an operating system was

at first hyped; it then
languished due to absence of
real solutions and is now
making a repeat appearance,
somewhat shyly. The
thinking was that one would
log onto an online software,
use it to do a task, and then
log back out. Why should a
user bother about patches
and other associated
headaches?

The idea is back. The
Internet, now more than
ever, is being touted as a
platform for software
deployment, and an
increasing number of
developers are building 
Web applications using
markup languages such as
XUL and XAML.

Some companies such as
Google are banking on the
idea, whereas others, such as
Microsoft, would have things
play out otherwise. 

For Microsoft, Windows
brings home the money;
losing control of that
platform is unthinkable, the
kind of unthinkable which
would have developers
program for a browser rather
than the operating system.
After all, a browser isn’t
exactly locked onto a
Windows platform… for a
Google, a browser hosts ads
and the more ubiquitous
Internet browser, the more
places the company can
place its ads and thus gain
revenue.

So while a Google looks
to bring the Internet to the
OS—Google has several
software such as GMail,
Google Desktop, Picasa, Hello
which integrate online with
offline, apart from a
rumoured Web browser that
is in the making. 

Microsoft hopes to keep
developers, and hence users,
pinned to Windows. 

GENDER 

BENDERS

Abhishek Chintakindi, a second-year Computer Engineering
student, sat down apprehensively at the monitor. Once at
the Microsoft site, he wasn’t quite sure where to look.
Should I look under downloads? Probably search it off?
Nearly seven minutes and no sign of the patch. A little
change in the search string did the trick and a relieved
Abhishek was all smiles as he downloaded the removal tool.

Abhishek Chintakindi vs Prajakta Korde
Download the Sasser Patch from
Microsoft’s Web site

7 min 
19 sec

2 min 
26 sec

Prajakta Korde, also a second-year Computer Engineering
student, was confidence personified as she took her seat.
“The Sasser Removal tool, right?”, she asked to confirm
whether she heard it correctly. And then she was at it in full
gusto. A minute passed as she made her way to the
Downloads section. But look, there it is under ‘Most Popular
Downloads’. A quick click on the link and Prajakta had the
download done.
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Microsoft’s strategy 
is to take XML and integrate
it to such an extent with 
its upcoming Longhorn OS
that writing applications for
online usage will 
be dependent on its
operating system.

Who will own the
Internet—will it be the
ubiquitous Web browser or
the equally ubiquitous
Windows? The one who
owns the platform has the
money in the bank. 

This fight promises to be
interesting.

GOOGLE DESKTOP SEARCH

Google Beats
Microsoft To
The Desktop

Google has released a beta
version of a desktop

searching utility. Termed
Google Desktop, the 400 KB
software integrates Google’s
online search engine with an
offline one for the desktop
very nicely indeed.

The utility, in its beta
avatar, can search within
your e-mails (limited to
Microsoft’s Outlook and
Outlook Express), your
browsing history (limited to
Microsoft’s IE), and logged
conversations on AOL’s
messenger (which not too
many people use in India). 

How useful is it then?
Fairly so: it does gather data
from within text, MS Word,
Excel and PowerPoint files. It
sifts through text files, Word
files and the like, scanning
their contents, so you can
actually search for a file
based on a word it contains.
For pictures, PDF files and
the like, the searching is
based solely on filename.

The magic works on
indexing—the software sits
in the background and
spiders your hard disk for
supported files. It then
creates an index of keywords
and content, thus creating a
local cache of your local files
(it offers no support for
network searches yet). 

Think of it as Google for
your hard disk. Sorely

lacking is content-searching
of popular file formats such
as PDF and support for other
e-mail and chat clients.

However, it does the job
and does it fairly well for
early software. Searches can
be linked to online results: if
you say search for “flowers,”
at www.google.com, Google
Desktop will serve up files
locally stored on your
machine with “flowers” in
them (perhaps an e-mail)
while, at the same time,
searching online for
“flowers.” Privacy concerns?
The official line is that the
software does nothing to
breach your privacy. It does
send across usage patterns,
but that can be turned off.

UPDATE: A security vulnerability
was recently patched in Google
Desktop. The JavaScript
vulnerability let third-party Web
sites view the results of searches
made on your local hard drive

PERSONAL DATA COMPRO-
MISED

Huge South
Korean Scam

Personal details of a
staggering one-fifth of

the South Korean Internet
population were allegedly
compromised in July by 15
mobile phone workers and
brokers, police found. The
group of 15 were richer by
$314,000 (Rs 1.45 crore) after
selling the information to a
telemarketing company. In
late October, police were still
investigating how the
scamsters obtained the data.

Details are emerging:
Chosun Ilbo, a daily, reported
that seven of the 15 sold data
of about 920,000 mobile
phone customers to the
telemarketing company. The
data consisted of names,
phone numbers, e-mail
addresses and type of phone
used, and was used in
attempts to get the
consumers to switch mobile
operators or sign up for
broadband services.

One of the accused sold
e-mail addresses of
consumers to porn

spammers. The same person,
a broker, allegedly sold data
of about five million mobile
phone users to operators and
shopping malls, as reported
by Chosun Ilbo. Three of the
suspects have already being
arrested. One of the chief
suspects is president of a
marketing company, and he
is now on the South Korean
police’s wanted list.

FOUR CHINESE JAILED

Online Porn?
Go to Jail!

China has been
implementing its edicts

against online pornography:
four men, in their twenties,
were recently jailed for
running a porn site. 

They rang up a profit of
about $2,000 (Rs 90,000)
during the few weeks their
site was up. It attracted
about 16,000 hits during that
period. And the men have
been jailed for between one

year and two-and-a-half years.
Since the time China

began clamping down on
online smut, around 445
people have been arrested,
and 1,125 sites have been
shut down. There are even
rewards for reporting smut
sites—around $240.

China’s government
believes that the rampant
increase in online smut is
damaging the moral fabric
of the nation, and of young
people in particular. 

One official said
pornography “severely
damaged social style,
polluted the social
environment, and harmed
the physical and
psychological health of the
young people.”

What is a plasma display?
A plasma display is a flat-
panel display. It does not use a
cathode-ray tube (CRT), which
traditional TVs and monitors
do. They are bright, have a
wide colour range, and can be
manufactured in large sizes—
up to 80 inches diagonally.

How does a plasma display
work?
In a plasma display, light is
created by phosphors, similar
to those used in TVs, excited
by a plasma discharge
between two glass panels.
Plasma is a gas made up of
free-flowing ions and
electrons.

Who invented the plasma
display?

The plasma display was
invented in 1964 at the
University of Illinois, by
professors Donald Bitzer and
Gene Slottow, and graduate
student Robert Willson.

Why do we need plasma
displays?
Plasma displays are ideally
suited for HDTV. They are
capable of producing bright
pictures, and are good for use
in high ambient light
conditions. They are also
extremely thin and wall
mountable, which gives them
great flexibility for integration
into a range of rooms and
viewing environments.

When were plasma displays
first used?
Although they were invented
back in 1964, they first started
becoming popular around
1999 or so.

Where can I find plasma
displays?
Plasma displays are relatively
common now. They are
especially used in home
theatres. As of 2004, the cost
is down to $2,300 for a 42-
inch diagonal screen model. In
India, Samsung, Hitachi and
Sony are the big players.
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he innocuously-named National
Network Operating Centre (NNOC) at
Reliance Infocomm’s 140-acre

Dhirubhai Ambani Knowledge City in Navi
Mumbai is one of the 20-odd, post-modern
buildings that the complex houses. Large
Samsung plasma monitors line the large
hallway with promotional films reminiscent
of the subliminal messages delivered in

George Orwell’s 1984, interspersed with
wall-mounted displays of the company’s

history, its achievements, its
technologies, a few phone

models, a Reliance
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The Man who saw
Tomorrow

Web World, a Java Green coffee outlet—you get
the picture. A few steps later, the well-appointed,
well-rehearsed hostess in a well-starched sari
takes you through a motion-activated door into
what looks like an aerobridge. On either side of
the passageway are James Bond-like glass walls
that give you a bird’s eye-view into a revolution. 

It is mostly quiet here, and the engineers
downstairs look at large LCD video walls—ones
that allow them to monitor every single point on
the Reliance network (see box ‘What is NNOC All
About?’ on Page 28).

They seem to work with almost NASA-like effi-
ciency to run India’s largest cellular phone service.
It is so efficient it gets boring after a while; sup-
pressing a yawn becomes tough.

The Man 
Mukesh Ambani, Chairman and Managing
Director, Reliance Infocomm, would

Reliance Infocomm chief Mukesh Ambani says the future of communication will not be just
voice services; it will be high-speed data. He tells ‘Digit’ how he plans to deliver that dream



not mind that. He, along with these couple of
hundred engineers, and 15,000 others, has created
a telecommunications behemoth in just 18
months. One that has more than 90 lakh sub-
scribers, a fifth of all mobile subscribers in India;
one that sells CDMA phones, where the lowest-end
model has more data services than the highest-
end GSM phone; one that is supported by a back-
end of more than Rs 15,000 crore in investments.

Enough to impress Total Telecom, the leading
publication on telecommunications; enough for
them to present him with the World Communi-
cations Award in mid-October for being the
“World’s Most Influential Person in Telecom.”

The Dream
“The idea is to straddle the infocomm value
chain,” says Ambani. “We want to change the
socio-economic landscape of India. We can do this
by linking mobile devices and broadband services
to powerful digital networks.”

It is not a distant dream, nor are these words
egotistic. India is already adding almost 20 lakh
new mobile subscribers every month, and by the
end of October, had 4.5 crore mobile subscribers.
Only a few other countries, such as the US (16.5
crore) and China (a staggering 31 crore) have more
mobile connections. Despite the huge growth,
India’s tele-density stands at a pathetic eight per
cent (as against the world average of 15), making
telecom giants from across the world drool: India
is fast becoming the world’s hottest mobile
market, just behind China, which adds 
40 lakh new mobile users a month.

It’s Not Just About A Telephone Call
It wouldn’t be exaggeration to say that it has been
Ambani and his 18-month old company that have
fuelled this growth. He has been able to do this by
focusing on the fundamentals. In an interview
with a business magazine last year, Ambani
admitted that Reliance was six months late to take
off (He later told Digit: “Yes, we were late, but when
we entered, India was the most expensive telecom
market in the world. Today, it is the cheapest.”).
However, it was also evident that Reliance was
concentrating on building the backbone of India’s
largest and strongest fibre-optic cable network—
one that spans the country.

This backbone has enabled Reliance to main-
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tain a 99 per cent fault-
free rate, and create the
back-end for more than
a hundred data services
on the mobile,
including checking
your bank account,
paying your bills,
booking a railway ticket,
watching the latest
news, and even
checking your public-
exam marks.

“We needed the
world’s most advanced
technology, and the
world’s most advanced

network, to make this happen,” says
Ambani. “I believe the mobile phone

will become an information advisor, computer,
entertainer, teacher, wallet, and friend in the near
future. It is not long before you will be able to intel-
ligently speak to your mobile phone to take you
places. You already access video news, entertain-
ment, and conduct m-commerce transactions.”

Ambani’s words are not prophetic—they are
already a reality. Besides, he admits, he uses his
company’s R World services quite often. “I am a
regular user of our broadband and data services,”
Ambani says with the same enthusiasm as would
the owner of Rama Nayak, the famous Mumbai
Udipi restaurant, who has a signboard put up at
the entrance: “The owner of this establishment eats
here.” It invites a few giggles, but it also earns trust
amongst the restaurant’s customers.

The analogy is not bizarre. Mumbai’s Udipi
restaurants have perhaps the best delivery models
in the service industry. You order, and you are
served in not more than three to four minutes. A
strange request, and the waiter will go to all
lengths to fulfil it. 

Profitability, here, depends on satisfying the
customer’s need.

What Is NNOC All About?

The National Network Operating Centre (pictured on Page 27) is Reliance
Infocomm’s way of saying, “We have arrived.” The 1.1 lakh sq ft NNOC is a

single-point monitoring room that controls more than 3,000 sites and 5,000
elements. In short, the entire Reliance network of 1.2 lakh km of fibre-optic
cable. 

Insiders call it God—it can talk to each piece of Reliance equipment across
the country; and it knows everything at all points in time.

The NNOC is divided into two sections—wireless and national/international
long-distance. Since each operation is further divided into various other
functions, the NNOC has teams dedicated to each—the surveillance group, the
service-positioning group, traffic and capacity-routing group, performance-
monitoring group, planned-events group and the applications support group.
It is also one of the few such centres in the world that also records failed calls. 

The 200-odd engineers here monitor the network 24x7, and everything
they want to see can be visualised on the two 100 ft video walls each giving a
360-degree view of the operations. That is not surprising considering the
video walls have 80 screens.

When a fault is detected, the NNOC informs the ground-level staff in the
respective area. A team is then sent to the fault area, and the fault call is
meant to be closed only when it is repaired. This increases accountability, and
puts pressure on the ground team to keep the service fault-free.

Instead of focusing on just rolling out services, Ambani concentrated on building a robust backend,
including the sprawling Dhirubhai Ambani Knowledge City at Navi Mumbai. The strategy worked
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when Ambani is investing $5.5 billion in building
a countrywide telecommunications network. In
Indian currency, that will be Rs 26,000 crore, one-
third of India’s defence budget this year.

Ambani is convinced of the size of the invest-
ment, even though it may sound huge. “It is still
very competitive in the global context,” he says in
a matter-of-fact way. “Other companies would have
to invest at least three to four times this amount
to reach the level of our large initiative.” 

Hindsight is an exact science, says Murphy’s
Law. However, insiders at Reliance say that Ambani
has developed foresight into an advanced science.
The adoption of CDMA meant that Reliance
phones cannot be taken out of the country, but it
also meant that Reliance could exploit a domestic
market of data services—one that did not exist, or
if it did, was restricted to downloading news head-
lines via SMS or downloading ringtones, screen-
savers, and wallpapers.

The Services 
Reliance spent time building the fibre-optic back-
bone, one that would allow it to get into the
mobile data services (more than 120 at the time of
going to print); create Reliance WebWorlds, where
you get services such as Internet telephony, video-
conferencing, digital suitcases, etc.; create a net-

work for fixed wireless
terminals on the WLL
platform; create
Internet data centres for
services such as Web-
hosting and call centres
(majors such as ESPN-
Star, State Bank of India
and Morgan Stanley are
hosted there); anywhere-
Internet services from
your mobile phone; and
now even international
calling cards at previ-
ously unheard-of prices.

“We are on the verge
of a digital revolution,
one that will bring a

For Ambani, it is no different. “When we
entered the business, the other players were
looking at providing vanilla telecom services to an
already under-served country like India,” he says.
“We have changed the model of communication
and data services. I guess we are driven by the
desire to become a facilitator, an enabler of busi-
ness, by providing the entire gamut of communi-
cations services and not just telecommunication
services. We have done that in just 18 months.”

GSM Or CDMA? 
One of the key drivers of this silent revolution
was the choice of the platform to deliver serv-
ices. Before the entry of Reliance, there were
dominant players in the GSM arena—Orange,
BPL, Idea Cellular, Essar and AirTel. Reliance
chose CDMA 2000 1X, (CDMA stands for Code
Division Multiple Access).

“CDMA technology meant that we could use
Enhanced Voice Rate Codec (EVRC),” says Ambani,
“which ensured that the back-end is continuously
scalable, and gave high levels of voice clarity.” So
much so that Reliance phone owners often have to
keep the phone slightly away from their ears
because of the enhanced voice levels. Thankfully,
every mobile phone has a volume adjust button.

However, loud volume is only a minor issue

Data, Data, And More Data

Reliance chief Mukesh Ambani feels
that the future of telecom is in

delivering data services. And he goes to
lengths to explain that Reliance
Infocomm is not just about voice
services. “So much so that, looking at the
success of our data services, several
other players are keen on providing
them,” he says.

Reliance has a multi-pronged strategy
for delivering data services to the
consumer: corporate broadband, 3G
Mobile services, Reliance Netway, Reliance
WebWorld, and Internet Data Centres.

“We already deliver corporate
broadband services with Ethernet links at
100 Mbps. It is our endeavour to enter
the home market at the same speeds,”
says Ambani. If that becomes reality

(market sources say this will be in the
next financial quarter), homes will be
connected using Reliance’s high-speed
optical fibre network (Reliance has
identified more than 1 million homes
across the country for this purpose),
giving them access to services that go
beyond the Internet.

For instance, the Netway service 
gives options such as watching television
channels, high-speed Internet telephony,
audio and video-conferencing, video-on-
demand, a jukebox, time-shifted television,
t-commerce and even home-surveillance
services in various Indian languages.

On the other hand, Reliance has
already begun such services in 250 Web
Worlds in India, offering the same services.
WebWorlds are communication technology

outlets that offer Internet, voice, gaming,
and even corporate services.

To add a bit of glamour, WebWorlds
often host video chats with movie stars
and other popular personalities. In what
was clearly an out-of-the-box idea, earlier
this year, WebWorlds across India let
siblings in different cities talk to each other
through video-conferencing for 15 minutes
on Rakshabandhan day for a fee of Rs 375.

R World, meanwhile, delivers
broadband services to the mobile phone.
At present, R World has page views of 1.5
billion a month, and over a hundred
services, ranging from ring tones and
screensavers to checking your bank
statements, downloading songs and
videos, booking railway tickets and
paying bills.

We are on the
verge of a digital
revolution, one
that will bring 
a new way of 
life to India

The Reliance WebWorld model works under a simple premise—provide personal services such as 
surfing and gaming (left), and corporate services such as broadband (right) under one roof using their 
existing fibre-optic network
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new way of life to India,” feels Ambani. “These serv-
ices will let people watch television programmes
and movies, and access the Internet as well. But
before any of that, we feel our fundamental respon-
sibility is to provide telecommunications services
at affordable prices.”

The Road Ahead
Conventional wisdom would say that Ambani
should concentrate on the big cities, to make
money and keep the company going. He feels the
answer lies elsewhere. “We are networking more
than 5,000 cities and towns in India,” he says. “We
have laid more than 1.2 lakh km of fibre-optic
cable. The same services that people get in a
Reliance WebWorld will be the services that they
will get at home. That would be real broadband.”

But the trouble is, despite the huge array of
services, India has traditionally been a country
with a low adoption rate for paid services. For
instance, all of Reliance’s R World data services on
the mobile phone are free (some of them would go
paid soon), and this is the primary reason behind
its popularity.

Ambani doesn’t agree. “We need to challenge
conventional cost structures and offer services at
incredible rates. You will witness how the usage will
boom for technology and data products, even if
they are paid for. It’s because people value relevant
content, and they wouldn’t mind paying for it.”

He says he is confident that this growth will be
exponential, making India one of the highest 
consumers of data products in the world. “Given
India’s diversity, data and communications 
services need to be a combination of affordability
and the best in technology. People should view
these services as enablers of personal economic
growth. Take your neighbourhood vegetable
vendor, the newspaper vendor as well as the fish-
erman; all of them use mobile phones to conduct
and enhance their businesses.”

This proliferation has made India the second-
largest cellular handsets market after China. In a
recent report, investment firm Morgan Stanley pre-
dicted that India will show a compounded growth
rate of 40 per cent per year until 2007 in the cel-
lular market.

“A one per cent increase in tele-density raises
the country’s GDP by three per cent,” says Ambani.
“That’s good for us as a nation, and for us as a com-
pany. What is good for India, is good for Reliance.”

What is good news for the consumer, however,
is that Reliance will soon be entering the home
broadband services sector. The fibre-optic network
has already ensured that corporate broadband
services are delivered at speeds of up to 100 Mbps.
“We will now concentrate on providing high-speed
Ethernet links to homes, too,” says Ambani.
Reliance has termed this Netway. “It is our way of
changing the communication pattern in India.”

Up, Close And Personal
Ambani’s words are chosen carefully, and they
show determination and impatience in equal
quantity. He wants to make things happen, and
fast. “Not really,” he says. “Impatience can never
result in success. Yes, we are in a hurry, but we are
running fast because we have to catch up with the
rest of the world. We have to deliver.”

It would seem he has the same level of enthu-
siasm of a first-time entrepreneur, not the been-
there-done-that kind of attitude of the head of an
empire that has yearly revenues of Rs 99,000
crore, or 3.5 per cent of India’s GDP. Any spare
time, then? “You have to make time,” he says, “I
spend my free time reading about the latest tech-
nology trends and books on management. But a
majority of my free time from work is spent with
my family. Business may be the driving force of
your ambition, but family is more important.”

Ambani says he spends considerable time
using R World services, though he admits that
there is none in particular he would choose as
his favourite. “That would be like asking who you
like most among your children.”

Perhaps that is the secret of Reliance being
India’s largest telecom company in 18 months.
Ambani nurtures it like his child; one that has
shown enough signs of being the Big Daddy of
them all.

sachin_kalbag@thinkdigit.com

What is CDMA?

CDMA is short for Code Division Multiple Access, which uses multiple 
frequencies for transmission of voice and data. Simply put, it differs

from GSM (Global System for Mobile Communication) in the way voice 
gets carried from one phone to the other. Because of the way it assembles
multiple voices into the same frequency, CDMA increases voice clarity. The
technology also helps you receive calls when the signal is weak.

Imagine a locked room where you and your friend are talking to each
other. The room, then, is exclusive to you. Now imagine the room as a 
frequency band. This is how GSM works.

In CDMA, however, the same locked room (or frequency band) will have
several pairs of friends talking to each other, but each of the conversations
will be scrambled, thus ensuring privacy. Because CDMA uses the same 
frequency to accommodate several conversations by using multiple
transmitters, the usage of available bandwidth can be optimised, leading to 
higher traffic density without the accompanying problems of failed calls.

This also gives CDMA service providers the flexibility to provide data
and video services.

CDMA was invented during World War II when Allied forces wanted to
get past the Germans by sending coded messages over different
frequencies and giving them the ability to be accessed from different
points—hence “Code Division Multiple Access.”

Sit back and relax: A chat session featuring film celebrities at a
Reliance WebWorld event
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The Solution To Last Month’s Challenge

Here’s how to replace the Windows XP 
logo in the General tab under System
Properties.

The Windows XP logo is controlled by the
file c:\windows\system32\sysdm.cpl. We’ll
need to edit this first, for which we need a
tool called Resource Hacker. This can be
downloaded from http://www.user.on.net/
~johnson/resourcehacker/. 
Back up the file before proceeding.
Start Resource Hacker and open “c:\win-
dows\system32\sysdm.cpl”.
Expand the “Bitmap” folder, then expand
the one folder there, and click on “1033.”
You’ll see the Windows XP logo in the right
pane.
Go to Action > Save [Bitmap: 1:1003] and
save the bitmap image. Do not close
Resource Hacker.
Open the saved image using any editor, and
note its size. Now create an image of your
choice of the same size and save it.
Now in Resource Hacker, replace the image
with the edited image. Save it from File >
Save As, in any location except c:\win-
dows\system32, with the name “sysdm.cpl”.
Restart your computer in DOS mode and
copy your edited “sysdm.cpl” file to the
c:\windows\system32\ directory. Say “yes”
when asked to overwrite the existing file. 
Restart your computer and note the results.
To get your old logo back, just replace the
“c:\windows\system32\sysdm.cpl” file,
under DOS mode, with the original
“sysdm.cpl” you backed up earlier.

Replace the default
Microsoft Windows XP
“Copying...” animation
with an animation of
your choice

Rules and Regulations
Readers are requested to

send in their answers by the
15th of the month of
publication.

Employees of Jasubhai
Digital Media and their
relatives are not permitted to
participate in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any
damage to your system that
may be caused while you are
solving the problem.

Each month, Digit will pose a query that will set
you thinking. The challenge is to crack it. If you
are successful in cracking the challenge, send

in your answers to Digit with your full name, your
address and other contact details to
takeacrack@thinkdigit.com. 

Digit’s Test Centre will select the correct
answer(s). In case of multiple correct entries, the
winner will be decided by a draw of lots.

Last Month’s Challenge Was
Replace the Windows XP logo in the General tab under System Properties with
an image of your choice. The winner of the Microsoft keyboard and mouse is
Amit Bhagat. Congratulations, Amit! His solution is published below …

Replace the default
Microsoft Windows XP
“Copying...” animation 

This
Month’s

Challenge

DIGIT NOVEMBER 2004

THE CHALLENGE

Take a Crack 
and Win
Webster’s New
World
Computer Dictionary
By Bryan
Pfaffenberger
Published by
Pearson
Education

Win!



DVDs from live shows. “We use the DV-CAM to
record a show, bring it to the studio, hook it up
to the laptop and we can create our DVDs.” His
latest buy and most prized possession? The
Yamaha Motif ES top-of the-line synthesiser.

The synthesiser can be connected to his lap-
top, and he can record directly to the latter. The
laptop can play back tunes, through the key-
board.

The laptop has become an integral part of a
musician’s repertoire, says Banks. “There’s no
need to carry six keyboards or a bank of effect
processors now, to a studio. Everything is soft-
ware driven. One just needs a basic keyboard,
loaded with all the software and effect process-
ing tools you would require. I can create jingles
at home, on the laptop; take it to the studio,
provide other inputs and record the track. This
is creating a whole new breed of musicians and
producers, who can now become a one-man
industry.”

Team Banks includes sound engineer Neil
D’Souza, who is an IT (as in information tech-
nology, not income-tax) consultant and “com-
puter wizard,” according to Banks. “He looks
after all my computer needs. We work as a
team, creating the music. All that I create here
goes into his console. He records, processes,
and mixes, and helps me polish the final prod-
uct.”

Man Friday Neil D’Souza says,  “I spend 60
per cent of my time with music. This is one
field in which you get to put technology to its
fullest use.”

Neil uses an assembled Intel Pentium III,
870 MHz PC. He also uses a digital mixer, the
Yamaha O1v, “which interfaces the analogue
audio we record with the digital world.”

He also uses MOTU 2408 MKII—an audio
interface that connects to the computer and
aids in digital sound processing. This is con-
nected to the mixer through a fibre-optic cable.
MOTU is a universal sampler plug-in that helps
import, audition, and load sound banks in sev-
eral formats. “Together we have a 24-channel
input/output setup, eight of which are dedicat-
ed digital (input/output) channels,” says Neil.

Another system called MOTU MTP AV works
as the synchronisation and MIDI unit. 

Louiz Banks is one artist who has managed
to successfully integrate technology with cre-
ativity, to create music that appeals to the mod-
ern generation, just like southern sensation A
R Rahman. 

Not only does he employ technology: his
extreme thirst for knowledge makes him keep
track of the latest technological developments
in the field of music. As Neil affirms, “He’s very
techno-savvy. And I’m a hardcore IT guy. That’s
why we vibe well.” 

meera_vankipuram@thinkdigit.com
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Technology helps Louiz Banks, the ‘Godfather of Indian Jazz’ create magic in the cyber-age

Banks On Technology

Meera Vankipuram 

“Ilove gadgets,” declares Louiz Banks,
whose exploits with the electric piano
have earned him the sobriquet

“Godfather of Indian Jazz”. Nearly 7,000 jin-
gles, several movie scores and stage shows later,
Banks continues to churn out music that
appeals to young and old—thanks largely to the
fact that he’s one of the few musicians who
have managed to keep abreast of developments
in music-related technology.

“If there is any new gadget in the market, I
have to buy it,” he says.  

In a career spanning more than a decade,
Banks has composed numerous ad jingles and
toured with world music band Silk. He per-
forms regularly in stage shows, including the
by-now legendary Jazz Yatra in Mumbai.

His home studio is located in a quiet niche
of the otherwise bustling Santa Cruz, a western
Mumbai suburb. Says Banks, “Even in a small
room like this, we can create good music with
hardware that costs lakhs of rupees. Because of
advancements in technology… we can do won-
ders with the limited space. All we need is
imagination and intelligence, and we can cre-
ate some of the world’s best music.”

Gadgets abound at his workplace. There’s
the HP Invent laptop synchronised to the iMate
Pocket PC. The iMate integrates fully with
Microsoft products, and is also a tri-band GSM
phone. “It has an ActiveSync with the laptop so
I can transfer data back and forth,” says Banks.
The iMate, besides being a mobile phone, also
offers him about 2 GB of storage space.

A Sony MINI DV-CAM helps Banks create
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Louiz Banks gets cozy with his gizmos that include an HP laptop and an iMate Pocket PC

HHPP  IInnvveenntt  LLaappttoopp  —
Rs 1,40,000

MMiiccrroossoofftt  iiMMaattee
PPoocckkeett  PPCC  —Rs 40,000

SSoonnyy  MMIINNII  DDVV--CCAAMM  —
Rs 50,000 

YYaammaahhaa  MMoottiiff  EESS  ((ssyynn--
tthheessiisseerr))  —Rs 1,25,000

YYaammaahhaa  OO11vv  ((DDiiggiittaall
MMiixxeerr))  —Rs 1,20,000

MMOOTTUU  22440088  MMKKIIII  —
Rs 80,000

The DJ’s Devices



Ram Mohan Rao

My smmr hols wr CWOT. B4, we usd 2 go 2 NY 2C my
bro, his GF & thr 3 :-@ kds FTF. ILNY, its gr8. …

That excerpt is from a Scottish schoolgirl’s
essay on her summer holidays. A transla-
tion goes like this: “My summer holidays

were a complete waste of time. Before, we used
to go to New York to see my brother, his girl-
friend and their three screaming kids face to
face. I love New York; it’s a great place.”

Instances such as these are ringing alarm
bells in certain quarters. College students, too,
are increasingly using SMS lingo in their essays
and assignments.

Is our language taking a beating as a result of
the use of technology? Will your children ever
be able to understand Shakespeare and Keats?
Will they write novels worth reading? On the
other hand, are people thinking faster when
they use techno-speak, and putting their point
across better? What will these trends ultimately
lead to?

That’s a mixed bag of questions, but there are
two basic sides to the debate: one which says that
language is indeed degrading as a result of tech-
nology, and the other which says that it’s all
about evolution—that just as language has
evolved with the times, there is now an acceler-
ated evolution as a result of technology.

Slips Of The Langue
Professor David Crystal, one of the
world’s foremost linguists, notes that
Henry Alford, then the Dean of Canter-
bury, wrote a book called A Plea for the
Queen’s English in 1864, in which he effec-
tively said that the English language was
going to the dogs. Dr Crystal notes that
it’s always been that way—each generation
condemns the slips in language, but what’s
happened ultimately is that the language has
kept on growing.

“There has never been a pure language,” he
says. “Language is not always logical.” We may
infer that there is always room for change.

Naveen Halemane, a research scholar at
Mysore University’s Department of Linguistics

feels youngsters are the ones effecting most of
the changes. He says, “Most informal expressions
are created and used by youngsters. Older people
usually get along somehow. Nevertheless, they
bother about ‘rules’ being neglected. Most abbre-
viations these days are incomprehensible for
older people. The use of ‘u’ in place of ‘you’ by
youngsters has sometimes resulted in high-rank-
ing officers rejecting applications.”

This may be true, but things will
change—even if it is just for the sake of the
simple fact that today’s youngsters will be the
adults of tomorrow. 

What about instances such as the Scottish
schoolgirl’s essay? Crystal is of the opinion that
it is the teacher’s job to instruct students in the
correct use of language—that there is a place to
be informal and a place to be formal, and the
debate need not go beyond that.

Tech-speak shortcuts are to be found in Web
chat. Be it in a Yahoo! adult chat-room or one
between office colleagues, the use of shortcuts
such as “gr8” doesn’t raise any eyebrows.

Not any more, at least. Many would say that
shortcuts are shortcuts; it doesn’t mean
language is deteriorating. That may be true.
However, the degradation of language is an
intangible; it is a continuous process—some-
thing you cannot quantify, something that
happens without your notice.

Consider the following response to a 
Digit contest:

“....thx a lot...i can belive on my
luck......actually i was a bit late in
sending my images and never
expected to win....any ways... my
postal add is as follows......”

This kind of writing is at the
centre of the debate. On one
side, critics of tech-speak may
say: What can be said of the

mind of a person who writes like this? It’s obvi-
ous his or her language skills have been
dumbed down. Can such a person ever partici-
pate in a debate over real issues? And so on. On
the other hand, defenders of today’s language
trends say that there is no cause for alarm what-
soever, and that the person was merely shoot-
ing off a message hurriedly, without paying
attention to detail.

Once upon a time, there was communication… then technology happened.
Is the written word doomed?

The b3nd!ng
ov the rul3z

There has never
been a pure
language
Prof David Crystal, 
Linguist and leading
language expert
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Halemane says there are enough reasons to
believe that language changes today happen due
to lack of time. “People today may just not have
time to elaborate, nor do they have the time to
pay attention to every small rule of language. They
choose to communicate in the way they like.” 

He adds, “People using ‘E-English’ use e-mail
and SMS extensively. It is the written form of
what they speak, making it look informal. This
could well be because youngsters dread order
and formality.  Fill-Gaps such as ‘umm,’ ‘err,’
‘like,’ etc., are used just as they are in spoken
language… they type as they think.”

However, he also believes that language 
skills are not on the decline: “Technology has
not affected spoken language much. The way
people use language these days is just another
societal transformation. We do not use the
language Shakespeare used. And youngsters
don’t use the English we used 20 years ago.”

Professor Crystal says each new technology
has changed the language in some way or the
other. For example, the advent of printing, and
the advent of TV. Think of TV sports commenta-
tors, and its peculiar phraseology. The Internet,
Crystal says, will effect another technological
change, although it would be premature to 
predict how.

Cr8ive And Po3tic?
Dr Jill Walker, associate professor in the Depart-
ment of Humanistic Informatics at Norway’s
University of Bergen, says SMS-speak is “creative,
sophisticated and can have poetic beauty when
used well.”

She says emoticons work well as additional
cues for conversation. An “lol” may not always

mean “laughing out loud,” but
it does usually mean that the
person is smiling, or is
amused. Face-to-face conversa-
tions support our language
with body language as well.
“We need those extra cues in
conversation, because we don’t
have the time to carefully
construct each sentence as we
do while writing, say, an e-mail

or a blog post or an article.” 
Dr Walker reckons we think faster as a result

of SMS-speak. Again, there are two aspects to
this: thinking faster might mean that we get
more “communication” done in lesser time, but
it might also mean that we express less, with
only the essentials coming forth, and the
nuances lost. That is at the core of what is
happening. 

There is an increasing tendency to express
only that which is necessary to the topic at
hand; we are losing out on the finer points.
Technology seems to have made us blunter.

However, Halemane makes a point here: that
it’s change that makes us grow. He also says that
we cannot predict whether the trend will
continue: Crystal, in his book Language And The
Internet says, “We can never predict language
change, only recognise it once it has happened.”

Here’s what Dr Walker has to say about the
possible evolution of language as technology

forces us—or allows us—to communicate in
different and diverse ways: “Look at ‘leet’—short
for ‘elite.’ Leet looks a lot like SMS-speak at first
glance, but rather than shorten ‘you’ to ‘u,’ leet
substitutes numbers and other characters for
many letters.

“Originating on the Internet, Leet itself is
written ‘1337.’ Leet is a cipher, a novel form of
English spelling. (See this month’s Bluff your way
through for more on Leet.) It is characterised by
non-alphabetical characters that stand in for
letters to which they bear a superficial resem-
blance, as well as by a number of quasi-standard
spelling changes such as the substitution of ‘z’
for final ‘s.’ Leet is traditionally used on the Inter-
net and other online communities, such as
bulletin-board systems, sometimes to comple-
ment Internet slang or ‘chatspeak.’

“There are artistes who write ‘codework,’ in
a kind of pseudo-machine English that has a lot
in common with leet. For instance, the artist N
N’s (apparently, this person’s Web identity is that
of a woman named Netochka Nezvanova, but no

one knows who he/she really is) words
mor konfusd kr!!!!ketz. !
sh!ne m! metal!k zurfazez
modulated b! 01 z!lnz
can be translated into English as
More confused critics (crickets?)
I shine my metallic surfaces modulated by
silence
“There is a certain beauty to it.

Whether languages like these remain
slang for sub-cultures and artistic expressions
remains to be seen.”

There may be a certain beauty to N N’s words,
and there may be a certain beauty to Shake-
speare’s sonnets as well. Which will be consid-
ered “more beautiful” in the years to come—N
N’s works or Shakespeare’s?

Language: Like Fast Food
What’s the problem with chatting the way we
do, and in general, communicating the way we
do? The answer lies in the articulation of ideas.
Consider the following sentence from Arthur
Schopenhauer, the influential German philoso-
pher: “No truth therefore is more certain, more inde-
pendent of all others, and less in need of proof than
this, that all that exists for knowledge and therefore
this whole world, is only object in relation to subject,
perception of a perceiver, in a word, idea.”

Schopenhauer was known for his long
sentences. However, even though this sentence
is long and involved, it is certainly not incom-
prehensible. But how many people—especially
young people—who are used to
SMS-speak, would understand
this sentence without a second,
or even a third, reading? There is
a tendency to consume and
deliver language like fast food.

The SMS Novel
Earlier this year in July, Chinese
writer Qian Fuchang began writ-
ing a novel as text messages. The messages would
be sent via SMS to would-be readers. He divided
his novel, “Outside The Fortress Besieged,” into

[SMS-speak is]
creative,
sophisticated and
can have poetic
beauty when used
well
Dr Jill Walker, 
Associate Professor,
University of Bergen,
Norway 
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60 chapters of 70 characters each. Interestingly,
Xie Wangxin, vice chairman, Guangdong Liter-
ary Academy, told the official Xinhua News
Agency in China that the novel was not a
gimmick, and would be “a real literary work.”

Some may question the state of a world
where a series of SMS messages is considered a
novel. While many would dismiss it as a novelty,
other may think this is the beginning of a revo-
lution—the end of the printed word.

One thing is for sure—our consumption of
language, our perceptions about it, and how
much leeway we give it are changing. We do
seem to be becoming more liberal, more casual
about how we deal with it. And that may just be
a dangerous thing because it is language that
distinguishes us from the apes.

Can the clarity and depth of, say, Schopen-
hauer’s prose, be matched by the novels that
will, one day, undoubtedly be written in techno-
speak? On the other hand, such writings will
undoubtedly have their own appeal; they will
communicate with their audience in ways we
cannot clearly imagine now.

Vocabulary and culture are important factors
when one is talking about the manner in which

we communicate. Consider
the word “great” or “gr8.” Your
friend says, “gr8” when you
say, “I’ve passed my
exam”—what does it mean? Is
he happy for you? Is he
congratulating you? Would he
like more information? It
could either mean all, none, or
some of these. Responses and
expressions have become stan-
dardised. This “stock-phrase

phenomenon” means we are losing out on the
nuances of language.

Another aspect that has become more and
more evident is the fact that this phenomenon
is causing us to communicating more and more
mechanically. There has long been a trend of
expressing less than one would like to, which
technology seems to be accelerating.

Blogs: Too Much, Too Little
A majority of blogs on the Internet have nothing
of real value to say, but that is not our concern
here. We are concerned with the manner in
which blog posts are written: poor punctuation
is rampant. 

Add poor grammar in almost every posting,
and you have written pieces with hardly any
articulation of thought. A well-written blog,
therefore, is a rare pleasure. There is informa-
tion overload here: there seems to be too many
people expressing too many things.

We are also changing our notion of what
constitutes communication. Take picture-blogs,
for instance, or MMSes. What motivates people
to put up pictures on Web sites and invite others
to comment on them? 

It could all be put down to a hunger for
communication (or attention?). Experts have
voiced several times that people who use the
Internet excessively to chat, e-mail, etc., are
typically socially maladjusted. They feel 

the need for a creative outlet that empowers
them to express themselves in the manner they
wish to. 

On the other hand, it could also be explained
in terms of the allure of technology: people who
normally would not want to express much, now
have new avenues of communication; they use
these for the sake of using them.

Taking current trends to their logical conclu-
sion, there will soon be a time when, at 
the press of a button on a device, we will 
know everything we want to know—and
more—about a person. What’s wrong with that? 
But then again, what’s wrong with 
information overload?

Surviving Technology?
We live in interesting times,
with everything moving at
an accelerated pace. How will
we communicate, say, 20
years from now? Are there
certain things that will
remain constant? Crystal
says that certain things—like,
for example, the notion of a
sentence—are “hardcoded”
in our brains. But of the 3,500 or so grammatical
rules that Crystal estimates exist for the English
language, how many of them are hardcoded? Not
many, one would suppose. The language may well
change dramatically.

Will there be a standardised phrase-book
from which our wearable computers choose
phrases to utter—Terminator style—without us
actually conveying anything? Will all linguistic
nuances be done away with? Will our smart-
phones evolve into devices that communicate
sound, smell, and taste? Will luddites occupy a
niche, where communication will be conducted
“the old way”? 

Here, Professor Crystal says that it’s all about
formality—there exists a “spectrum of formali-
ties,” and we use formal or informal language
according to what the situation demands.
However, as the average age of the Internet user
goes up, we are seeing more and more of the old
styles coming in. Ten years ago, Crystal says, it

was unusual to see an e-mail
beginning with, say, “Dear Profes-
sor Crystal”; such formalities are
becoming more common.

Whatever may happen, we are
clear on three points: personal
communication will see informa-
tion overload; we would have to
choose and discard. Second:
language and expression will

evolve, taking on exciting new possibilities.
Three, we will be increasingly to-the-point.

While still on writing, Lynne Truss,
Australian author of the bestseller Eats, Shoots
and Leaves, probably puts it best: “I’ve come to a
new conclusion recently, that it’s not actually
writing that people are doing, but talking,” she
says. “People have actually given up writing alto-
gether. What they’re actually doing is transcrib-
ing the spoken word.” 

ram_mohan@thinkdigit.com

We do not use
the English
Shakespeare
used. And
youngsters are
not using the
English we used
20 years ago
Naveen Halemane, 
Research Scholar,
University of Mysore
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The OQO calls itself a portable computer
and it means it—with a profile of less
than five inches, the diminutive

handheld packs a Goliath-sized punch. Dig
into this: a 1 GHz Transmeta Crusoe processor
powers either Microsoft Windows XP
Professional or its Home Edition; for display
you have a 5-inch TFT screen capable of 800 x
480 resolution, supported by a dedicated
graphics processor with 8 MB of video RAM;
and what’s more, the chip is capable of 3D
acceleration. You want storage? A 20 GB hard
disk and 256 MB of DDR RAM offer adequate
space, while communication is via Bluetooth
and 802.11b WiFi—all this in your pocket!

The OQO is meant as a desktop
replacement. It is designed to free you of the
need to maintain two copies of data—and the
associated synchronisation headache. A slide-

out QWERTY keyboard, a digital pen, and a
thumbstick support data-input-on-the-go. But
the coolest feature is the dock. With a desktop
stand and a docking cable, the OQO
transforms into a desktop computer: a VGA-
out on the dock lets you connect the OQO to a
monitor for a 1280 x 1024 display—use either

the inbuilt or the on-dock USB or FireWire
ports to connect peripherals such as a
keyboard, mouse or a digital camera. The dock
also sports an integrated Ethernet port for
access to either a local network or the
Internet. Gotta own it! 

Still thirsty for more? Visit www.oqo.com.

Digital Passion | Geek Dreams
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Honey, they
shrunk the PC!
A computer that
fits in our
pocket—yes,
please!
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Yashraj Vakhil and Ahmed Shaikh

he two-storey house veils a covert opera-
tion. It is an innocuous façade to a clan-
destine project. You are expected to walk

past, turning a blind eye to the acts of maximum
chaos within. It seems to be designed thus. Let
curiosity guide you inside however; try not to
stare at the typical family that resides within. Do
notice the glint in the son’s eyes—he is hiding
something! Take a flight of stairs to the portal
that shields the secret…

Opening the door is akin to lifting an inno-
cent rock in a sedate garden, only to find a hub
of activity underneath. 

We see Vikram and Keshav sniping at each
other, arguing whether to approve the design of
a particular game level. Snap! Snap! Argue,
argue!

Ashray, the Design Lead has been up all
night, tending to his polygonal gardens. Orthog-
onal surfaces, in numerous shapes and sizes,
stare him in the face—they are trees, virtually
speaking; always in need of pruning to fit the
polygonal budget of a level…

A familiar scent hangs in the air. Smells like
teen spirit. Nay, deadlines. The Lab is buzzing

with activity. Sheets are everywhere, with artists
furtive in their need to pencil thoughts down.
Scratch! Scratch! Erase, erase!

Posters, concept sketches, and level maps
paint the walls; a small bulletin board hangs like
a sword with razor-sharp deadlines.

Deadlines!
The hushed-word screams the loudest. Even

the phones and PDAs hum missed calls, and beep
to-dos gone past. Only Daisy seems unaffected.
The beloved German Shepherd prances around
in all her innocent glory. Quick! Somebody teach
her how to code!

Welcome to Raptor Entertainment: an up
and coming game development outfit in Banga-
lore—some say the best India has to offer the
video-game industry.

Children Of A Dream
Sandeep Kowdley and Jayanth K set up Raptor
Entertainment in December 2001, a time when
the video-gaming scene in India was nascent
enough to be classified as non-existent. The chal-
lenge was to develop a game engine to power dig-
ital dreams. A unique challenge seen from any
angle: if gaming was embryonic, game develop-
ment in India was fantasy. “The greatest chal-
lenge has been getting a grip on the philosophies

Digital Passion l First Hand
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recently saw soldiers staging a fake siege and
then distributing free copies of the game to
their ‘hostages’. Talk about promotion! Enter-
tainment drives the global economy today, and
games are the biggest contributor.”

Raptor’s current project, Xtreeme Forces
has been in the making since October 2003. “I
grew up reading about the Soviet Union and
the cold war,” says lead designer Ashray Gokul.
“The elaborate and involved spy thrillers, (the
works of) Boris Pasternak, Solzhenitsyn, the
purges and the excesses of the Stalinist era…
that’s the stuff which fuelled my adolescent
dreams. So it was natural for me to think of a
game, based on events occurring after the fall
of the Soviet Empire.” 

The highlight of Xtreeme Forces has been
the response and support the game has
received from gamers, both in India and across
the globe. The gaming community is tightly-
knit—a ripple in the force is felt throughout
the gaming world and a good creation is
lauded almost as vehemently as a sub-par effort
is mocked out of the collective.

Raptor Entertainment recently showcased a
demo of Xtreeme Forces at Game Developers
Conference in San Jose, USA, in March this year.
The Game Developers Conference, as the cliché
goes, is the Mecca for the interactive art of
game creation. 

Far from being stoned or ridiculed, the
response they received at GDC 2004 was excel-
lent; these days many game publishers knock
quite frequently on their doors. Raptor is wise
beyond years though, as it patiently stalks the
scene for a better deal in the offing.

The High Of Creating
Game development and production is a com-
plex, lengthy process, which involves the inte-
gration of many specialised streams—from art,
to history, to mathematics—a game leaves
nothing untouched. 

“Game development is all about being cre-
ative; you are constantly pushing the bound-
aries of communication and interaction. 

and the working practices of an industry which
in India is new and untested,” says Ashray
Gokul,  Raptor’s lead designer.

Sandeep and Jayanth started out with
building a very small game concept to water
their fantasies. As Sandeep puts it, the seed was
a shared desire to create something that they
cherished: “I was always fascinated with the
depth of technicality that went into developing
games. I had a background of building
numerous applications, viruses (grins), 3D ren-
derers—the ones you coded bit by bit (said with
pride). It was natural to take it forward.”

Vidyuth Srinivasan, business relations head,
calls those at Raptor “children of art, music and
technology”. Ashray takes it further, “Sandeep,
Vikram, Vidyuth and myself were part of a local
rock band and we used to spend most of our
chill-out sessions discussing games”. He con-
tinues, “Initially, the project started out with
only three full-timers while seven were part-
time members. Gradually, as work piled on, the
dynamics changed and Raptor had four full-time
guys while the rest worked five to six hours a
day”. 

Today, Raptor has 12 dedicated team mem-
bers and two freelancers with the sole objective
to develop Xtreeme Foces, their maiden game.

Their designers work on
nine machines powered
by AMD processors and
sundry 3D cards with
monikers such as
nVidia GeForce 6800
GT and ATi Radeon
8500.

Name Of The
Game
Surprisingly, despite a
huge software
industry and an even
bigger film industry,
game development
has hardly seen any
growth in this
country. A primary
reason could be that
building a game has
long been associated
with software than
with entertainment. 

As Vidyuth
observes, “The (global
gaming) industry is
currently worth $40
billion. The promo-
tions for games world-
wide are
mind-boggling. An
armed-forces title

Podcasting is an exciting innovation. Thousands of
people are doing it these days: audio blogs, radio

shows, etc. are made available as MP3s; Podcasting
entails using software—such as iPodder—to port

these MP3s from your computer to an iPod or any
other MP3 audio device. It is thus a subscription
service which comes from an original source—the
‘PodCaster’—to an aggregator and then to you.
How’s that for democratic, ad-hoc radio?

There Is No Number One At Raptor

Sandeep and Jayanth say that without the
entire team, Raptor would not have been
possible. They give a big thumbs up to
Vidyuth Srinivasan, Ashray Gokul, Akshay A V,
Akshay B S, Joel Johnson, Keshav, Ravindra
Kumar, Sudhir G N, Poorna Chandra Suraj,
Vedavyas K P, Vijay R Sarthy, and Vikram
Parthan. They say they are also indebted to
the NVIDIA guys—Keita Iida, Darryl Still and
Guy Grenier—in addition to Raptor Dad 
Narasimhan and Raptor Uncle Anand Mutalik.

Podcasting

From left: Keshav Damodaran, Level Designer;
Vijay R Sarthy, Artist & Scripting;
Akshay A V, Operations and Quality Assurance

Ph
ot

og
ra

ph
s 

Sr
iv

at
sa

 S
ha

nd
ily

a



47NOVEMBER 2004 DIGIT

Digital Passion l First Hand

The buzz and the high of creation… there 
is nothing like it in the whole world!” 
gushes Ashray. 

“The fact that you can create digital content
within a massive game world, own it and then
sell it in the real world means that boundaries
between simulation and real life are blurring.
And gaming as an industry has been at the fore-
front of this crossover”. 

No gaming company in India has developed
more resources under their roof than Raptor: a
weapons engine, a camera engine, a
particle/composite-particle engine, a physics
engine, a character engine, a terrain-rendering
engine, a sound engine, a shadow engine and a
scripting engine, all created inhouse.

Architect-in-chief Sandeep, is responsible
for research, development and engineering of
the ‘XForce Engine’. How does the XForce (XF)
stack up against engines that power interna-
tionally renowned behemoths such as DOOM
III and Half-Life 2? The XF Engine is good, but as
Vidyuth puts it, “Doom III and Half-Life 2 have
too much technology for us to implement with
our limited budget… we do hope to get there
someday. The XF Engine cannot be compared to
those but most certainly can be compared to
the likes of the X-Ray Engine and the Crytek
Engine.” The XF Engine also implements
shaders and volumetric shadows,
“Technologically, things are advancing at a
very rapid pace,” says Sandeep, “…staying in
sync, is one of the most challenging tasks!” 

Driven By Passion
Raptor hopes to continue to build high-quality
games; future plans include taking their cre-
ation(s) to consoles. There are also plans of

licensing their engine, “One of the main con-
straints that have plagued growth of game
development in India is the time and money
consumed in setting up your technical plat-
form. The quicker approach of licensing a
quality game engine is almost unaffordable. 

In the future, we plan to license our engine
to fellow Indian developers at extremely nom-
inal costs”, says Sandeep. This is definitely good
news and we hope he follows-up on this plan as
affordable tools are of paramount importance
to Indian developers. 

“If the BPO sector of gaming such as Sound
Design and Production can be developed in
India over a given period; it will bring down
costs drastically,” says Vidyuth. “I see India’s
cost-effectiveness playing a huge part in the
progress of this industry.”

Making a game is a gargantuan investment
in cash (A good international title is often
budgeted to cost a few million dollars). What is
more impressive then is that Raptor
Entertainment is completely self-funded.
Sandeep: “Managing a team of 14 is certainly
difficult, especially with funding coming from
our own pockets! I must thank my dad, Mr.
Narasimhan, for understanding our wave-
lengths and being generous in helping us
through our tight situations.” 

The other side of
being financially inde-
pendent is that they do
not have a single game
release to their name
in the more than three
years of their exis-
tence. Will Raptor be
able to sustain itself
until the time their
game is released? They
certainly have the
passion to see it
through.

The fervour and
dedication that
the 14 possess is
evident as
Sandeep speaks
of hard times. He
looks back at
times when the
team worked its
“backside off”
without taking any
money home. 

“We would
skip a meal a day
and work! The
team never lost its drive or
focus, (adversities) just made us
look the challenge of making a
world-class game, in the face.” They will need
that fire to sustain themselves as time
progresses. Creating a game is no play but we
have faith in our boys from Bangalore. Go get
’em, Raptor! 

Xtreeme Forces is scheduled for a worldwide release towards
the end of 2005.

From left: PoornaChandra Suraj, Artist;
Vikram Parthan, Level Designer

From left: Sudhir G N &
Ravindra Kumar, Technical
Engineers
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Assembled something
just as geeky? 
Tell us about it. 
Write to editor@
thinkdigit.com
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In 1995, three friends had an brainwave—use the Net
to deliver advertising solutions. This is the story of
how a simple idea turned into a moneyspinner

Meera Vankipuram

hen Sachin Karweer of
Hinduja TMT’s Digital TV
services—Incablenet, was

looking to offer an Electronic
Programme Guide (EPG) to his
subscribers, he turned to Mumbai-
based Mediaware Infotech
(www.mediaware-infotech.com) for
help. Thanks to Mediaware, a
media solutions provider,
“Incablenet is today India’s first
MSO (Multisystem Operator) to
offer EPG to its viewers,” accord-
ing to Karweer.   

Mediaware offers HTMT, and
several other media organisa-

tions in India and abroad,
customised database and work-
flow management solutions.
Mediaware’s software solutions
are employed by advertising agen-
cies, media researchers, media
buyers and planners, client
accounting staff at ad agencies,
advertisers, and TV channels. 

Mediaware maintains a
comprehensive database of non-
syndicated media related infor-
mation, collected, updated and
maintained in an electronic
format by the Mediaware
Database Group. The database can
be accessed by paying a subscrip-
tion fee, and benefits media
buyers, advertising agencies,
advertisers, print publications, TV
channels, PR and market research
agencies. This is essentially a
collection of ad rates, circulation
details, contact information 
(for print publications), and

W



Mediaware initially envisaged
and constructed a media-rates
database, which would be updated
regularly. 

This was targeted mainly at
media executives.  Soon they
evolved a workflow and financial
accounting software, in addition
to customized modules for diverse
clients. Mediaware now makes
available database updates via
the Internet, through their
DOCX service. 

The Mediaware team, which
started out with a staff of 25, has
today grown to about 100
employees, mainly programmers,
with an annual turnover of
about Rs 9 crore. 

Solution Seekers
Founded in 1995, Mediaware
supplies software and database
solutions to nearly 400
customers across India and in

the Middle East. Corporate
houses employ Mediaware’s solu-
tions to automate and monitor
advertising and promotion activ-
ities, TV media houses use the
software for asset management,
print publications and other
broadcast media, in automating
their operations.

A veritable who’s who of the
Indian media feature on
Mediaware’s client list—agencies
such as Rediffusion, Publicis, FCB
Ulka, Enterprise, Euro RSCG, RK
Swamy, Carat, Madison and
Percept, broadcast networks such
as Sahara TV, Hinduja TMT, Jaya
TV, and companies such as
Videocon, Parle, and Living
Media among others.

What Is On Offer
Apart from the media database,
and special modules for financial
accounting and budgeting,
Mediaware’s services extend to
virtual data entry, web services
broking servers, pay-per-use tech-
nology platforms, remote data
entry, and more importantly,
seamless end-to-end integration
of disparate application software
across multiple locations.

The Mediaware team has also
developed services to connect ad
agencies, and has introduced e-
documents into the workflow
process. They have also devel-
oped server software as well as
programmable IM software. 

As Das puts it, “Our team regu-
larly updates our media database.
The updates are delivered to
clients through a web-based auto-
matic reporting system, connect-
ing different software applica-
tions via e-document exchange.” 

Their applications are
bundled with attractive add-ons
such as automatic desktop pop-
ups which alert clients to data-
base updates, electronic docu-
ment exchange via XML which
eliminates paper completely
from the workflow process as
well as keeps the client up-to-date
on the status of a particular proj-
ect, and online publishing of web
folders and documents.

Their message and web service
broking server software makes it
possible to connect disparate soft-
ware applications and deliver
electronic documents, with ease.
Mediaware’s programmable
Instant Messaging Servers can be
connected to any software appli-
cation. These double up as CRM
solutions as well as help integrate
applications via the Internet.

Mediaware’s tools can also be
adapted to build e-communities
and to implement e-documents
with digital signatures. (See the
Digit DVD for Mediaware’s E-
Community Builder tool)

The company also provides
technical support to its
customers, at every stage. 

Workflow Made Easy
Mumbai-based ad agency Media
Directions has been using
Mediaware’s database solutions
for a few years now. They also
purchased customised client-
interface software from the
company. Sandip Tarkas, CEO of
Media Directions: “The single
source access to a database of
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programme diaries and related
information for TV channels.

Apart from the database,
Mediaware also offers customised
software solutions for the media.
Their media operations software,
for example, automates all func-
tions from planning, estimating,
approval and releases to billing,
bill matching and posting to
accounts. 

Mediaware’s financial
accounting software is specifi-
cally designed for ad agency busi-
ness—it boasts of an extensive
taxation module, multi-branch
capability and bill matching,
among other features. This soft-
ware imports billing and receipt
data seamlessly from any other
media operations system. 

The Internet As A LAN  
Mediaware saw in the Net, a rela-
tively cheap, public network for

data, which could be deployed as
a LAN. 

Coupled with the effort to
make it easy for software to ‘talk
to each other’, Mediaware has
developed software and database
applications for the advertising
and media industry in India and
the Middle East. 

The company was founded in
1996 by Biswajit Das, Deepak
Chheda and Laxmikanth
Kulkarni. Says Das, “We realised
that many companies wanted to
automate their workflow
processes. We also found that
there was a need to maintain
extensive databases of client-
related information, especially
among media organisations.” 

There was a
need to
maintain
extensive
databases of
client-related
information,
especially
among media
organizations
Biswajit Das
Founder Mediaware

How Mediaware’s Solution Works

1. In the mad, ad-
world, an executive
wishes to place an
ad intelligently 

2. He approaches
Mediaware and
purchases their
database software

3. The database is
regularly updated
with ad-rates, and
reports are sent to
the executive... 

4. ...who can now
purchase ad-space
intelligently
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contacts as well as ad rates is rather useful, especially for
media organisations. With constant tinkering, the customised
applications are particularly effective.”

One of Mediaware’s recent clients, Parle Products, was
looking for a solution to curb escalating media budgets. They
also wanted to track and monitor media activity, and expenses
related to advertising and retrieval problems. 

Mediaware, which has taken up this project, will design
an Oracle-based database solution for Parle on a .NET plat-
form. Their solution will help Parle eliminate paper from the
entire process, by receiving and sending reports from Parle’s
media agencies in the form of e-documents, receiving telecast
certificates online, in electronic format, automatic bill pass-
ing and transferring purchase vouchers and credit notes
online, among other things. 

The solution will also aid Parle integrate their media
agency’s (Rediffusion/TME) software with their new software
system to receive estimates electronically from the latter—in a
secure manner.

Parle officials say, “Until now, we didn’t have a process in
place. With this solution, the workflow will be smooth and
work will be allotted in a better manner.”

Life Insurance Corporation (LIC) is another big organisa-
tion that found the need for Mediaware’s solutions.
Venkateshwaran, Executive (Publicity) for LIC (Mumbai) says,
“We purchased the AMW software (software + database solu-
tion) to automatically prepare estimates and budget details. I
find it a rather useful tool. We have been using this software
for several years now.”

On To Convergence
Mediaware’s Kulkarni affirms, “I think we succeeded because
we have domain knowledge built over time and our clients
prefer that. By utilising an existing network like the Internet,
we were able to provide a boost to our database and workflow-
related services—especially for prompt delivery of updates.”

Mediaware plans to expand their target market to advertis-
ers as well, in addition to ad-agencies and media houses. 

The trio foresees a healthy future for advertising.
“Although agencies are not really cutting down on budgets,
they want to find innovative ways to catch the customer’s eye.
They now offer more promotional schemes and bargains,”
says Das.

Convergence is another trend to watch out for. Das opines,
“Internet advertising is on the rise. But it is only about one per
cent of the ad spend in India. However, I think convergence is
closer than we think. A combination of Internet plus TV will
provide advertisers more reach than ever.”

meera_vankipuram@thinkdigit.com

Mad about ads: (L to R) Vishwajit Das, Deepak Cheda and Laxmikanth
Kulkarni
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All your hard work and valuable information can disappear in the blink
of an eye, if you don’t back up your data. This test will help you choose
between optical drives and external hard disks as backup solutions
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Aliasgar Pardawala

W
e go about our
daily work com-
m u n i c a t i n g ,
d o c u m e n t i n g
and in the end,

produce results. 
Software is replaceable, but

the data you’ve generated putting
in personal effort isn’t. You stand
to lose hundreds or thousands of
hours of work if you do not have
a backup solution in place.

There are various backup
solutions to choose from—the
one you choose depends on your
requirements. The most afford-
able ones are CD or DVD burners,
and internal hard disk drives—
perhaps in a RAID setup—fol-
lowed by external hard drives,
tape drives, etc. Then there are
online backup solutions pro-
vided by Web sites such as XDrive
and IBackup, which are conven-
ient since there is no physical
medium that you need to safe-
guard. Unfortunately, online
backup solutions are yet to make
their presence felt in India, as
they, naturally, rely heavily on
broadband access.

CD or DVD burners are afford-
able, and so are the media they
use. They are not the most con-
venient though, as they require
you to sit down and burn disk
after disk. Backing up is an impor-
tant part of office work, but you
do not want it taking up an entire
day of your working week!

A quicker option is an
external hard drive. You can get
an external drive with a capacity
that matches or exceeds that of
your workstation or server hard
drive(s). Making a complete disk
mirror takes a short while and
almost no effort after the initial
configuration and software
setup. The biggest advantage that
external hard drives bring is data
portability.

This hardware test takes a
look at currently available
backup solutions: DVD burners
and external hard drives. 
We divided DVD burners into
three categories: single-layer
burners, dual-layer burners, and
external burners. The external
hard disk drives were cate-
gorised according to  size. It’s up
to you to pick a solution to suit
your need.  

DVD WRITERS
For this test, we received 23 DVD
burners from 13 different ven-
dors. Of our three categories:
Single-layer DVD writers, dual-
layer DVD writers and external
DVD writers—the maximum
number of drives were single-
layer, internal DVD writers. 

We were glad to see eight
drives from seven different ven-
dors with dual-layer DVD-writing
support. This showcases the speed
with which technology is
adopted. Dual-layer writing sup-
port was also seen in external
DVD burners of IOmega. 
Availability of optical DVD
media—especially dual-layer—is
currently an issue, but this too
shall pass with time.

Single-layer DVD Writers
Single-layer DVD burners can
burn up to 4.3 GB of data onto
single-layer DVD media. By cur-
rent CD standards, 4.3 GB is  large
indeed. A typical SoHo worksta-
tion is likely to have 
40 or 60 GB of disk space, a com-
plete backup of which will fit on
just 10 to 15 single-layer DVDs.
Besides, the cost per MB for single-
layer media has dropped enough
to rival that of CDs. Add to this
the convenience offered by DVDs,
and they seem even more attrac-
tive. Of course, a dual-layer
burner means higher capacities,
but lower-cost single-layer disks
are sufficient for most scenarios.

In this category, we had one
drive each from Sony, ASUS,
Gigabyte, Samsung, AOpen, and
Krypton; two from Plextor; and
three from Lite-On. All, except the
AOpen, were capable of burning
to both DVD+R and DVD-R. The
AOpen only supports DVD+R.
Even Pioneer, the pushers of the
DVD-R format, offers full DVD+R
compatibility with their drives.

Features
The two Plextor burners we
tested—the PX-708A and the PX-
712A, at 8X and 12X respectively—
offer a winning set of features: Mt
Rainier support—which is the
new standard in packet writing
technology, designed to do away
with specific software such as
InCD and Direct-To-Disk; excel-
lent build quality; and a generous
8 MB of buffer memory in the 12X
variant. Since the other drives
offer only 2 MB, Plextor’s 12X
model performed well. 
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DVD WRITERS

Our test-bed for DVD burners comprised an Intel Pentium 4
3.0 GHz on an MSI 875P NEO motherboard, supported by

512 MB of DDR400 SDRAM and a 200 GB Seagate Barracuda
SATA hard disk. Microsoft Windows XP with SP1, along with the
latest  drivers, was the operating system used.

Features
Features such as Mt Rainer support, data buffer, silent
operation, etc., were rated on a scale of five.

Package Content
Here we checked and allocated points to accessories that
added value, such as data cable and blank DVD media,
provided along with a drive. Similarly, a drive with DVD-
authoring and playback software was awarded more points.

Performance
We ran a battery of tests—a mix of synthetic and real-world—to
gauge the performance of the drive. Nero Burning ROM
6.3.1.20 was used as the authoring software to burn data on
CDs and DVDs.

Nero Speed: Nero Speed was used to measure transfer rate
and data throughput, in addition to access time and CPU
utilisation of the drives in question. This test offers insight on a
drive’s performance.

SiSoft Sandra 2004: SiSoft Sandra is a synthetic
benchmark that measures the sequential and random 
read speed of a drive. It does this by constantly reading 
data at the maximum speed supported. It also measures the
access time.

CD Ripping Test Using dbPowerAmp: In this test, we
encoded an audio CD of 13 tracks and noted down the time
taken by each drive. 

DVD Video Extraction Using DVD Decrypter: Using DVD
Decrypter 3.5.1.0, we encoded a DVD movie and noted down
the time taken by each drive to complete the task.

Burning Test For A CD/CD-RW: In this test we burned 700
MB of assorted data and a 700 MB file on a CD/CD-RW. The
time taken by each drive was then noted. We also noted the
time needed to erase a re-writable disc. We used 52X Moser
Baer CD-R and Mitsubishi 24X US (Ultra Speed) CD-RW as
optical media.

Burning Test For A DVD: A 4.3 GB file and assorted data
were writted on a Memorex 8X DVD-R, a Verbatim 8X DVD+R
and a Sony 4X DVD+RW media. We ran additional erasing tests
for DVD+RW media and noted the time taken. For the dual-
layer drives we used a Verbatim 2.4X and noted down the time
taken to burn 8.5 GB data on it.

EXTERNAL HARD DRIVES
Our test configuration, consisted of  an Intel Pentium 4 2.6 GHz
processor on an i845 chipset-based, ABit BG7E motherboard.
The rig had 256 MB of DDR SDRAM and a Seagate 40 GB hard
disk. The latest drivers for the motherboard and USB ports were
loaded. To maintain a standard environment, we installed only
the required benchmarking utilities and the needed test files.

Features
We looked at various inbuilt characteristics and qualities of
each drive. Considering that every product was marketed as a
portable device, we laid emphasis on a drive’s weight. 

Portability was awarded less importance for a 3.5-inch
drive, since their usage will primarily be as a stationary backup
device. 

Build-quality was also assessed, with particular importance
given to the sturdiness of the product. Bonus points were
awarded for miscellaneous features such as extra
USB/FireWire port, configurable buttons, and also for useful
software included. 

Performance 
Both synthetic and real-world tests were conducted to gauge
performance. SiSoft Sandra Professional 2004 was used to
assess theoretical read and write speeds, as well as the
average access time. We also tested with HDTach 2.7 and noted
the average CPU utilisation of each drive.

For real-world performance evaluation, we transferred a
set of assorted files of varying sizes, totalling 1 GB, back and
forth, from the system hard disk to the external hard disk, and
noted the time taken during each transfer. Similarly, to test the
sequential speeds, we transferred a large image of 1 GB
between the system and the external drive.

Price Index
This was calculated taking into account the ideal price for
which an external hard disk is available. 

How We Awarded
Scores granted to Features, Build Quality, Performance and
Price were given weightages relevant to specific categories. An
overall score out of 100 was then calculated. The product that
scored the highest here was adjudged the winner of the Digit
Best Buy Gold award for its category. The runner-up was
awarded the Digit Best Buy Silver award.

How We Tested

We used dbPowerAmp to test CD Ripping

Nero Burning ROM was used to burn DVDs
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The PX-712A and the Lite-On
SOHW-1213S were the fastest at
burning CDs—at speeds of 48X. CD
burners may have reached 52X,
but 48X is pretty fast. All the
other contenders topped out at
40X. The Lite-On SOHW-1613S was
the only one in this category to be
able to burn DVD+Rs at 16X,
making it the fastest to do so.
AOpen’s DRW4410R supported
CD-R, CD-RW, DVD+R and
DVD+RW, and it came with a
decent software bundle—but no
DVD-R support. The DVD+R and
CD-R speeds of the AOpen maxed
out at 4X and 12X respectively. All
the others lapped the AOpen on
this circuit.

The Plextor burners also offer
notable features: VariRec, a
recording mode that lets you
adjust the power of the laser to
produce CDs and DVDs that are
compatible with non-PC hard-
ware—such as music systems and
desktop DVD players—and are also
more reliable. GigaRec lets you
burn 1 GB of data on a standard
700 MB CD-R, and SecuRec allows
you to password protect data on
your disks. These features add
value to the drives.

Performance
While taking server backups, you
are talking several hundred giga-
bytes of data. Writing speeds are
therefore very important when
making a buying decision.
Remember that read speeds
matter too, since you will also
need to restore the data you
backed up.

The Plextor PX-712A aced the
performance tests with the fastest
DVD+R times at 12X as well as the
fastest DVD-R burning times at
8X, coupled with great CD-R/RW
scores. Media reading was also the
fastest with the PX-712A. Surpris-
ingly, the Plextor PX-708A failed
the CD-RW tests with both Ultra-
Speed (24X) as well as UltraSpeed+
(32X) media. Also, the DVD-R

speed was limited to 4X
despite its rated 8X, and
DVD+RW scores were
comparatively lower. The
Sony DRU-540A posted
some pretty impressive

DVD±R/RW burning scores, fol-
lowed by the Lite-On SOHW-1213S
and the Asus DRW-1604P. 

Amongst the losers was Sam-
sung’s TS-H542. While most
burners could even overburn at
12X on 8X-rated DVD-R media, the
TS-H542 only managed to write at
4X—even after a firmware
upgrade. 

Our assorted DVD+R test took
almost twice the time that the
sequential test took, which was
quite strange since almost all the
other writers gave very similar
times for these two tests. The
AOpen DRW4410R also had a 4X
maximum speed for DVD+R
burning, and as mentioned ear-
lier, offered no support for DVD-
R. 

The Krypton DRW1008IM dis-
appointed us with below-par 
DVD-R burning at 4X and DVD+R
burning that started off at 8X,
but, more often than not,
dropped to 4X. We tried to
upgrade the firmware hoping to
improve the drive’s media com-
patibility. However, we were
unable to even get the update
patch to recognise the Krypton as
a compatible target drive!

Price
This is totally Lite-On territory:
With prices as low as Rs 4,495 and
extremely competent perform-
ance, its SOHW-812S makes for
the ultimate option, if your wallet
is what you are thinking with.
The next on the price podium is
another Lite-On—the SOHW-1213S
at Rs 4,750.  

The Krypton drive may not
have performed too well in the
tests, but is affordable, at Rs 4,850.
Plextor’s 8X variant, the PX-708A,
is competitively priced at Rs
5,500, but since it failed our CD-
RW tests, we recommend you
steer clear from it. The other
Plextor, the PX-712A, at Rs 7,000, is
the second-most expensive drive
in this category, but has great per-

formance and features to back it
up. 

You might say you get what
you pay for, but unfortunately,
that’s not true for all the drives:
what the Sony DRU-540A gains in
performance, it loses out in
pricing. At Rs 7,500, it is the most
expensive.

Conclusion
Plextor’s PX-712A is undoubtedly
the best performer in the single-
layer category. Though it has a
comparatively high price tag of Rs
7,000, the extra features it pro-
vides, makes it a good deal. As of

now, even 8X media is rare
in India, and when that

becomes commonplace, you

will be looking for 12X media. 
Thus, buying the Plextor PX-

712A (which has a 12X DVD+R
speed) will future-proof your
investment. But wait—the
Plextor’s score of 70.43 is not the
highest. The Lite-On SOHW-812S
runs past it by a whisker—70.47.
How did that happen? Two fac-
tors: great price and decent per-
formance.

Even so, the scores are too
close to push one off to a lower

level, so we decided to have a
tie—both the Plextor PX-712A
and the Lite-On SOHW-812S
earn the Best Buy Gold award,

and they deserve it. 
The Best Buy Silver goes to the

Lite-On SOHW-1213S for decent
performance and affordable
pricing.

Dual-Layer DVD Writers
Most movie DVDs have 8 GB of
video on what are called dual-
layer DVDs or DVD9s. 

They have been around for
long, but consumers were
deprived of this technology and

An external interface, first
popularised by Apple. 
There are two types of FireWire
ports, often referred to by their
throughput—FireWire400 and
FireWire800. Firewire400 is a
relatively old standard and has a
throughput of 400 Mbps, whereas
the newer FireWire800 offers twice
that speed.

FireWire

The Plextor PX-712A

NOVEMBER 2004

The Lite-On SOHW-812S

NOVEMBER 2004

The Lite-On SOHW-1213S

NOVEMBER 2004
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had to make do with single-layer
DVDs or DVD5s, until now. Get
ready to cram 8.5 GB of data on
just one disk! For the typical work-
station backup we mentioned ear-
lier, you can pack it off in only 5
DVDs instead of 10. 

Dual-layer burning means you
will not need applications such as
DVD Shrink to compress DVD9
movies to make them fit on a
DVD±R.

We tested a total of eight dual-
layer burners in this category:
drives from Pioneer, Lite-On, LG,
MSI, Sony, ASUS and BenQ. All of
them burn dual-layer media at
2.4X. The ASUS DRW-1604P and
the Pioneer DVR-108, though go
up to 4X.

Features
As was seen earlier, ASUS and Pio-
neer lead the features pack with
the fastest dual-layer burning
speed—4X. Strange though it may
seem, they also have the lowest
CD-R speed at 32X. Every other
drive does 40X, barring the Lite-
On SHOW-1633S which zooms
ahead at 48X. 

The ASUS DRW-1604P is a
rebagged version of the Pioneer
DVR-108, much as the single-
layer ASUS DRW-0804P is a

rebagged Pioneer DVR-107, which
we haven’t tested. Speaking of
rebagging, even the Sony DRU-
700A is a Lite-On SHOW-832S! The
Pioneer we received was a bulky
OEM piece—it came sans a box, in
a plastic wrap with only one CD
containing Sonic RecordNow.

LG receives special mention
here for being the only drive to
offer DVD-RAM burning at 5X.
Only the Pioneer and the ASUS
drives support reading DVD-
RAMs. Also interestingly, the
BenQ DW1600, shipped by default
as a single-layer drive can be
upgraded to the next model, the
DW1620, by a free, official
firmware upgrade! We naturally
upped the firmware for the tests.

The Sony drive also came with
an extra faceplate—a new trend
for others to follow? Nokia did it
for mobile phones; perhaps Sony
will do it for optical drives.

Performance

The Pioneer and the ASUS were
head-to-head in all the perform-
ance tests, while also being ahead
of the others, thanks to 4X dual-
layer burning. 

They burned a disk in a little
under 27 minutes. The BenQ drive
almost caught up, with very com-
petitive reading scores and higher
CD scores, but fell back because of
its 2.4X dual-layer speed. It took
45 minutes, which was more or
less the average score for the rest
of the drives. 

These three drives—the Pio-
neer, the ASUS, and the BenQ—all
performed well in the DVD+R and
DVD-R tests, burning at an impres-
sive 12X. However, the BenQ was
the fastest here because of the
CAV-writing method as opposed
to the Z-CLV method used by the
Pioneer and the ASUS. 

The LG lagged behind with
the lowest scores in both reading
and writing—only 4X DVD-R sup-
port, and a 12X DVD+R support
which actually averaged around
6X. MSI missed out on the DVD-R
scores as well. It also revealed a
near 4-minute difference between
the assorted and the sequential
tests.

Price
The Lite-On SOHW-1633S steals
the show in this category. Very
affordable at Rs 5,750, it is mar-
ginally more expensive than its
sibling, the SOHW-832S, but
offers double the speed for DVD+R
media—a very big plus. This is the
cheapest 16X dual-layer drive in
the market.

The Pioneer and ASUS drives,
at Rs 6,300 and Rs 7,250 respec-
tively, offer higher dual-layer per-
formance. LG loses the price
battle badly with skimpy per-
formance and Rs 8,000 on the bill,
along with Sony, also priced at Rs
7,999—for the extra faceplate?
Thanks, but no thanks…

Conclusion
A 16X drive with 4X dual-layer
burning for Rs 6,300 is simply
unbeatable. Yes, the Pioneer DVR-
108 is an OEM piece that is sup-
plied to PC manufacturers such as
HP to sell with their PCs, and for
that reason, it comes with no
media or manual, but we have yet
to see those facts make a notable
difference to the market. The
drive works well, and is cheap. It
wins Gold with an overall score of
72.77, and makes for a great
choice for speedy backups. 

Not all burners are created equal. Not all of
them read and write the same way even if

their operational speed is the same. Here are a
few strategies that different burners employ:

Constant Linear Velocity (CLV): The
advantage of CLV is a constant data-transfer
rate. Depending upon the location of the data
on an optical disk, the rotational speed of the
burner varies: less amount of data is stored
near the centre of the disk, so the disk spins
fastest to maintain data throughput. As data is
read from portions closer to the outside of the
disk, its speed slows down, since more data is
read per rotation. With CLV, the rotation speed
of a disk changes according to the location of
the data on the disk.

Zonal Constant Linear Velocity (Z-CLV): Z-
CLV uses the CLV mode and further divides a
disk into different parts, called zones. A Z-CLV
burner starts writing at 6X, and steps up to 8X
for the next zone, 12X for the zone after that,
and so on. Most high speed burners use this
technology.

Constant Angular Velocity (CAV): Quite the
opposite of CLV, here the rotational speed
remains constant regardless of the physical
location of data on the disk. If read in sequence
from the centre of the disk right to the
periphery, the transfer rate increases smoothly.

The average transfer rate is generally lower
than the advertised speed—for example, 16X.

Partial Constant Angular Velocity (P-CAV):
P-CAV is a mix of CLV and CAV. Like CAV, the
transfer rate goes on increasing until the
speed tops out at the rated speed of the
burner. From then on, the drive slows down
and the data transfer rate remians constant,
akin to CLV—by varying the rotational speed of
the disk. Using the P-CAV method, burners
reach the rated maximum speed faster than
burners using CAV, thus achieving a higher
average transfer rate.

As far as usage is concerned, Z-CLV is not
the best-performing method, because the
average performance of a CAV or a P-CAV
method is better. For Z-CLV, the time taken to
step up the speed to the next zone can add
extra time and lower the performance. As an
example, the Plextor PX-712A, which uses P-CAV
writing, is faster at 12X than the Pioneer DVR-
108 at 16X, which uses Z-CLV—the Pioneer
burner doesn’t step its speed up from 12X to
16X until about 4 GB is burnt. In other words, if
you don’t burn a full 4.3 GB on the disk using
the Pioneer, you’ll never reach the 16X zone,
essentially making the drive a 12X! If the Plextor
was a dual-layered drive, we think it would have
taken the Gold away from the Pioneer burner.

Demystifying Burners

The Pioneer DVR-108

NOVEMBER 2004
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Silver has to
be handed out to
the ASUS DRW-
1604P for an
overall score of
69.90. Lite-On’s
SOHW-1633S
gets a consola-
tion prize for
extremely good
pricing, together with a decent performance. If your
budget is too tight for the Pioneer or the ASUS, the
Lite-On is for you.

External DVD Writers
Mobility in backup solutions is an important aspect
to consider. With an external DVD writer, the
process of backing up becomes more efficient as it
only involves unplugging the device from one
machine and plugging it into another. 

You do not need to shutdown the machine(s) in
question, since these are all USB or FireWire-enabled
devices. Additionally, if you plan to copy data from
one machine and burn it on another, you save time
otherwise spent waiting for data transfers over the
network. You can travel around with an external
burner, effortlessly plugging it into any capable
system and getting the data out when you need it.

We had two external DVD burners from Plextor,
and one each from Iomega and AOpen.

Features
The Plextor burners were USB 2.0/FireWire versions
of the exact same drives that we tested in the single-
layer internal category: the PX-708UF and the PX-
712UF, where UF stands for “USB2.0/FireWire.” The
A in the single-layer internals stands for “ATAPI.” The
specs of the PX-712UF were obviously the same: 12X
DVD+R, 8X DVD-R, and 48X CD-R, which was the best
in the category. The Iomega drive was up to par with
DVD speeds, and almost there with 40X CD-R
writing. But it was the only drive capable of burning
dual-layered DVD+Rs.

The AOpen lost out because of its 2.4X DVD+R
speeds, and again, no DVD-R support. Also, the 
CD-R speed was the lowest in the whole range
including the single-layer drives—only 12X. However,
it came with the best bundle—a DVD+R, DVD+RW,

For regular optical CDs, you have speeds going
from 1X all the way to 52X. But for CD-RW media,

we have speed “brackets,” and they are named
accordingly. As of now there are four types of CD-
RWs available:

· Multi Speed: 1X - 4X
· High Speed: 4X - 12X
· Ultra Speed: 16X - 24X
· Ultra Speed+: 24X - 32X
Burners have to support that speed to be able to

burn on a CD-RW disk from that bracket. If the CD-
RW is rated higher, your burner may not be able to
write to it. You can still read the disks, though. All
the DVD burners we tested are UltraSpeed
compatible, but only a few—such as the Pioneer,
ASUS, BenQ and the IOmega—support UltraSpeed+
CD-RW, albeit only at 24X.

The Speed Trap

1/2 pg V AD

The ASUS DRW-1604P
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CD-R, CD-RW, and good software,
just like its internal “brother”,
but that didn’t do too much to
boost its overall score.

All the drives except the
AOpen came with USB 2.0 as well
as FireWire support. The AOpen
only had USB 2.0 support.

Performance
Since USB was common across all
the drives, we did not test
FireWire performance. The

Plextor PX-712UF obviously
turned in the best burning

speeds with DVDs as well as
CDs. It is, after all, a faster

drive. However, the Iomega
turned in better read scores. 

The Iomega, though, failed
the DVD+R dual-layer burning
test, making it the only dual-layer
drive in our entire shootout to do
so. 

Since the Iomega was the only
dual-layer drive in this category,
and it failed, we had to nullify the
results of the dual-layer test to
put the drives on par with each
other. The AOpen drive was the
slowest in reading DVD-ROMs and
writing DVD+Rs, but it was faster

at DVD+RW than the Plextor
PX-708UF, finishing up a
minute earlier. Both of them,
however, failed the CD-RW test.

Price
At Rs 11,000 for the 8X variant
and Rs 13,500 for the 12X variant,
the Plextor drives come out on
top of the low-cost countdown.
This is surprising, since Plextor
products are generally not the
lowest-priced—at least when other
generally low-cost players such as
AOpen are in the reckoning. 

By the way, the underpowered
AOpen is a scorching Rs 14,900 a
piece, which we think is obscene
for a drive with no 
DVD-R support and the lowest
read/write speeds across all
media. The Iomega was the most
expensive at Rs 15,750; though, it
does have dual-layer DVD+R
burning.

Conclusion
From the performance point of
view, and considering price-to-per-
formance ratio, the Plextor PX-
712UF comes out as winner of the
Best Buy Gold award. For about Rs
1,500 extra over the PX-708A, you
get a 12X DVD+R, 48X CD-R, and
24X CD-RW along with full Ultra-
Speed+ compatibility. Can’t beat
that, can you?

The runner-up is also a
Plextor—the PX-708A, thanks 
to its low cost and acceptable per-
formance rating. If you 

can afford to spend a few minutes
more on your backups, the 8X
write speed will cost you 
Rs 1,500 less.

EXTERNAL HARD
DRIVES
An external hard drive is the
peripheral of choice if there is a
lot of data to be backed up, and if
it needs to be accessed frequently.
The faster USB 2.0 and FireWire
interfaces found in most of these
drives significantly reduces the
time taken to back up large
chunks of data. 

Currently, these drives are
available in three form factors.
The first package is the one that
houses 3.5-inch drives. These
external hard drives are large,
heavy, and need an external
power supply. They usually ship in
capacities as high as 250 GB. The
other two packages house 2.5 and
1.8-inch drives respectively. These
tiny drives are very light and
pocketable—especially the 1.8-
inch variety. They draw power
from the interface. 

Since these drives will be used
for backup, vendors bundle along
the necessary software. We gath-
ered 14 models from five brands
in our external hard drive
shootout to bring you the best in
the market in terms of perform-
ance and price.

The Heavyweights
There were total of five drives: one
each from Freecom, Iomega,
Maxtor, Seagate and Western Dig-
ital. The combined capacity of
these drives was 1,040 GB, which
can store around 120 to 200 DVD
movies, or 1.8 lakh MP3s!

Features
Since all these drives featured 3.5-
inch drives, they were bulky. The
Iomega HDD 160GB was the
lightest at 817 gm, and was com-
pact. The packaging of the
Freecom, which weighed 
900 gm, was impressive. At 
1,450 gm, the Western Digital was
the heaviest. Except for the
Freecom FHD-1 120GB, the rest of
the drives were stackable, and

Basic Specifications—Write speeds Price (Rs)Model Score Brand

DVD Writers Scoreboard

EHD-2412U
DVDRW4216E2D
PX-708UF
PX-712UF

DRW-1604P
DW1600
SOHW-1633S
SOHW-832S
GSA-4120B
DR16-B
DVR-108
DRU-700A

DRW4410R
DRW-0804P
GO-W0808A
DRW1008IM
SOHW-812S
SOHW-1613S
SOHW-1213S
PX-708A
PX-712A
TS-H542
DRU-540A

DVD+R

2.4X
12X
8X
12X

16X
16X
16X
8X
12X
16X
16X
8X

4X
8X
8X
8X
8X
16X
12X
8X
12X
12X
12X

DVD-R

NA
8X
4X
8X

16X
NA
8X
8X
8X
16X
16X
8X

NA
8X
8X
4X
8X
8X
8X
4X
8X
8X
8X

DVD+RW

2.4X
4X
4X
4X

4X
4X
4X
4X
4X
4X
4X
4X

4X
4X
4X
4X
4X
4X
2.4X
4X
4X
4X
4X

DVD-RW

NA
4X
2X
4X

4X
NA
4X
4X
4X
4X
4X
4X

NA
4X
4X
2X
4X
4X
4X
2X
4X
4X
4X

DVD+R DL

NA
2.4X
NA
NA

4X
2.4X
2.4X
2.4X
2.4X
2.4X
4X
2.4X

NA
NA
NA
NA
NA
NA
NA
NA
NA
NA
NA

CD-R

12X
40X
40X
48X

32X
40X
48X
40X
40X
40X
32X
40X

24X
24X
40X
40X
40X
48X
48X
40X
48X
40X
40X

CD-RW

10X
24X
24X
24X

24X
24X
24X
24X
24X
24X
24X
24X

10X
24X
24X
24X
24X
24X
24X
24X
24X
24X
24X

41.41
48.35
58.60
61.20

69.90
68.46
68.63
68.20
59.00
65.81
72.77
62.23

56.13
63.21
65.41
63.97
70.47
67.96
69.13
65.70
70.43
61.62
62.22

14,900
15,750
11,000
13,500

7,250
7,999
5,750
5,550
8,000
7,000
6,300
7,500

5,690
6,750
5,500
4,850
4,495
5,595
4,750
5,500
7,000
6,000
7,500

External DVD Writers

Dual-Layer DVD Writers

Single-Layer DVD Writers

The Plextor PX-712UF

The Plextor PX-708UF

NOVEMBER 2004

NOVEMBER 2004

AOpen
IOmega
Plextor
Plextor

ASUS
BenQ
Lite-On
Lite-On
LG
MSI
Pioneer
Sony

AOpen
ASUS
Gigabyte
Krypton/BTC
Lite-On
Lite-On
Lite-On
Plextor
Plextor
Samsung
Sony
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came with stands for vertical
mounting. Western Digital also
supplied rubber pegs, to safe-
guard the body from scratches. 

USB 2.0 was the interface of
choice. Since many graphics pro-
fessionals prefer Macintosh sys-
tems to run their graphical tools,
FireWire was supported. The
IOmega, however, didn’t support
FireWire. 

Disk-side USB connectors used
in hard drives were standard,
unlike in digital cameras where
vendors modify their shape—
which forces users to buy propri-
etary USB cables at premium
rates. All the drives came with the
standard USB connector, cables
for which are readily available in
the market.

Another great development of
late, in external hard drives, is the
application  launch button on the
device itself. The button launches
the backup software provided
with the drive. Although not a
revolutionary feature, it saves a
few mouse clicks. 

Maxtor called this button the
One Touch, Seagate called it
Backup, whereas Freecom called
it SYNC. Western Digital went one
step ahead and incorporated 2
buttons—one each for automatic
and manual backups.

All five drives came with good
software. The Freecom FHD-1
120GB came with Acronis True
Image, which can
create an image,

restore data, write an image to a
CD or DVD, and also restore from
a network. 

Iomega came with Norton
Ghost 2003; the Maxtor and
Western Digital were bundled
with Dantz Retrospect Express,
which is capable of locating the
files to be backed up on the media
without user intervention. It can
even create restore points. 

Seagate provided BounceBack
Express, which can restore lost
data, and back up data from any
mapped drive on the network.

It would be an understate-
ment to call the Western Digital
Media Center an external hard
drive. It is rightly named “Media
Center,” because it not only func-
tions as external hard drive, but
also has an 8-in-1 card reader and
two extra USB and one extra
FireWire port—which makes it a
USB/FireWire hub. 

Freecom and Seagate were the
only other drives that had extra
FireWire ports. The IOmega came
with no extra ports.

Build Quality
Since external drives house very
sensitive insides, the package has
to be sturdy enough to take the
shocks and jerks associated with
a portable medium. It also has to
be splash- and dust-resistant for
smooth operation over a long
period of time.

All the drives featured very
good build quality, with Freecom
topping the chart. The Freecom
FHD-1 120 GB had a tiny fan at
the back to regulate the heat gen-
erated by its 7,200-rpm drive.

Seagate and Western Digital,
on the other hand, had a cage
design for air regulation, which
also exposed the drive and its
electronics to dust and water—not
a very good idea. None of the
drives came with a carry case.

Performance
We performed three sets of tests
to gauge the performance of the
drives. We ran two synthetic
benchmarks—HDTach and SiSoft
Sandra 2004 Pro, to get the data
transfer speed, access time and
CPU utilisation.

In SiSoft Sandra, we got
slayer DVD writers, dual-layer
DVD writers and external DVD
writers—the maximum number
of drives were single-layer,
internal DVD writers. 

We were glad to see eight
drives from seven dif, internal

DVD writers. We were glad to see
eight drives from seven difeecom
and Maxtor One Touch managed
a respectable 31 MBps in the
sequential read test. This means
that these drives will take the
least time to restore a drive
image, which is a single, large
file. In the random write test, the
Maxtor One Touch reached a high
of 17 MBps, which is a good score
for an external drive. 

In HDTach 2.7, the Freecom
FHD-1 120GB drive returned
decent scores. It logged an access
time of 13.3 compared to the 21.2
logged by Maxtor, because of its
multiple platters and heads. 

The Seagate ST3160024A
160GB edged passed the Freecom
by a few decimal points in average
write speed, logging 18.3 MBps.
The sore point in this test was the
CPU utilisation, which was in the
range of 28 to 45 per cent.
Western Digital needs 44.8 per
cent of the CPU cycles while trans-
ferring data, whereas Seagate
needed 28.4 per cent—the lowest
in the test.

These drives, if
plugged into older
machines, will
bring them to
their knees, and

wouldn’t allow any CPU-intensive
processes such as Photoshop to
run while data is being trans-
ferred.

To test for real-world sce-
narios, we copied a single 1 GB
image and assorted 1 GB data to
and from an external hard drive. 

In this test, the Maxtor One
Touch was faster than the rest. In
the sequential write test, where
we copied a 1 GB image from a
local drive to the Maxtor One
Touch, the transfer took 52.23 sec-
onds. This means that the drive
will be very useful to image artists
and videographers, because their
files usually are a few GB.

The Seagate, despite running
at 7,200-rpm with 8 MB of buffer,
took 62.78 seconds—which may
not make for a major difference if
we consider just 1 GB of dataThe Western Digital Media Center

The Maxtor OneTouch 250 GB

NOVEMBER 2004

NOVEMBER 2004

There are quite a few DVD burners available now that
support write speeds of up to 16X. However,

availability of 16X DVD media is still a big problem, even
outside India. In fact, branded 8X media have just
started selling here. We had quite a few problems
sourcing branded media for this test, and were actually
saved by one of our colleagues who got us branded
media from the United States. The media we used are
the 8X Verbatim DVD+R and the 8X Memorex DVD-R,
both of which are capable of writing at up to 12X speeds.
After spending almost Rs 10,000 to purchase the blank
media required for this test, the Digit team can proudly
claim to have some of the most expensive coasters!

Media Speedia



64 DIGIT NOVEMBER 2004

Digital Tools l Test Centre

transfer, but if the file were
around 20 GB, the difference
would be considerable.

In the sequential write test,
the Maxtor, once again, finished
its job ahead of the rest, at 46.9
seconds. The IOmega was slug-
gish in this test, with 64.07 sec-
onds. In the assorted write test,
the IOmega HDD 160GB edged
passed the rest, logging the
lowest time—61.23 seconds. The
Maxtor One Touch here was the
slowest—it completed the task in
75.62 seconds.

Overall, it is the Maxtor One
Touch that will be sufficient for
the needs of users across the
board, because in general, there
will be both sequential and
assorted data to be backed up 
and restored.

Conclusion
In this category the Western Dig-
ital Media Center topped the
chart, being the only drive packed
with features: it offered card
readers, and USB and FireWire
hub support. 

It offered decent performance
and a low price per MB of just 8
paise, which won it the Digit Best
Buy Gold award. 

The Maxtor, on the other
hand, with its good features,
better performance and solid
build quality won the Silver Best
Buy Award. It offered the lowest
price per MB—just 6 paise—which
makes it the most affordable
backup solution. 

The others were not far
behind in either performance or
features. Freecom would have
topped the chart on the basis of
its performance and build quality,
but its price index of 11 paise per
MB held it back.

Thin and Slim
There were a total of nine slim
drives in this category. A few
were quite good-looking, with
capacities from 20 GB to an aston-
ishing 80 GB. One wouldn’t mind
keeping them around on one’s
desktop. The Transcend
TS0GHDC2 was the only odd-

capacity drive at 30 GB. They
were all palm-sized, and a few,
such as the Transcend TS20GSJ18
20GB, made cell phones look fat.

Features
The drives in question were emi-
nently pocketable. The Transcend
TS20GSJ18 20 GB and the
TS40GSJ18 40 GB were the lightest
drives, weighing just 140 grams
each. Both these sported the body
colour and make of the Apple
iPod. The Freecom FHD-XS 20 GB
and 40 GB models were the
smallest external hard drives in
the comparison. Both these were
just 12 mm thick, and occupied
the least space.

All nine drives sported USB
2.0, except for the Transcend
TS0GHDC2 30 GB, which also had
FireWire support. Of the nine
drives, just three—all from
Freecom—came with an applica-
tion launch button. None of the
Transcend drives had this.

Like the drives, the packages,
too, were compact, and came
with a quick-install guide, a soft-
ware CD with an electronic
manual, and an interface cable.
That was all that was bundled
with these drives. Only the 
Transcend TS0GHDC2 30GB came
with a 6-pin to 4-pin FireWire
cable converter. 

All the drives drew power
from the interface, which means
that some older systems, espe-
cially laptops, might not be able
to power them. To overcome 
this, all the Transcend 2.5-inch
drives came with an extra power
inlet. One can purchase a 

power adapter separately if the
need arises.

Build Quality
All the drives were sturdily built.
The Transcend TS20GSJ18 felt the
sturdiest. The Freecom FHD-XS
came with a short, fixed USB
cord, which is adequate for lap-
tops—but a desktop PC might
demand a USB extender cable.

Performance 
In SiSoft Sandra 2004 Pro, the
Transcend TS0GHDC2 30 GB
drive gave the best drive index in
this category—18,939. This, with
a sequential read score of 28
MBps is comparable to any laptop
drive. The random read score of
4 to 5 MB was scored by drives
across the board, which is not
bad, though the random read
score for desktop drives is around
8 to 10 MB.

Both the Freecom FHD-XS
drives returned poor results in
SiSoft Sandra. They scored just
half the score of the other
drives, despite having the same
USB 2.0 interface and 4,200 rpm
drives. In access time, all the
drives took 10 to 12 ms. This is

Basic Specifications—Write speeds Price (Rs)Model Score Brand

External Hard Drives

FHD-1 120GB

HDD 160GB
OneTouch 250GB

ST3160024A 160GB

Media Center

FHD-XS 20GB
FHD-XS 40GB
FHD-2 PRO 80GB
StoreJet TS0GHDC2  30GB

StoreJet TS20GSJ18 20GB
StoreJet TS40GSJ18 40GB
StoreJet TS0GSJ25 20GB
StoreJet TS0GSJ25 40GB
StoreJet TS0GSJ25 60GB

120 GB, 3.5-inch platter, 900gm, 2MB buffer, USB
2.0/FireWire
160 GB, 3.5-inch platter, 817gm, 8MB buffer, USB 2.0
250GB, 3.5-inch platter, 1400gm, 8MB buffer, USB
2.0/FireWire
160 GB, 3.5-inch platter, 900gm, 8MB buffer, USB
2.0/FireWire
250 GB, 3.5-inch platter, 1450gm, 8MB buffer, USB
2.0/FireWire

20 GB, 1.8-inch platter, 150gm, 2MB buffer, USB 2.0
40 GB, 1.8-inch platter, 150gm, 2MB buffer, USB 2.0
80 GB, 1.8-inch platter, 175gm, 2MB buffer, USB 2.0
30 GB, 2.5-inch platter, 240gm, 2MB buffer, USB
2.0/FireWire
20 GB, 1.8-inch platter, 140gm, 2MB buffer, USB 2.0
40 GB, 1.8-inch platter, 140gm, 2MB buffer, USB 2.0
20 GB, 2.5-inch platter, 180gm, 2MB buffer, USB 2.0
40 GB, 2.5-inch platter, 180gm, 2MB buffer, USB 2.0
60 GB, 2.5-inch platter, 180gm, 2MB buffer, USB 2.0

72.78

72.19
73.37

71.84

73.75

44.60
48.88
52.07
49.37

40.36
47.83
50.37
47.92
50.67

14,000

10,950
16,500

11,000

19,500

15,000
21,000
21,000
9,000

9,000
11,000
7,800
14,330
16,900

Desktop Hard Drives

Portable Hard Drives

Similar to the BIOS on your
motherboard, all devices have their
respective BIOSes, often called “the
firmware”. Some drives have
upgradeable firmware, while others
don’t offer this feature for end users.

Firmware

The Freecom  FHD-XS 40GB

Freecom

IOmega 
Maxtor

Seagate

Western Digital

Freecom 
Freecom 
Freecom 
Transcend

Transcend
Transcend
Transcend
Transcend
Transcend
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quite high, and could be due to
the external interface bringing
in an overhead.

In HDTach 2.7, the TS0GSJ25
40GB logged 22.2 MBps of sequen-
tial read, followed by the
TS0GSJ25 20GB which logged 21.9
seconds. The Transcend
TS20GSJ18 20 GB drive managed
just 10 MBps. In the sequential
write speed test, the Transcend
TS0GSJ25 20 GB logged the
highest value—30.7 MBps—which
is awesome. 

However, this drive also
needed 25.7 per cent of the CPU
cycles; only the TS0GHDC2 30GB
was hungrier for attention,
demanding an even higher 26.4
per cent.

In the real-world performance
test, for the sequential read test,
the Freecom FHD-2 Pro took 54.93

seconds to read a 1 GB image off
a local drive. The Transcend
TS0GSJ25 40 GB took 167.86 sec-
onds for the same test on the
same machine over the same
interface.

In the assorted read test, the
Transcend TS0GSJ25 20 GB took
58.51 seconds to read hundreds
of small and large files from a
local drive. 

The TS0GSJ25 40 GB took
163.82 seconds. These times are
quite high. In the assorted write
test, the Transcend TS0GSJ25 60
GB took 72.26 seconds, whereas
the Transcend TS20GSJ25 20GB
took 164.05 seconds. It is strange
that these drives, both from the
same vendor, gave such varied
results. 

Conclusion
Overall, it was the Freecom FHD-
2 Pro that secured the Digit Best
Buy Gold award—thanks to its
performance, decent features
and lowest price per MB. The
drive looks decent and also has a
large storage capacity—80 GB.

The Silver winner, the Tran-
scend TS0GSJ25 60GB, also
sported good storage capacity of
60 GB. The drive returned a
commendable performance
score, and had good features.
The price per MB was a little
higher at 28 paise, than our
Gold winner.

All 1.8-inch drives make
good companions for those who
need to carry their data with
them. If portability is not of
prime importance, it makes
sense to go for a 2.5-inch drive,
for the best mix of performance,
features and portability.

aliasgar_pardawala@thinkdigit.com

Telephone Web siteCompany E-mailBrand

Contact Sheet

Aopen
ASUS
BenQ
BTC Krypton
Freecom
Gigabyte
IOmega 
Lite-On
LG
Maxtor
MSI
Pioneer
Plextor
Samsung
Seagate
Sony
Transcend
Western Digital

Xserve India 
ASUSTek COMPUTER INC 
BenQ India 
Priya Ltd 
J.S Equipments
Digi Giga Systems 
Neoteric
Mediatech India 
LG Electronics India 
eSys Distribution
Maxtone Electronics 
Prime ABGB 
Zeta Technologies 
Samsung India Electronics
eSys Distribition
Rashi Peripherals 
Mediaman Infotech
Western Digital

080-51131001
022-56290787 
022-25705230
022-56663100 
022-23810713
022-26526696 
022-39828600
022-26361111 
0120-2560900 
022-56910348
022-23011919 
022-23896600 
022-24102277 
011-51511234 
022-56910348
022-28260258 
022-23828100
022-25851085

info@xserves.com 
info_india@asus.com.tw 
SalesEnquiryIn@BenQ.com 
sejal.shah@priyagroup.com 
jse@vsnl.com
sales@dlink.co.in 
sales@neoteric-info.com
info@mediatechindia.com 
ARastogi@lgezbuy.com 
yogi@maxtor.com
maxtone@vsnl.com 
primeservices@vsnl.com 
sales@zetaindia.com 
hari@samsungindia.com 
response.india@seagate.com
ho@rptechindia.com 
sales@mediamangroup.com
ajay.kapure@wdc.com

asia.aopen.com.tw
www.asus.com.tw
www.benq.co.in
www.priyagroup.com
www.freecom.com
www.gigabyte.com.tw
www.iomega.com
www.liteon.com
www.lgezbuy.com
www.maxtor.com
www.msi.com.tw
www.pioneer-eur.com
www.plextor.com
www.samsungindia.com
www.seagate.com
www.sonystyle.com
www.transcendusa.com 
www.wdc.com

1 col Ad

The Freecom FHD-2 PRO 80GB

The Transcend StoreJet TS0GSJ25 60GB

NOVEMBER 2004

NOVEMBER 2004
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Toshiba e400 Pocket PC

O2 Xda II

A Phone In Your Handheld

The O2 Xda II is finally here in India! The much awaited
successor to the original Xda smoothens out most of the

chinks in its predecessor.
With triband GSM and GPRS capabilities, the Xda II

measures 69.9 x 130 x 19 mm3 and weighs 190 gms. There is
no unwieldy external antenna, making it quite pocketable.
The front facia boasts of a 240 x 320 pixel, 65K colour,
transreflective screen with two buttons to access calendar
and contacts, and a five-way navigation button
flanked by a ‘send’ and an ‘end’ call button at
the bottom. Two LEDs placed at the top indicate
Bluetooth and GSM connectivity, as well as
battery charging status, new messages or missed
calls. 

Powered by an Intel XScale 400 MHz processor,
it has 128 MB of RAM and 14 MB of flash ROM
storage—enough horsepower to run most of the
supported applications, games and play movies. Add
more memory or additional functionality such as
WiFI via the SDIO slot. Inbuilt Bluetooth connectivity
lets you pair the device seamlessly with compatible
devices. However, the lack of the OBEX file transfer
profile makes it incapable of exchanging files
directly using Bluetooth.

Running Windows Mobile 2003 for Pocket
PC, the bundled software includes Pocket
versions of Outlook, Word, Windows Media
Player, Internet Explorer, Microsoft Reader,
MMS, Photo Caller ID, PPT and PDF Viewers,

and XBackup. You can synchronise the device with a PC using
the bundled ActiveSync 3.7 application and the USB cradle.  

The inbuilt digital camera captures stills at a maximum
resolution of 480x640 pixels and video at 240x320 pixels. The
images captured are not that great though, and turn out
grainy. The Photo Contacts application lets you assign images
to contacts, thus enabling the photo-caller ID feature. 

Calls come through clearly even at locations with low
network coverage. If needed, press and hold down the

green send button to activate the speakerphone. 
Apart from the detailed user manual and software

CD, the package includes a stereo headset, a spare
stylus, a power adaptor, a leather carry case and a
USB cradle that has an extra slot for charging a spare
battery. You can also charge the unit directly by
using the power adaptor and a bundled converter,
so you don’t need to lug around the cradle
everywhere you go. The user-replaceable 1200 mAh
Li-ion Polymer battery lasts just over 4 hours while
playing MP3 music at full blast with the backlight
set to half  its intensity.

A top-notch performance (with features to
boot) make the Xda II ideal for the global traveller
who wishes to stay connected while on the move.

Company Creative E-Biz.Com Ltd
Price Rs 35,999
Phone 011-51619800
E-mail creative@goldkist.net
Web  site www.myxda.com

Rating

Slim And Sleek

Toshiba’s new e400, an entry-level Pocket PC (PPC),
looks stunning in its cobalt blue outfit. Measuring a

mere 0.4 inch in thickness, this is the slimmest around. 
The e400 is driven by Intel’s PXA261 300 MHz

processor, has 64 MB of RAM and 16 MB of ROM, and
comes with a 65K colour transreflective screen,
which has a resolution of 320x240. A 980 mAh non-
user replaceable battery provides enough juice to
power the PPC for 3.5 hours of continuous
multimedia usage. An SD slot, and the infrared
and USB interfaces complete the memory and
data connectivity options. 

A bulky power adaptor, USB cable and
manuals are bundled. The CD-ROM bundles MS Outlook
2002 and MS Active Sync 3.7, Toshiba also includes a text-to-speech and
voice-commanding application. Sensibly priced at Rs 19,500, the
Toshiba e400 should fit most pockets.  

Company Esource Global
Price Rs 19,500
Phone 022-26732929
E-mail sales@esourceglobal.com
Web site www.toshiba.com

Rating

Cyber Acoustics Portable Amplified 
Speakers CA-MP30

This device integrates two speakers and a
woofer into one small casing that can be

carried wherever you go. Its face incorporates
circular speaker grills on either side of a 2-inch
woofer, along with a power
switch, volume control
and a tiny reflex port for
the woofer. You can power
these speakers with the
bundled power adaptor, or four
AA batteries. Ideal for presentations
on notebooks; you can also use the
speaker set with portable music players such as
cassette players, MP3 players and FM radios. 

Tested with a Wipro 1000D notebook, the
sound output is decent enough, but not meant
for audiophiles.

Company Arc-Max Technology Company
Price Rs 2,500
Phone 044-26440062
E-mail ca@arc-max.com
Web site www.cyberacoustics.com

Rating
1 2 3 4 5 1 2 3 4 5

1 2 3 4 5
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Add Flair To Your Life

The 7610 is the latest ‘Series 60’ phone from Nokia that succeeds the
6600 and adds a bit of flair with its odd design and striking colours. 
The unfamiliar keypad is a bit of a bother. However, we found that it

is not as difficult to work with as it seems to be. 
The heart of the 7610 is its crisp and brilliant display that is

unmatched even by the Sony-Ericsson K700i. The 65K colour screen is
paired brilliantly with the inbuilt 1 megapixel camera. 

The photos taken from the 7610 are quite good; however the phone
will not replace your digital camera. Also, the time taken for the Click-

Save-Click process does leave one frustrated.   
The 7610 captures 10 minutes of video which can then be

played back using the bundled Real player. The phone
comes equipped with 8 MB of internal memory and a 64

MB RS-MMC. 
Bluetooth works flawlessly when paired with a

Bluetooth USB adapter for the PC and other phones.
The 7610 kit comes bundled with a USB Sync cable
and Nokia’s unintuitive PC Suite. 

Voice clarity and signal reception is
exceptionally good; we didn’t come across any
quirks on this front. However, the sluggish
interface leaves a lot to be desired.

Company Nokia India Ltd
Price Rs 28,499

Phone 011-26779000
Web site www.nokia.co.in

Rating

Nokia 7610 Smart Phone

AOpen XC Cube AV 

D-Link DPH70 VOIP Phone

If your business demands international calls
then the DPH70 VOIP phone will help cut

communication costs. It comes with an inbuilt
modem and a speakerphone. A quick guide
helps you configure ISP parameters and
calling card settings. Once done, just press the
Dial-Up button—the hotkey to connect to the
ISP. Once it connects, you hear a dial tone. We
used VSNL as our ISP, an IPYantra calling card
and dialled two separate international
locations—Kuwait and Taiwan.

Though it had a high time lag, the call
to Kuwait was crystal clear. The lag
increased significantly when
we dialled Taiwan—the
conversation in this
case was almost
meaningless. Hence,
it is advisable to check the numbers you dial
frequently during office hours before you
make the purchase.

Company D-Link India Ltd
Price Rs 5,500 plus taxes
Phone 022-26528914
E-mail sales@dlink.co.in
Web site www.dlink.com

Rating

Adobe Video Collection Professional V 2.5

Adobe Video Collection Professional V2.5 in
an assortment of the finest application

from Adobe’s extensive range of A/V editing
and composing tools, for professionals. 

The new line up consists of Adobe
Premiere Pro 1.5, Adobe After Effects, Adobe
Audition, Adobe Encore DVD 1.5 and Adobe
Photoshop CS.

The collection comes in a
well-packaged box consisting
of extensive manuals for all
application and a training DVD
for the video products.

This well-conceived suite is
suitably integrated, something
other manufacturers of mix-and-
match products should take note of.

If you are into A/V editing and creation we
heartily recommend Adobe’s Video Collection
Professional.

Company Adobe India
Price Rs 1,03,000
Phone 0120-2444711
E-mail sandeepm@adobe.com
Web site www.adobe.com

Rating

PC For The Living Room

The AOpen XC Cube AV is a Media Center PC in a Small Form Factor
(SFF). It has a variety of modes—DVD/VCD, CD/MP3, FM and TV/PVR—all

catering to home entertainment, such as . The entire experience is
enhanced by the presence of Home
Theatre software and a remote
control that is bundled along.

The Cube can play a DVD, a VCD,
an MP3 or radio, even while the PC
is off; it uses a monitor to display
information. It also has slots for
flash-based media such as SD, MMC,
Memory Stick, and CF—you can
directly play songs or video from any of
these media.

A minor bother: under Windows and while a video plays in the
background, you can switch to another application via the remote
only if the Home Theatre software is
active. Overall the software is an
attempt to mimic Windows Media
Center but it still has a long way to go
in achieving the latter’s level of ease
and smoothness.

The product comes with a 15-inch
LCD and 5.1-channel speakers, which
makes it a good buy. Its performance is
good enough for its intended purpose as
an advanced TV/Music entertainment.

Company Xserve India Pvt Ltd  
Price 78,990 plus taxes
Phone 080-51131001  
E-mail info@xserves.com  
Web site xc.aopen.com.tw

Rating
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1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 Poor: Has serious drawbacks and needs improvement before
it can be used for its target application. 2 Mediocre: Does not
live up to expectations, needs improvment in many areas. 
3 AAvveerraaggee:: Reasonably competent but nothing spectacular
about the product. 4 Good: A good buy, better than most
products in its category. 5 Excellent: A brilliant combination of
price, performance and features - far beyond expectations.

Looking for more information on any of the 
products featured in New & Notable?
Please write to products@thinkdigit.com. The DIgit Test
Centre will be delighted to respond to your queries.
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AMD Motherboards 
Asus A7N8X-Deluxe

Superb performance and
good feature set

None
Contact ASUStek Computer
Phone 022-56926013
E-mail info_india@asus.com.tw 
Price Rs 8,750

Asus K7V600
Perfect balance of features
and performance
Marginally over-priced
Contact ASUStek Computer
Phone 022-56926013
E-mail info_india@asus.com.tw

Price Rs 8,750

Printers
Canon Pixma iP4000

Good features, excellent 
performance 
None
Contact Canon India 
Phone 011-26806572
E-mail rajeev.singh@canon.co.in  
Price Rs 7,000

HP Deskjet 1100D
Rugged, can take heavy 
loads
Relatively slow
Contact Hewlett Packard India 
Phone 1600-444-999 
E-mail seema.dawar@hp.com 
Price Rs 14,299

Speakers
Creative Inspire 5700D 

Plethora of features 
matched with equally good
output 
The bass lacks a good 
punch
Contact Creative Technology 
Phone 0-9820357713
E-mail rajshekhar_bhatt@ctl.
creative.com
Price Rs 23,999

Creative Megaworks 550
Mind-blowing sound
Expensive
Contact Creative Technology
Phone 9820357713
E-mail rajshekhar_bhatt@ctl.
creative.com
Price Rs 23,999

Monitors (17-inch)
BenQ V773

Good screen geometry 
Not a flat-screen monitor 
Contact BenQ India
Phone 022-25705230
E-mail SalesEnquiryIn@

BenQ.com
Price Rs 6,500

Philips 107E5
Acceptable performance for
its cost
Not a flat-screen monitor
Contact Philips India 
Phone 022-56912325
E-mail PCP.India.Info@philips.com 
Price Rs 18,500

Portable Hard drives
Freecom FDH-2 Pro 80 GB 

Extremely compact and
bundled carry case
Low cost
Contact J.S Equipments
Phone 022-23810713
E-mail jse@vsnl.com
Price Rs 21,000

Transcend StoreJet TS0GJ25
60GB

Sturdy build quality
FLow access time
Contact Mediaman Infotech
Phone 022-23828100
E-mail sales@mediaman

group.com 
Price Rs 16,900

Portable Hard drives
WD-Media Centre 250GB

Very low cost per MB 
Memory card reader slots

Contact Western Digital 

Phone 022-25851085 
E-mail ajay.kapure@wdc.com
Price Rs 19,500

Maxtor OneTouch 250GB 
Hotkey for backup 
application launch 
Heavy
Contact eSys Distribution
Phone 022-56910348
E-mail yogi@maxtor.com
Price Rs 16,500

Colour Laser Printers
Lexmark C510

Blazingly fast at 24 pages
per minute
Colours come out dark
Contact Lexmark International 

(India) Pvt. Ltd
Phone 022-26057755/45/44 
E-mail sandeepk@lexmark.com
Price Rs 39,990
Web site www.lexmark.com

Samsung CLP500
Good overall speeds
Printing quality not to 
the mark
Contact Samsung Electronics
Phone 011-515-11234 
E-mail farrukh_quazi@

samsungindia.com  
Price Rs 39,990

Motherboard
MSI 875P Neo-FISR 

Excellent features and per-
formance 

None
Contact Cyberstar Infocom Ltd.
Phone 080-2276986 
E-mail navin@cyberstarindia.com
Price Rs 13,000

Intel D875-PBZ
Good performance and rock 
solid stability
No onboard sound
Contact SES TECH Limited  
Phone 022-26822299/88
E-mail kp@sesindia.com
Price Rs 11,440

The best products tested so far in different 
hardware and software categoriesThe A-List

AUGUST 2004
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CRT Monitors (19-inch)
Philips 109P4

Aperture grille for more 
accurate geometry
Bad implementation of 
the on-screen display for 
changing a setting
Contact Philips India
Phone 022-56912325 
E-mail PCP.India.Info@

philips.com
Price Rs 18,500

Philips 109E5
Maximum resolution of 1920 x
1440
Inexpensive
None
Contact Philips India
Phone 022-56912325 
E-mail PCP.India.Info@philips.com  
Price Rs 18,500

CMV-CT-722A
Inexpensive
Good pixel response time of 
16 ms
Contact Cee Vision Technologies
Phone 022-26733353 
E-mail chemoplastmumbai@

vsnl.net
Price Rs 27,000

Cell Phones 
Sony-Ericsson K700i 

Extensive feature set,
includes camera, MP3, FM
radio etc.
Fast processor
Contact Sony Ericsson
Phone 0124-2560808 
E-mail dhiraj.soni@
sonyericsson.com
Price Rs 20,995

Nokia 6600
Brilliant display screen,
Bluetooth
No FM radio, slow processor
Contact Nokia India
Phone 011-26779000 
E-mail Nokia.ebag@nokia.com  
Price Rs 19,309

Laptops 
MSI MegaBook M510C

Terrific performance, typical
feature set
Slightly tacky keyboard 
Contact Maxtone Electronics
Phone 022-23011919 
E-mail NA
Price Rs 74,990

Wipro CPQ 15 
Perfect balance of perform-
ance, features and price
Built-in speakers, mediocre
Contact Wipro Limited
Phone 1600-333312 
E-mail littlegenius@wipro.com  
Price Rs 73,990

LCD Monitors (15-inch)
CMV CT-522A

High contrast ratio of 500:1
Built-in speakers, mediocre 
Contact Cee Vision Technologies
Phone 022-26733353
E-mail chemoplastmumbai@vsnl.net
Price Rs 20,000

LCD Monitors (17-inch)
Samsung SyncMaster 173P

Great design, superb contrast 
Expensive
Contact Samsung India 
Phone 011-51511234
E-mail marketing@

samsungindia.com
Price Rs 47,500

Laser Multifunction Devices
Samsung SCX-4216F

Fast, feature-rich and priced
sensibly 
Slightly expensive  
Contact Samsung India
Phone 011-51511234
E-mail vikram.negi@

samsungindia.com
Price Rs 35,000

HP LJ-3380
Prints 20 pages per minute,
fastest in its class
None
Contact Hewlett Packard India 
Phone 1600-444-9999
E-mail seema.dawar@hp.com 
Price Rs 54,724

Heavy-duty Multifunction
Devices
Samsung SCX-5315F

Offers good features and good
performance
Expensive 
Contact Samsung India Electronics
Phone 011-51511234
E-mail vikram.negi@

samsungindia.com
Price Rs 65,000

Xerox SCX-M15i
Good performance at a
reasonable price
Bundled software not 
appealing
Contact Xerox Modicorp 
Phone 012-42561930
E-mail kuldeep.malhotra@

ind.xerox.com 
Price Rs 58,000

LG LM50 
Stylish looks and good per-
formance  
Lower battery life 
Contact LG Electronics India
Phone 0120-2560921
E-mail rajeevsaxena@lgezbuy.com
Price Rs 1,40,000

Compaq X1237AP 
Future-proof features, 
executive looks
Battery life marginally lower
than average
Contact Hewlett Packard India 
Phone 1600-444-9999
E-mail seema.dawar@hp.com 
Price Rs 1,59,990
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3-way Call 
Call conference connects you
to two distinct numbers,
allowing you to talk
simultaneously to both 
of them 

Emergency Call 
Make an emergency call,
even if your phone is
disconnected

Tamper-proof 
All connections are secure. It
is not possible to hijack or
tap your phone signal

Internet Access 
With an integrated  modem,
you do not need a separate
ISP connection. You can
access the Internet at around
115 kbps

SMS
You can send SMSes to a
cellular number and receive
them as well!

10 Great Things Your Fixed
Wireless Terminal Offers
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Voice Mail
Allows a caller to leave a
voice message on your
phone in case you are busy
or unreachable

Keep Surfing
Receive calls when there is
no data transfer while you
are logged on to the
Internet

Hotline
Your phone can
automatically dial a
specified number when you
pick up the receiver

Multiple Users
Share the same wireless
terminal with other users
via a PBX machine

Call Log Register
You can track all calls
made or received

Text Suprotip Ghosh, Imaging Jayan Narayanan
Model Rakesh Harjai, Photograph Mexy Xavier
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Ram Mohan Rao

If you are looking for an online
matchmaking site, we recommend
shaadi.com. It is comprehensive,

well-laid out, easy-to-use, and is
packed with features. The index page
reflects this. 

You can navigate to sub-sites
organised according to community,
religion, and country. There’s a free
newsletter that has good articles and
advice on topics ranging from preg-
nancy to marriage counseling to

sexual health. If you want to decide
whether or not to use the site, you
can take a quick tour. 

There are over two million
members, and the site claims a
100,000+ “success stories” and
500,000+ photo profiles. You can
chat online with members. There’s a
range of tools to “shortlist your
matrimonial partner.” 

On the front page, you can search
for a partner according to your spec-
ified criteria. You don’t even need to
register for matches to show up!
Navigation is easy—you can jump
from any kind of search to any other
using the friendly interface.

The only complaint? The site is so
packed with links it can get a little
confusing.

Membership
There are two kinds of member-
ship—free and premium (paid). Paid
membership costs between Rs 900
for three months to Rs 2,400 for 12
months.

Free membership allows you to

register your profile, view profiles
without restriction, contact other
members, and respond to messages
you receive. 

With the paid membership, you
can, in addition, message members
who are online, use advanced
matchmaking tools, etc.

Other membership features
include checking compatibility based
on Vedic Astrology, featured listings,
the ability to place ads in Indian
newspapers all over the world with a
few mouse clicks, and the facility to
purchase gifts.

Main Navigation
The main navigation consists of two
sections—‘Partner Search’ and ‘My
Matches’.

‘Partner Search’ includes saved
searches; advanced search; keyword
search; photo club—a place where
you can see photo profiles; ‘Who is
Online’—where you can look for other
shaadi.com members who are
currently online; ‘Matrimonial Sites’—

which takes you to a navigation page
where you can browse by Indian reli-
gion, countries, Indian communities,
Indian castes, Indian states, and even
US states; and ‘Special cases’—where,
for example, you can search for phys-
ically challenged members.

‘My Matches’ contains such links
as ‘My favourites’, ‘Members who I
contacted’, ‘Members who contacted
me’, and so on.

Registration
The first registration page asks for
the basics—your e-mail ID, gender,
date of birth, and so on. 

Once you are done with this, the
second page asks for almost every-
thing about you that a potential
partner would like to know, such as
body type, complexion, religion,
caste, mother tongue, family values,
smoking status, and so on and so
forth. Here, you can add something
about you and your family back-
ground.

It’s Free! Partly, At Least
Probably the best thing about
shaadi.com is that you can find
potential partners without having to
shell out a paisa. 

Of course, the paid membership
does have its benefits, but you can
try the service out for free—you
submit comprehensive information
about yourself, you view thousands
of potential matches, you search
according to your specified criteria,
and you can communicate with
potential life-partners through the
site, and otherwise—all for free.

What more could you ask for?  
ram_mohan@thinkdigit.com

You can check out thousands of well-laid out photo profiles

You can search, without registration, by basic criteria

Shaadi.com
Digital Tools l Net Gain

One of the best matchmaking destinations on the Web

Profiles are comprehensive, with almost everything you’d like to know 
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Prevent Windows
Messenger from running

You installed MSN
Messenger, and you now

want to uninstall Windows
Messenger. The standard
method for uninstalling
Windows Messenger often do
not work, but you can
prevent it from running at
all. In the Run menu, type in
“gpedit.msc.” In the window
that appears, look in the
right pane—you'll see
“Computer Configuration”
and “User configuration.”
Click on “Computer
Configuration,” then on
“Administrative Templates,”
then on “Windows
Components,” and finally on
“Windows Messenger.” Right-
click “Do not allow Windows
Messenger to be run,” and
choose “Properties.” Choose
the “Enabled” radio button.
Do the same for “Do not
automatically start Windows
Messenger initially.”

Change The Background
You can change the 
background image in

Windows Messenger. Click
Run and type in “regedit”,
then navigate to
HKEY_LOCAL_MACHINE\SOF
TWARE\Microsoft\Messenge
rService. Double-click the
InstallationDirectory value to
verify the location of your
Windows Messenger
installation. By default, this
location is C:\Program
Files\Messenger. 

Create the background
image you want to use. Save
the image you created as a
.gif file named lvback.gif, and
place the file in the Windows
Messenger folder.

Exit the regedit, and
restart Windows Messenger
for the change to take effect.
Depending on how large the
picture is, it will occupy part
of the messenger window.
For example, if it is 640 x
480 pixels large, and you
have dragged your Windows
Messenger window to be
around 200 x 200 pixels,
only the lower left-hand
corner of the picture will be
displayed.

Change Sounds
You can change the
sounds you hear in

Windows Messenger. Go to
C:\Program Files\Messenger,
and change the .wav files to
any other .wav files. When
you are changing them,
remember to back up the old
files first. Also remember
their funcions: ‘online.wav’
sounds when a buddy logs in;
‘newemail.wav’ is when you
receive a new e-mail; and

‘type.wav’ is the sound you
hear when you receive an
instant message, so if you are
changing this sound, be

careful to keep it short—you
will be hearing a lot of it!

Change Font Colour
Would you like your text 
in Windows Messenger

to appear in a custom colour?
Here is a plugin that allows
you to choose, using sliders
for red, green and blue,
exactly what colour you want
in your fonts: http://members.
home.nl/t.gorissen/custom%2
0msn%20colors.exe.

MSN Messenger:
The Latest Version

Download the latest
version of MSN

Messenger from here:
http://download.microsoft.
com/. Run the .exe file
mentioned there to install
Messenger. Alternatively, find
the current latest version on
the DVD accompanying this
issue. You can also download
the messenger from
http://download.com.

Cool Stuff
For animated smileys, 
interesting plugins, cool

display pictures and the like,
go to http://www.mess.be/

Emotise Your Nick
You can add an
emoticon to your

nickname—the name that
appears when other people
receive messages from you.
Go to Tools > Options, then
in the ‘Personal’ tab, type in
your name as you would like
it to appear, along with the
keyboard shortcut for the
emoticon. For example, if you
would like your name to
appear as “Wolfhound” with
a smiling face after it, simply
type in “Wolfhound :)” here.

Two Instances Of
Messenger

Do you have two 
Hotmail (or MSN)

accounts, and would like to
make use of them by opening
two MSN Messenger
windows? You can do that by
downloading a program,
which is easy to install and
creates a shortcut on the
Start Menu. The download
location is http://members.
home.nl/t.gorissen/several%2
0msn%20sessions.exe

Clear Histories
If some friends have 
signed into MSN

Messenger using your
computer, you might want to
remove their histories. Go to
Control Panel and select User
Accounts. Click on your
Windows XP user name, and
go to Manage my network
passwords. Here, you will find
a list of the e-mail addresses
that have been used to logon
to Messenger. You can delete
the ones you don’t want.

GENERAL TIPS
Windows Messenger 75 • MSN Messenger 75 • Yahoo!

Messenger 76 • Trillian 78 • ICQ 79 • mIRC 81 

30 MINUTES EXPERT
Print your passport photos at home 77 • Creating a

bootable CD 80

Windows Messenger

MSN Messenger

Secrets That Keep You Ahead In The Race

Using Custom MSN Colors, you
can change the colour of your
font to any colour at all

You can easily change the display
picture in Windows Messenger
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Who’s Added You?
To see who has 
added you to their

contacts list, simply go to
Tools > Options > Privacy,
and then click View.

Think Outside The 
Contact List

To send an instant 
message to someone

who is not on your contact
list, right-click on the MSN
Messenger icon in the system
tray, click ‘Send an instant
message’, and then choose the
‘Other’ tab. Here you can enter
the e-mail address of the
person you want to message.

To prevent other people
from sending you messages
this way, go to Tools >
Options > Privacy, and tick
‘Only people on my Allow list
can see my status and send
me messages’.

View By E-mail Address
People use nicknames 
such as “Look who’s

here” or things like that,
which is what you see when
you log in to Messenger.
Since people change these
nicknames often, you might
not know who a contact is
until you run the mouse
over the nickname (the
display name). If this is an
annoyance, you can view all
your contacts by their e-mail
address. To do this, go to
Contacts > Manage Contacts
> View Contacts by, and
select E-mail address.

Lots Of Emoticons—Free
When you want to send 
an emoticon in a

message, you typically click
on the smiley in the
conversation window to get
more smileys. There are many
more emoticons that you can
use, each with its keyboard
shortcut. For a list of all
emoticons available for
various versions of Messenger,
look at http://www.
bigblueball.com/im/msn/msn
-emoticons.asp

No More Tabs On The Left
If you find the tabs to 
the left of the contact

list annoying, you can turn
them off. They are not much
use anyway. Simply go to
Tools > Options > Privacy,
and tick ‘This is a shared
computer so don’t display my
tabs’.

Plus!
Plus! is a
freeware

add-on for MSN
Messenger. It
offers various
Messenger tweaks,
advanced logging,
enhanced
notifications,
security and
privacy control,
etc. You can get it

at http://www.msgplus. net/,
or install it from the DVD. If
you want a full list of the
enhancements that Plus!
offers, go to http://www.
msgplus.net/features.php. 

Log Your Chats
To keep a log of all your 
conversations so you can

retrieve them later, you can
go to Tools > Options, click
on the Messages tab, and tick
‘Automatically keep a history
of my conversations.’

Turn Emoticons Off/On
You can choose whether 
or  not to display

emoticons and/or custom
emoticons in the messages
you receive. Simply go to
Tools > Options, go to the
Messages tab, and tick or
untick ‘Show emoticons…’
and/or ‘Show custom
emoticons…’

Yahoo! Messenger—The
Latest Version

The latest version of
Yahoo! Messenger is a

significant improvement over
previous versions. Go to
http://messenger.yahoo.com/
to download it, and to see
what’s new. You can find the
current latest version on the
DVD accompanying this issue.

New Mail Alert
To be alerted in Yahoo! 
Messenger whenever

you receive new mail in your
Yahoo! account, do the
following: Select Login >
Preferences. Go to the Alerts
and Sounds category. Under
‘Alert me when:’, highlight ‘I
receive a mail message’.
Select the desired
notification options under
‘Alert me by:’, and click OK.

All The Smileys You Want
Want to know about all 
the smileys you can use

in Yahoo! Messenger, along
with their keyboard
shortcuts? Point your browser
to http://www.bigblueball.
com/IM/Yahoo/yahoosmileys.
asp

YEmote2
Download itfrom 
http://www.camgrab.tk/.

YEmote2 adds several
interesting features to Yahoo!
Messenger, such as advanced
Webcam capture, easy
smileys selection, advanced
message archive viewer, an
auto-reply feature, and much
more. Go to http://www.andy.
w2s.co.uk/yahoo/YEmotePlus/
index.htm for more on
YEmote2.

Disable Windows
Messenger

Windows Messenger
automatically loads up
when you start your XP
computer. It also starts up
at certain other events. To
prevent it from loading at
startup, or at any other
event, do the following:
Go to Start >  Run. Type
in “GPEDIT.MSC”.
In the window that comes
up, navigate to Computer
Configuration >
Administrative Templates
> Windows Components
> Windows Messenger.
Here, you will see ‘Do not
allow Windows Messenger
to be run’ and ‘Do not
automatically start
Windows Messenger
initially.’ Go to each of
them and enable them.
Close the Group Policy
window, and you’re done.

Bet You Didn’t Know

Yahoo! Messenger

Organise your contacts better
using the features in Plus!

Nokia, Samsung, Sony-Ericsson, or...
Who will reign the Cell Phone Kingdom?

Digit Zero1 Awards

Find out India’s top tech products of 2004 across 
28 categories in the Digit December issue

In MSN Messenger, you can choose to view
contacts either by nickname or by e-mail address
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Print Your Passport Photos At Home

Aliasgar Pardawala

If you have a computer and an
inkjet printer, we have good news

—you no longer need run to the
nearest photo studio each time you
want a passport-size photo! The news
is sweeter still if you own a digital
camera—you can then shoot yourself,
digitally touch the image up, and
print it out on appropriate media.

Preparing Your 
Photograph
Find or shoot an appropriate

photograph of yourself. The first
thing to note is that a photo meant
for printing needs a resolution of
300 dpi and a preset size. To ensure
this, start Adobe Photoshop, open
your picture. Click on Image > Image
Size, in the dialog box that follows,
you will need to supply the
‘Document Size’: width of 3 cm and
height of 4 cm; in the ‘Resolution’
field type 300 pixels/inch. Now click
on OK.

Preparing Your 
Photograph, Part II
We will now create a blank

image within which we will paste
our resized photograph. The blank
image should have a white back-
ground since this colour will form
the frame of the photograph. Go to
File > New and specify a 3 cm x 4 cm
image with a 300 pixels/inch resolu-
tion and a white background. Head
to the photograph, which we earlier
resized, press [Ctrl] + [A] to select the

photo, [Ctrl] + [C] to copy it, then
select the new image file with the
white background and paste it there.

Framing Your Picture
You will now need to create a
‘frame’ around the pasted

image. To do this, press [Ctrl] + [T]
then press [Shift] and resize the
image, making sure that some white
space is kept around it as the frame.
Once satisfied with the size of the
frame, double-click on the image to
render it to the new size.

Printing Your Picture
This step will use a
Photoshop tool to create an

A4 size page full of your passport-
sized pictures. 

Head to File > Automate and click
on ‘Picture Package…’

In the ‘Picture Package’ window
that appears, here is what you need to
do: Select a ‘Page Size’ of 8.0x10.0
square-inch (this is the standard
photo paper size). Next in the ‘Layout’
drop-down menu select (9)2.5x3.25—
this will basically tell Photoshop to
create nine images, each of 2.5x3.25
inches-square—which is the standard
size of a passport photo.

Now we need to select a
Resolution of 300 pixels/inch. That’s
it! Click on [OK] and you are done!
Well, almost done…clicking on [OK]
will create an 8x10 square-inch
image which you can print to your
inkjet printer. 

Cut out along the white frame
and use the passport-sized photos as
you desire.

All you need is a photo or inkjet printer, and you’d
never have to go a photo studio again for prints 

Click this to change your photo’s size

Specify the photo size and resolution here

The white border is the ‘frame’ of your photo

This is what the final step will look like, only
less green. Your photos all in a row

Seagate, Samsung, Maxtor, or...
Who will win the Hard Disk race?

Digit Zero1 Awards

Find out India’s top tech products of 2004 across 
28 categories in the Digit December issue
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Change The Title Text
Here’s how you change 
the title text that

appears at the top of the
Messenger window. By
default, this is “Yahoo!
Messenger”, followed by your
status. Simply edit the
ymsgr.ini file, which you will
find in the same folder as the
Messenger program, in your
Program Files folder. Locate

the file and open it in
Notepad. Then, at the end,
add the following:

[APP TITLE]
caption=YOUR TEXT

Here, “YOUR TEXT” is
whatever you want in the
title bar. Save the file and
close Messenger. When you
restart it you will see your
text in the title bar.

Multicast A Message
To send a message to 
several recipients at

once, right click on the group
title in your contact list, on
select Send Message to all in
this group. Alternatively, hold
down [Ctrl] and left-click on
the contacts you wish to send
a message to. Once you’ve
highlighted the required
names, simply right click on a
name and select ‘Send a
message’.

I Don’t Want To Be 
Your Buddy

Ever wanted to remove 
your name off someone

else’s buddy list? Download a
plugin to do this, from
http://www.zakie.
fsnet.co.uk/nobuddy/

Multiple instances of
Yahoo! Messenger

To run multiple
instances 

of Yahoo! Messenger, which is
useful if you have multiple
Yahoo! IDs and want to use
them all at once, download
this useful program from
http://www.softpedia.com/pu
blic/cat/10/4/1/10-4-1-111.shtml

Change The Size Of The
Contacts Window

Here’s a patch to change 
the size of the contacts

window in Yahoo! Messenger
to whatever size you want it
to be. The file location is
http://www.angelfire.com/
creep/yahoo_heretic/Yahoo6_
MinSize_Patch_All.zip

Extra Smileys—Free
For adult-themed, rude, 
and just plain naughty

smileys for Yahoo! Messenger,
navigate to
http://www.geocities.com
/basefaces/. You will find a

link there to download a
zipped archive.

Download Trillian
Trillian is an award-
winning, multi-network

IM client that allows you to
seamlessly integrate all your
communications into a
single, sleek package. It is
touted by many as “the
ultimate chat program”. You
can stay in touch with
contacts spanning multiple
networks, and get the latest
news, stocks, and other
information with a versatile
array of plugins. Download
the latest free version from
http://www.trillian.cc/, or find
it on the DVD accompanying
this issue.

The Smileys
The Trillian emoticon
reference, along with

keyboard shortcuts, is
available at
http://www.bigblueball.com/i
m/trillian/trillian-smileys.asp

Make Trillian Look Like
MSN Messenger

There’s a very popular
skin for Trillian that

makes it look and feel a lot
like MSN Messenger. Get it

here:
http: //www.
ceruleanstudios.
com/ downloads/
downloads.php?
d_type=skins&
componentID=216

Trillian
Everywhere

You can use
Trillian

wherever you go,
by installing it on
your Zip disk, CD,

Disable unknown
users from paging you
in mIRC
You probably hate it when
you are chatting and
suddenly a window opens up
with somebody saying “Hi” or
“m/f”. Fortunately, with
mIRC, you can get rid of this.
You can configure mIRC to
inform you, in your active
window, all the following: 
The nick of the person who is
querying or messaging you. 
The content of the message. 
To accept or reject the
message. First, in General
Options, in the IRC Switches
tab, tick ‘Queries in active
window.’ Then copy the
following into Remote.

on 1:TEXT:*:?:{ 
if ($nick isin $active) { goto
halt } 
else { 
splay
c:\mirc\events\hello.wav |
/set %mnick $nick 
echo $active To Close
message Hit F3 
echo $active To Accept
message Hit F2 
} 
:halt
} 

Also put this in Aliases: 
/f2 /query %mnick | /unset
%mnick 
/f3 /notice %mnick Sorry
can’t chat now, c ya around
%mnick :-) | /ignore -pntiu60
%mnick 3 | /closemsg
%mnick | /unset %mnick 

Here, the /f3 alias should be
on one line. Don’t forget to
leave a space before and
after the ‘|’ .

Tip Of The Month

Trillian

You can easily change the text
that appears at the top of your
Yahoo! Messenger window

You can skin Trillian so that it looks like MSN
Messenger, to the extent that you won’t know
you’re not using Messenger

HP, Canon, Epson, or...
Who will bag the Printer Gold?

Digit Zero1 Awards
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or any other type of portable
medium, and take Trillian,
your preferences, and your
contact list with you
wherever you go. You can
use a fully functional
Trillian anywhere, on any
computer with an internet
connection, instead of
online clients with limited
functionality such as AIM
Express and ICQ Lite. 

There is an online guide
that will walk you step-by-step
and show you how to achieve
this. No technical knowledge
is necessary. Follow the steps
of the online wizard at this
site to create your own
installation of Trillian that
will work wherever you go
using any portable media
that you can use: http: //www
.trilliananywhere
.com/wizard-1.html

Check Out Trillian Pro
Trillian Pro comes
packed with a whole lot

more features than the free
version. It costs $25. Check
out all the features it offers at
www. ceruleanstudios
.com/products/

Custom RSS/XML Feeds
With Trillian Pro, it’s
easy to add a live,

custom RSS/XML feed. All you
need to do is install the News
plugin from the Trillian Web
site (www.cerulean
studios.com); then go to File
> Preferences, select the
News option under the
plugins category. Now, you
have the option to add a
custom feed, or add an
already installed feed. To
view a custom feed, click Add
Custom Feed, then enter the
title, and then the site name
(you will need to find this
from the site).

Get The Contact List 
Out Of The Way

Usually, ICQ’s Contact
List hovers over all other

windows. You can get it out
of the way in ICQ 2000 by
clicking ‘Always On Top’  in
ICQ > Contact List Options.
In ICQ 99, click ICQ >
Windows/Alerts > Always On
Top.

Custom Away-Messages
With ICQ, you can leave
custom away-messages,

like an answering machine.
Just click the Services button
on the front of the ICQ
screen. If the Services button
is not showing up, go to ICQ >
Preferences, and make sure
you have Contact List selected
from the navigation bar on
the right. Click the Design
tab, and tick the box in front
of Show bottom ICQ buttons. 

Now, choose Answering
Service and click the top-left
drop-down menu to find the
appropriate status. The
second drop-down menu
shows the titles for the
messages that appear in the
box to the right. Select one to
display for each state in the

top list, or compose your own
using the empty selection at
the bottom and typing in
your own remarks in the
message box. For example,
you could type something
like, “I’m away at the
moment, but I’ll be back
online at 1:30 PM.” After you
have finished choosing which
messages to display for which
states, save your preferences
by clicking ‘Save’. 

Choose your status by
clicking the flower on the
bottom right of your ICQ
screen. Now, when you are
away from your computer for
a break, just click the
appropriate flower, and your
friends will know to stay
online until you get back.

Make An “Invisible List”
If you want to appear
invisible to a particular

user, click the contact’s
name, select ‘Alert/Accept
Modes’ from the pop-up
menu, click the Status tab,
and select ‘Invisible To User.’
You will appear to be offline
to that contact until you send
him or her, a message.

To add more than one
user to your “Invisible List” at
the same time, go to ICQ >
Security & Privacy, click the
Invisible tab, and fill in the
info. There is also a ‘Visible’
tab where you can list users
who will see you as visible
even when you are invisible
to everyone else.

Get Rid Of The Pop-up
If you are tired of the
announcement box that

pops up every time you start
up ICQ, you can get rid of it.
Go to ICQ > Preferences &
Security > Preferences. Click
the Contact List tab, and look
for the ‘Don’t Show
Announcements’ checkbox on

the right side of the window.
Tick this box. In ICQ2000, go
to ICQ > Preferences >
Miscellaneous, and leave
‘Show ICQ announcements’
unchecked.

Float A Contact Name
In ICQ, you can ‘float’ a
contact name on top of

any other program you’re
running. Basically, you can
message your key contacts
while keeping your ICQ
window minimized by
floating their names on your
desktop. To do this, drag a
contact name—or names—
from the ICQ window to
anywhere on your screen, and
then minimise the ICQ
window. This copies that
contact name to your
desktop, where it remains on
top of other applications. 

Click a floating name to
send and receive messages
just as you normally would

ICQ

To remove the flashing
banners at the bottom of
the ICQ window, open the
ICQ folder with windows
explorer. This is typically
C:\Program Files\ICQ.
Delete the file
‘ICQHttp.dll’. Be careful—
do not delete
‘ICQHttp .dll’ (note the
space).

Re-start ICQ and you’ll
find no banners.

Bet You Didn’t Know

If you’re not doing
something with it, ICQ can
automatically get out of
the way. In ICQ 2000, go to
ICQ > Preferences, select
Contact List, and tick the
‘Auto Hide Delay’ box. In
ICQ 99a, click ICQ >
Preferences; in ICQ 99b,
click ICQ > Preferences &
Security > Preferences;
and then turn on the ‘Auto
Hide Delay’ function on
the Contact List tab.

Now ICQ will
automatically minimise to
the system tray when it’s
not in use. When
you need to send or
respond to a message,
bring ICQ back by double-
clicking the flower icon in
the tray.

Bet You Didn’t Know
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Abootable medium is a
life-saver. Sooner or
later something will

go wrong with your com-
puter and you will need a
boot disc to rescue it. 

Current computers can
boot off a CD-ROM or a
DVD-ROM disc. The bene-
fits of using an optical
disc, as opposed to the tra-
ditional f loppy, are
twofold. The major benefit
is that of reduction of data

corruption. An optical disc
by virtue of its design is
immune to stray magnetic
fields which are so
common around a per-
sonal computer. Such
fields would lead to fre-
quent data corruption and

create bad sectors on a
floppy. A CD medium is
free of such hassles.

Of course a CD is not
without its drawbacks—the
biggest concern being that
of scratches across its read-
able face. 

The other advantage is
that of the storage space
offered. A bootable CD
should also carry backup
and restore software along
with an antivirus solution,

a program to partition
your hard disk, maybe even
an image of your desktop.
This article will tell you
how to create a bootable
CD-ROM using a popular
application called Nero
Express 6.

Create A Boot
Image 
You will first need

to create a bootable floppy
the old way. To do this in
Microsoft Windows XP,
insert a new floppy in
your drive; head to 'My
Computer' and right-click
the floppy drive icon.
Select ‘Format’ from the
menu and select ‘Create
an MS-DOS startup disk’
and then click on ‘Start’. 

If you are using
Windows 98, go to 'Add /
Remove Programs', found
in the 'Control Panel' and
select the 'Startup Disk'
tab. Now insert a blank
floppy disk and click
'Create Disk' button.

Using Nero
Express 
In order to create

the bootable disk, we will
use Nero 6 Express.

Start the application
and from the Nero Express
menu and select the
'Bootable data disc' option
under the 'Data' menu. 

Adding Files To
Your Bootable
If you need to add

any files or applications to
your bootable disc, the
next window is where you
should do so. If you do not
wish to add any files, you
can skip this option and
move to the next step by
clicking on the 'Next'
button. 

Pointing Out The
Boot Image 
THe next step is to

point Nero to the
bootable ‘image’ file. To
use the floppy click on the
'Read boot disc in drive'
radio button and select
your floppy drive. If you
have your own image
(IMA) file, point Nero to it.
Now, click on Next. 

Burning Your
Bootable Disc
This final step

requires that you select
your CD-Writer, then
name your bootable disc. 

Click on the 'Burn'
button and be patient as
your bootable disc is
burnt.

Create a bootable floppy disk—
this will form a boot image

Start Nero Express to create a
bootable CD-ROM

Creating a bootable CD
We help you create a bootable CD-ROM using Nero Express

Creating a bootable floppy
under Windows 98 

You can add files other than the
boot image to your CD-ROM

The final step: a bootable CD-
ROM is minutes away

Choosing the boot image,
created earlier on the floppy

1 2
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with the window open. To
remove the floating name
from your desktop, open the
ICQ window and drag the
name back off the screen and
onto the ICQ window.

ICQ’s Pager Service
People who do not have
ICQ installed can

contact you through their e-
mail clients using the ICQ
WWPager service. To use e-
mail to send an ICQ message
to someone, address the
message to the user’s ICQ
ID@pager. mirabilis.com—for
example,
4566134@pager.mirabilis.com.
Type a subject and a message
of up to 450 characters. The
message will be sent through
the ICQ Web site to the ICQ
user.

Re-indexing Your
Database

You might sometimes
want to re-index your

database in ICQ. This is if any
of the following problems
occur: ICQ crashes on bootup
or gives “Abnormal
Termination Errors”, or, even
after having cleared the
message history, the history
file still contains deleted
messages. First, back up your
contact list before you begin.
Then, follow these steps: Go
to Start Menu > Programs >
ICQ > ICQ Database

Convertor. Choose ‘Fix
New Database’ and
click ‘Next’. Choose
which owner you want
to fix the database of,
and how much history
you want to retain.
Then click ‘Next’. Let
your database be
reindexed, and when
it's done, click ‘Next’.
Click ‘Convert / Fix
Another ICQ Owner’ if
necessary, or click on

‘Done’ and wait for ICQ to
load. You are done.

Remember that if the
process crashes, try again and
choose “No History”—you may
want to keep a backup of
your history in case you want
to retrieve it later.

Require Authorisation
If you want to stop
spammers and other

unwelcome visitors from
invading your ICQ space, you
can set ICQ to require your
authorisation before contacts
can add you to their list. To
set ICQ to require
authorisation, go to ICQ >
Security & Privacy. In the
‘Change Contact List
Authorization’ section of the
Security tab, or the General
tab in ICQ 2000, select ‘My
authorization is required’.
From now on, when a user
wants to add you to his list,
you will automatically be
asked for authorisation.

Organise Your Contact List
If your contact list is
getting a bit unwieldy,

you can organize them into
groups. Go to ICQ >
Windows/Alerts, and check
the Group Mode tab. Next,
group your contacts into
different groups—family,
friends, and so on—by
dragging a contact name to
its group. To access contacts

in a particular group, click
the group name, and choose
Open Group from the menu.
If you want to go back to
viewing all your contacts at
once, click the Groups button
at the top of the ICQ window.
In ICQ 2000, you can view
groups and manipulate them
by going to  ICQ > Contact
List Options, and choosing
Contact List Groups.

Turn off pager messages
You can turn off pager
messages from the Web

in ICQ. Simply go to ICQ >
Preferences & Security >
Security & Privacy. Click the
‘Ignore List’ tab, and tick the
‘Do not accept WWPager
messages’ checkbox.

No Event Logging
If you do not wish your
history to be saved, go to

ICQ > Preferences > Events,
and tick ‘Do Not Log Event
History.’ You can also delete
all your history by shutting
down ICQ, and running the
ICQ database converter: go to
Start > Programs > ICQ >
Database Converter. Now,
select the owner of the
account, and under ‘history
options’, choose ‘No History
(Contact List Only)’. Then
click Next. After the
conversion is completed, click
‘Done’.

Multicasting A Message
To send a message to
multiple recipients on

your contact list, first open a
new message by clicking the
name of one of your intended
recipients and selecting
Message. Then, type your
message in the window as
usual. When you are ready to
send the message, click the
‘More’ button at the bottom
of the window, then click the
‘Multiple Recipients’ button.

Tick-mark the people on your
contact list to whom you
want to send the message,
and click the ‘Send’ button. 

All the recipients you
selected will receive your 
message. The recipients of
your group message will
know that you sent it to
multiple users, but they
won’t be able to see who else
was on the recipient list.

Multiple Personalities
You can register for
more than one ICQ

number if you want to
maintain multiple ICQ
‘personalities’—for example,
one for work and one for
home. In ICQ 99, just click
the ICQ button and choose
Add/Change Current User.
Select Add Another
Registered User (or Register a
New User) and follow the
prompts. In ICQ 2000, just
click the My ICQ button and
choose Change User on this
Computer/Add Another
Registered User (or
Registration to ICQ/Register a
New User), and follow the
prompts. When you want to
change personalities, go back
to ‘Add/Change Current User’
(ICQ 99) or ‘Change User on
this Computer’ (ICQ 2000),
then select ‘Change the
Active User’ and click what
you want.

Set Up A Pager 
To set up a pager in
mIRC, copy the follow-

ing into the Remote\Com-
mands folder, after making
sure that listening is turned
on. This will allow others to
send you messages when you
are set as away, and will play a
sound (here “file.wav”) when
you receive a message.

#page off 

mIRC

You can turn off the “Welcome to ICQ”
screen that comes up when you start ICQ
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CTCP 1:PAGE:/wavplay
file.wav | /notice $nick Page
received 

#page end
To ensure that the pager

stops after you set your status
back to Available, paste the
following into your popup.ini
file in the Channel folder: 

Away Pager 
.Away:/ame is away! $$?=”

Enter Reason:” If you need
me type /ctcp $me $+ _Away
PAGE | /enable #page | /set
%nick $me | /nick $me $+
_Away | /away $$! 

.Back:/ame is back! ctcp
page is disabled | /nick
%nick | /disable #page |
/away

Being Invisible
mIRC can make you
invisible if you tick

‘Invisible mode’ in Setup >
IRC servers. If you want to do
it manually, type in “//mode
$me +i”. 

You should see the
following in the Status
window:
*** <$me> sets mode:+i

If you want to be always

invisible, copy the following
into the General Options >
Perform tab: /mode $me +i 

Invisible mode makes you
invisible to the /who
#channelname command,
meaning that other people
cannot find you by searching
on IRC unless they know your
exact nickname. 

No wild carded search on
you by the /who command on
your IP Address or real name
will deliver your current
nickname or other
information to others. 
However, it does not make
you invisible to people in the
same channel as you.

Easy Exiting
To quickly leave a chat
session without having

to type in much, try the
following. Make a new text
file and name it Part.txt. Put
it in your mIRC directory,
typically C:\Program
Files\mirc\. Type the
following lines into the
Part.txt file:

/me wants to stay but
duty calls… must go :-) 

/me must go… bye
everybody… c u later. 

/me thanks everybody
and leaves $active. Bye. 

Of course, you can type in
any message you want.
“$active” is the name of the
currently active window. Now,
make a new alias: 

/pp /$read $$?
C:\mirc\part.txt 
Next time you’re in a

channel and you want to
leave, type in /pp. When a
dialog box pops up, type “-l2”.
mIRC will read the second
line of your Part.txt, because
you typed in “2” above. You
can choose what line number
you want mIRC to read. If you
don’t type in anything, mIRC
will randomly read a line and
send it.

Run A Fileserver
With mIRC, you can
have your own file

server—people can access a
pre-defined directory, and
download whatever they
want. 

The first thing to do is
make a new directory. The
user will be limited to
accessing only files and
directories within this
directory. 

Put whatever you want in
this directory—pictures, wave
sounds, text, programs, etc. If
you are using mIRC 5.1 or
over, here’s how to set up
mIRC’s file server:

Click the DCC options
button, and then click the
Fserve tab.

‘Max. Fileservers’ specifies
how many users can be served
simultaneously.  

‘Max. DCC gets per user’
limits the number of
simultaneous DCC Gets a user
can request.  

‘Root directory’ specifies
the root directory that a user
will see when they first enter
a file server initiated via the
DCC server. The user will be
able to access all files and
directories within this root
directory.

‘Welcome text file’
specifies the text that will be
sent to a user when they
connect to your file server.   

‘Display file server
warning’ is to be warned that
someone is doing an Fserve
from your server.

Note that a user must
type “/DCC fserve IP”—where
“IP” is your IP address—to
start an Fserve. To find your
IP, you can type in “/dns
nick”, where “nick” is your
nickname.

This method can be used
even if you or your friend are
not on IRC, as long as you are
connected to the Internet,
and know your IP address.

An MP3 Plugin For mIRC
Here’s an MP3 add-on
for mIRC. There is a

scrolling title bar, and a
volume adjust tab. The
playlist allows the user to
queue songs. Download it
from www. mircscripts.
org/download.php?id=2438&t
ype=2

Listen To Somebody
Leaving

You can play a sound
when someone leaves.

Save your desired sound as
“quit.wav”. Put it in your
sounds directory. Go to Tools
> Remotes. In the dialog box
menu bar, click on ‘Listen’. If
there isn’t a tickmark next to
Events, click on it. Add this
code to the dialox box:
ON *:QUIT:/splay quit.wav 

To turn off the annoying
screen that comes up when
you start ICQ, go to ICQ >
Preferences >
Miscellaneous, and
uncheck ‘Show ICQ
Welcome’.

Similarly, in MSN
Messenger, to turn off the
MSN Today that appears
after you sign on, go to
Tools > Options, click the
General tab, and uncheck
‘Display MSN Today when
Messenger signs in’. In
Yahoo! Messenger, go to
Login > Preferences, and
under ‘Misc.’, un-tick
“Show Yahoo! Insider
when I login”.

Bet You Didn’t Know

Go ahead and download this custom MP3 player for mIRC
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address, we immediately get on
to Google and search for the
company name. 

If we don’t find it within the
first five minutes, we give up and
decide that if Google, the baap of
all search engines, can’t find it, it
isn’t worth our time anyway. This
is sad, and a perception that may
be totally wrong in your opinion,
but it is the cold harsh truth of
today.

You might have thought of
setting up your own little Web
site. Perhaps, you do own a free
Web site, which is too bland to
draw attention to, leave alone
publicise it. 

The thought that stopped you
in your tracks was, “A Web site
will cost thousands a month on
server maintenance and site devel-
opment.” 

Well, you are wrong! You can
set one up for just Rs 400 a year!

The Dot-Com Domain
The first thing you need is a
domain name. This is your own
little postbox on the Web. You will
obviously buy a domain that has
your business’ name in it, and set
your eyes on buying a .com—
unless you run a non-profit organ-
ization (.org), or are interested in
setting up a .info, .biz, or a .name
Web site. Let’s stick with .com
domains in this article, mainly
because a majority of the online
world associates Web sites with a
.com.

Let’s say you want to purchase
TheSiteYouWantToBuy.com. You
need to log onto a registrar’s site
and check for its availability. If
you have a credit card, we suggest
www.godaddy.com—they are reli-
able and have really low rates.
The entire list of ICANN (Internet
Corporation for Assigned Names
and Numbers) accredited regis-

Robert Sovereign-Smith

ne thousand crores, or
one lakh; 15,000 employ-
ees, or 15; global or

limited to one city—no matter
what your business turnover,
employee strength or area cover-
age is, you need a Web site. 

Yes, there are still those
running family businesses who
will claim that it’s the personal
touch that matters; but if you’re
here, reading this article, you
know the advantages the WWW
has to offer. 

It’s a simple matter of infor-
mation, and if you don’t have a
Web site for your business yet,
it’s time you host one. Today,
when we hear a company name,
we immediately attempt to visit
its Web site to find out more
about it. If we don’t have its Web

www.mybusiness.com
Set up a
profes-
sional
looking
Web site
for a little
over Rs
400 a Year
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such as those by ZoneEdit.com.
ZoneEdit.com offers free DNS

services for up to five domains per
user account. It’s very noticeable
that they offer better services for
free, whereas some registrars
charge for the same services. The
Web site has no advertisements.
All ZoneEdit does is forward DNS
hits. Thus, your privacy is not at
risk. All this is for free.

Once you register at ZoneEdit
and login to your account, you can
add your domain (called a ‘zone’
on ZoneEdit.com). The moment
you add this new zone, ZoneEdit
gives you two name servers, such
as ns14.zoneedit.com and
ns15.zoneedit.com. You need to go

back to your registrar’s site and
get them to forward your domain
to these name servers. Typically,
this takes two days to update in
the Internet’s TLD (Top Level
Domain) registry, till then you can
start setting up your Web site.

Now, get cracking right away
at ZoneEdit, if you already have a
Web site hosted for free on, say,
Yahoo!’s www.geocities.com. If you
don’t then set up your Web site
and come back to this part of the
article after you are done.

Assuming you have a free
hosted Web site (at www.geoci-
ties.com, in this example) proceed
to forward your domain using
ZoneEdit’s trademark
WebForward method. Here, you
can forward www.thesite youwant-
tobuy.com to, say, www.geocities
.com/thesiteyouwanttobuy/index.h
tml, and choose the ‘Cloaked’
option to hide the fact that a visi-
tor is being forwarded. All that
visitors to your site will ever see in
the address bar is www.thesitey-
ouwanttobuy.com (See box ‘Cloaking
Charades: Make Your Web Site Look
Professional)’.

You can also create e-mail
aliases, and forward them to
existing e-mail addresses. Hence,

trars is available at http://www
.icann.org/registrars/accredited-
list.html. You can find Indian
registrars in the ICANN autho-
rised lists, but they’re a little
more expensive.

Once you find your domain
name, buy it using your credit
card. Follow the standard proce-
dure of shopping online, and
remember not to choose any host-
ing options—a simple tip here is to
steer clear of anything with a ‘$’
sign next to it, and look for the ‘No
Thanks’ or ‘Not at this time’ links
while buying your domain.

For hosting options, choose
the one that lets you use a parked
page or masked forwarding for
free. Proceed to the ‘checkout’ and
buy your domain. You will have to
register with GoDaddy.com and
create an account to manage your
domain. Once you buy the
domain, login and check the ‘My
Account’ section at GoDaddy.com.
You will see your domain there—
congratulations, you are now a
proud domain owner!

DNS Dilemmas
Now that you have bought your
domain, you need a proper 
DNS management service.
GoDaddy.com provides basic
DNS management, but it is
nowhere near adequate. What
you need to do is register for 
free DNS management services

While buying a domain, click on the ‘No
thanks’ links to avoid needless hassles

One View for all your forwarding in ZoneEdit

After you set up your ZoneEdit account, forward your
domain to the name servers that ZoneEdit alotted you

1/4th Pg Ad
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titled ‘A Mailman for Your Business’
(September 2004 Digit, page 102). 

Free Web Sites 
The easiest way to develop a
professionally savvy Web site for
your company isto use templates
from Macromedia Dreamweaver
or Microsoft Frontpage. You can
also use your free host’s quick
site creation tool, such as
Yahoo!’s PageBuilder. 

We recommend using
Dreamweaver and one of its
templates. Remember to keep it
simple with minimum graphics so
that it loads quickly; this also
helps you maintain a low band-
width usage for your Web site—
very important if your free host
imposes per-day or per-hour band-
width restrictions, the way
Geocities.com does. The smaller

the size of each page, the faster it
loads and the less bandwidth it
uses up per visitor.

Remember to read through
the box ‘Cloaking Charades’ when
setting up internal page links in
your Web site. 

Now that you have set up your
Web site, and have cloaked it to
give it that professional look, do
not forget to read up on search
engine optimisation tips for your
Web site. Nothing can get you
more online business than being
on one of the first three pages of a
Google search for the product or
service that you offer. Submit your
site to Google by visiting http://
www.google.com/ addurl.html.

You can choose to use other
services, however, try and get the
best deal possible, and ensure that
your domain is registered in your
name—at times when you apply
for a cheap hosting package, the
registrar or hosting provider regis-
ters the domain in their name,
thus forcing you to stick with
them. Hence, do remember to
read the fine print, both online
and offline.

Our solution, use
GoDaddy.com to register,
ZoneEdit.com to manage DNS and
Geocities.com to host for free, will
cost you exactly $8.95 (Rs 410) per
year—just the cost of the domain
name. All you need is a credit
card, some free time and a little
patience, and you can give your
outfit a much needed edge. 

Note that this solution
cannot be compared to dedicated
hosting and professional Web
site development, but is merely a
starting point for the millions of
small Indian businesses or free-
lancing professionals, who can
use all the help they can get.
Happy Cloaking! 

robert_smith@thinkdigit.com

you can just click on ZoneEdit’s
trademark MailForward service
and add, say, sales@thesitey-
ouwanttobuy.com , and forward
it to something@vsnl.net 
for example. 

Now, all e-mails sent to the
domain’s ‘sales’ e-mail alias will
be forwarded to your VSNL
account. You can do this for each
employee and each service. 

You can add as many e-mail
aliases as you like, and even make
your company seem a lot bigger
than it is by adding aliases 
for ‘customersupport’, ‘sales’,
‘production’, ‘dispatch’, etc, all
forwarding to a different or the
same address. 

You can even reply from these
addresses if you have access to 
an SMTP server from your ISP. 
For details see the article 

In order to keep up the ‘Professional’ look
of your Web site, you need to ensure that

there is no trace of the ‘free’ hosts’ domain.
For example, let’s say you host a free site at
Geocities.com, and you WebForward your
site from ZoneEdit to wwwwww..ggeeoocciittiieess..ccoomm//
tthheessiitteeyyoouuwwaannttttoobbuuyy//iinnddeexx..hhttmmll using the
cloaked option. As visitors type
thesiteyouwanttobuy.com in their browser,
they are taken to
www.geocities.com/thesiteyouwanttobuy/i
ndex.html, but the browser still shows
thesiteyouwanttobuy.com. Unfortunately,
you may have created a second page—a
‘Products’ page for example—called
products.html, which is linked to from your
site. The minute a visitor clicks on this link,
he or she will be taken to wwwwww..ggeeoocciittiieess
..ccoomm//tthheessiitteeyyoouuwwaannttttoobbuuyy//pprroodduuccttss..hhttmmll.
If the visitor looks up at his address bar, he
will immediately know that this site is hosted
for free at Geocities.com, thus spoiling the
professional appeal you hoped for.

There is a simple way to counter this:
edit or create your free Web site with a
ZoneEdit window open. Whenever you
want to link a page to another—say from
index.html to products.html—just go to
ZoneEdit and create a new WebForward
for the sub-domain products
(products.thesiteyouwanttobuy.com) and
forward it with cloaking to
www.geocities.com/thesite
youwanttobuy/products.html. Now, in
your index.html page, set the link as
products.thesiteyouwanttobuy.com, and
do not forget to upload the products.html
page to Geocities.com.

If you do this for all the links to other
pages in your Web site, you can pull of a
pretty decent job of masquerading as a
professionally hosted Web site.

For Tips on how to design a
professional looking Web site, go through
the tutorial from ImageOnline on the
November 2004 Digit DVD and CD. 

Cloaking Charades: Make Your Web site Look Professional

Strip Ad
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With both a film-
based and a
digital camera in
possession, I
decided to find
out which was
better when it
came to clicking
and sharing
photos. The old
way entailed
prints and post
offices; the tech
way promised a
digitised
solution
through-and-
through.

I picked up my old Kodak KZ25. It was out of film
and I had to walk down to my nearest photo
studio to buy a roll. Since the batteries had
enough juice to last that one roll, I decided not to
invest in a new set of alkaline batteries.

Time taken 15 minutes

Using the onboard LCD, I was clicking and review-
ing images with ease. I would click, decide whether
or not to keep the picture, and click some more. 

Time taken 20 minutes

I plugged the camera to my PC and transferred
my pictures to my hard drive. Then, I launched
photo-editing software to do some post-
processing and image scaling, to get them to a
size suitable for e-mail.  

Time taken 15 minutes

After the images were trimmed to size, I started up my
favourite e-mail client and attached them. An e-mail id
later, the mail was off to my relatives. 

It took four days for the prints to reach my relatives in
Rajasthan! God bless the postal service.

Time taken 4 days

Mailing the pictures, the old way... ...e-mail beats snail mail any day

1

2

3

4

My relatives received the images taken with the
digital camera within a few minutes. What’s

more, I got a reply e-mail just as quick—all this was
done in under an hour and a half. On the other

hand, the Old Way was much too time consuming
and tedious. It’s high time everyone who loves to
share their favourite moments upgrade to a digital
camera.

OLD
WAY

TECH
WAY

Total Time Spent: Five days, 40 minutes
Total cost: Rs 230

Total Time Spent: 65 minutes
Total cost: Rs 0

And 
The

Winner
Is...

Aliasgar Pardawala (aliasgar_pardawala@jasubhai.com)

I chose five prints I wanted to share with my rela-
tives by snail-mailing them. I put them all in an
envelope, wrote out the address (which did not
involve an '@' sign!) and sealed it. A drive to the
local post office took around 15 minutes in
Mumbai traffic. Five minutes in a queue for my
turn. Stamps: Rs 8. Sticking them on and drop-
ping the envelope into a postbox took another 5
minutes. Phew!

Time taken 25 minutes

Taking pictures—from clicking to sharing

At 5 megapixels with 10X optical zoom, my Kodak
DX6490 is a beauty. I ascertained that the batteries
were usable. Preliminary check done, I headed to
the menu to set the basic parameters to suit an
indoor environment. I took a few sample snaps to
double-check the results of the tweaking,  and got
ready for final shoot.

Time taken 30 minutes
After clicking about 20 frames, I handed in the
roll for development. Of course, I had to wait until
the next evening to get the prints—a wait of 24
hours. The guy did offer express delivery, but that
would have entailed additional cost. Cost for 20
copies, each of them 5 x 7 inches, around Rs 120.

Time taken 24 hours
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I Can’t Send My Mail

I read about YahooPOPs! in the Digit
September 2004 issue. I have downloaded

and installed it but it doesn’t seem to be work-
ing. YahooPOPs! downloads messages from the
Yahoo! server, but doesn’t send mail. How do I
send mail using this program?

Ramji

By default, the software is not set to send
mail. To enable sending of mail, you need

to enable SMTP, which you will find within
Advanced Preferences > Network.

Cannot Install Anti-Virus
Software

When I try to install Norton AntiVirus
Corporate Edition on a Windows 2000

PC, I get the following error message:
“Windows Installer cannot be accessed.” Is
it a virus that is preventing the installation?
What should I do?

Praveen

The problem is not due to a virus,
but due to some version issues

between version 1.1 and version 2.0 of
the Windows Installer. To resolve the
issue, you first need to locate the path of the
msiexec.exe file. Typically, this should be
c:\winnt\system32\msiexec.exe. Once you have
found the path, run regedit and navigate to
H K E Y _ L O C A L _ M A C H I N E \
S Y S T E M \ C u r r e n t C o n t r o l S e t \ S e r v i c e s \
MSIServer. Here, verify if the “ImagePath”

value is the proper path, the one you found. If
it is not, correct it and close regedit. Now,
restart the machine in safe mode and execute
the command “msiexec /regserver” at the
command prompt, or under Run.

ISA-to-PCI adaptor?

I bought a 4.7 GB SCSI HDD with a SCSI
controller card. The problem is, the SCSI card

is an ISA card, and my machine does not have an
ISA slot. Is there a converter for ISA to PCI? Or, is
there any other way out?

Manish Mishra

There is no adaptor available for this
purpose. You can buy a PCI SCSI controller

card and connect the HDD to your computer.
Alternatively, you can buy an external SCSI
drive casing and connect the drive to the PC.
However, this solution will only help if the
SCSI drive is an additional drive.

Free Space Reduces All By Itself

I have a Compaq Intel Celeron 900
MHz with 128 MB of RAM, and I am

running Windows XP Professional. I have
noticed that the amount of free disk space
keeps on decreasing, even if I don’t install
any new software. Many a time, I try to
recover disk space using the Windows disk
clean-up utility, but it does not work.
Sometimes there is some gain in disk
space, but as I continue to work, the free
space keeps on decreasing. Even after
removing a program, say 50 MB large, the
equivalent amount of disk space gain is not
obtained. Why is this?

Another problem is with PHP installa-
tion. I want to install and configure PHP
with the php-5.0.1-installer for Windows.
At one point of the installation, I am asked

to configure IIS automatically. If I select this
option, will I be able to run ASP programs as
well? Currently, I am able to run ASP pages.
Similarly, if I uninstall PHP, will my IIS settings
be disturbed, making it impossible to run ASP
programs? 

Partha Paul

To answer your first problem: Windows
uses hard disk space for a variety of

purposes such as swap, log files, etc. As you
work with Windows, you will observe that free
space is reducing—this is perfectly normal
behaviour. It would be abnormal only if it were
reducing at a drastic pace. You should observe
the disk space at the start and at the end of
your Windows sessions. You should find that
the space at the start of a session is more than
at the end of the previous session.

As far as deleting files is concerned, when-
ever you delete files they go to the Recycle Bin,
so you would not observe a change in free disk
space. You will only find an increase in disk
space when the Recycle Bin is emptied, or if
files are permanently deleted.

Your Questions, Our Answers

Select the source from where you want 
to import your photos
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It could be due to a virus as well.
Make sure you have anti-virus software
that is up-to-date with the current virus
definitions.

The PHP installer will add settings
needed for PHP to work properly with
IIS. It does not erase the settings ASP
needs. Your ASP pages will work.

Assigning Hotkeys

I run Windows 98 on my computer,
along with programs such as MS Office,

PageMaker, etc. I want to use a tool called
dictionary.exe along with these programs,
and I want to assign a keyboard key to work
as a hotkey for launching the application. How do I
do it?

Nilesh Waghulde

For assigning hotkeys, you can find free
tools such as Keyboard Launchpad 1.0

(http://www.softpedia.com/public/cat/13/11/
13-11-44.shtml) on the Net.

Sound Card Works With Win XP
But Not With Win 98

I have a PC with an Intel Celeron 2 GHz
processor with a D-Link motherboard,

an Intel 845GV graphics controller,
onboard Soundmax Digital Audio, a
Motorola modem, and other stuff. The
quality of the onboard sound is not as good
as that from the PCI CMedia sound card, so
I disabled onboard sound and installed the
CMedia sound card. The problem is, it does
not get detected in Windows 98 although it
works perfectly with XP. Furthermore, it

works fine at my friends place with Windows 98.
What’s up?

Sanju

The problem would be due to a resource
conflict with some other device on the

system. To get around this problem, you
should first check the BIOS settings, and
disable all unused devices. Also verify that IR
settings are set to Auto. If the problem
persists, try installing the card in a different
PCI slot. If you still have the problem, try
removing other PCI cards, such as the
modem, one by one, and see if the sound card
gets detected. If it does not get detected even
after removing all the other PCI cards, you
will need to bring in an engineer.

Unable To Defrag

I have an HCL Infinity Pro with a 40 GB disk,
divided into two 20 GB partitions. The prob-

lem is, in NTFS, Defragmenter does not work.

Getting Slow, Slow, Slower

I have a Wipro Super Genius 10845GL-m with a P4 1.7
GHz processor, 128 MB of RAM, a 40 GB HDD and an LG

CD writer. I run Windows XP Home Edition with Service 
Pack 2. My problem is, the computer has
recently gotten too slow. It takes ages to
start applications. It takes almost five
minutes to start applications such as
Norton AntiVirus, Microsoft Outlook,
Outlook Express, etc. I want a solution
to this, and also want to learn how to 
re-install Windows.

Malay Kurwa

To resolve the issue you will
need to check a few important

things. First, you need to open up the
cabinet and check if dust is covering
the parts. If it is, clean them with a
dry cloth. Second, verify that the
CPU fan is working properly. There
should be no sudden increase or
decrease in rotation speed. Clean the
dust from the power supply and check the power supply
fan movement as well. Finally, check if your machine is
getting too hot when you use it for around 3 to 4 hours.

If it is, you need to improve the air flow and cool-
ing. Depending upon your cabinet, try to add a
system fan. Or else, keep the cabinet open when
you plan to work for long.

On the software front, run msconfig and remove any
unnecessary services that
start up with Windows each
time. Next, use scandisk to
find and eliminate any
errors. Also defragment
your drive.

Installing Windows is a
breeze. Just make a backup
of all the important files on
your C drive on any other
partition. Also copy your
Outlook or Outlook Express
mail folders. If you want to
format the C drive, you can
do so during the install.
Formatting is always recom-
mended as it will erase all
unnecessary files residing
on the C drive—but do not

forget to take a backup of all your important files. 
Re-installing Windows will not affect any partition other
than the one you do the installation on.

Question 

of the

Month

Select the source from where you want 
to import your photos
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How to...

Install Applications On Your Handheld
Deepak Dhingra

Owning a handheld is one of the best indi-
cations that you have arrived in the digi-
tal world. A PDA helps you organise your
life and makes you more efficient. Though
most of the default applications installed
on a handheld are quite useful, you would
definitely need to install some more appli-
cations and games to get the best out of
one.

Here we illustrate how to install appli-
cations on your Pocket PC handheld.

The first step is to connect your
PDA to your PC. Install Microsoft
ActiveSync on the PC first, and

connect your PDA to the PC. The PC will
recognise the new device and ask you what

type of partnership is required. Select
GGuueesstt  PPaarrttnneerrsshhiipp and click NNeexxtt.

The ActiveSync Window will pop up
and show you the “connected” status on
the PC, and a confirmation message will be
displayed on the handheld as well.

Using your PC, download the
handheld application you wish to
install. Extract the setup files if

the file you downloaded is a Zip archive.
Run the setup executable. The program
will ask to confirm whether you want to

continue with the installation. Click YYeess
and follow the installation wizard.

The setup will retrieve the appli-
cation data from the device and
confirm whether you wish to

install the application into the default
install directory. Click YYeess to continue, or
NNoo to select a different directory.

Application installation on your Pocket
PC is now complete. A final message asks

you to check whether any additional steps
are required on your handheld.

PALM
Installing an application on the Palm is just
the simple task of dragging the right files
to the Quick Install utility. Applications for
Palm come in two varieties—either as a
PDB, a database file, or as a PRC, a
resource file. The process remains the
same. Just as ActiveSync is to the Pocket
PC, HotSync is to a Palm handheld—it helps
install and synchronise files between your
computer and handheld.

The first thing to do is to install
the Palm Desktop software on
your computer. This will install

the HotSync manager and the Quick Install
utility. If this is your first time installing it,
you will be asked for a username. Start

Palm Desktop after the installation
completes and look for the Quick Install
icon on the left pane of the application.
Click on it and head to the next step.

Installation is a drag-and-drop
process. Within Quick Install,
the upper window represents

your Palm’s local memory while the
lower window is for SD or MMC cards. As
a rule of thumb, applications go in the

upper window, and multimedia files go
in the lower window (assuming you have
a card). Locate either the PRC or the PDB
file you need to install, and drag it to
either of the two windows.

Now you need to HotSync the
files. This need not be immedi-
ate. You can close Quick Install

after Step 2 and come back later to do the
HotSync. The application will be installed
after the HotSync process is complete.

NNoottee:: Always remember to check how
much available memory you have on the
PDA. This is indicated by Quick Install.

BBoonnuuss  NNoottee:: Although Palm’s default OS
requires that an application reside in its
local memory and not on an external card,
you can use a third-party tool to move
applications to SD or MMC—this is very
helpful if you are running low on local
memory. Applications will take longer to
start up from a card, but hey, it is a good
bargain. zLauncher is one such application
which we heartily recommend.

deepak_dhingra@thinkdigit.com

Establishing a ‘partnership’ on a Pocket PC

Run the setup utility of the application you
wish to install to your Pocket PC

Drag-and-drop or use the ‘Open’ dialog

A file can be moved to a card or deleted

The upper window is for your Palm, while
the lower belongs to the external card

A confirmation dialog after a successful
installation
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Scandisk shows no bad sectors. I have checked for
hardware failures, but all seems OK. I have four
other similar PCs, and all have the same problem.

Himanshu

To resolve the issue, use Notepad to open
the scandisk.ini file within the

Windows\Command folder. In this file, search
for the [Environment] section. Within this
section, modify the lines for ScanTimeOut and
NumPasses as below:
ScanTimeOut=On
NumPasses=5

If the [Environment] section is missing,
add the section at the bottom of the file as
below:
[Environment] 
ScanTimeOut=On
NumPasses=5 

Save and close the file, then restart the
computer in DOS mode. At the prompt,
execute scandisk. Repair any errors. After scan-
disk is done, type in “exit” and hit [ENTER] to
get back to Windows. Run Defragmenter
again. If the error persists, run Defragmenter
to only consolidate free space. After that,
defragment files only, and then perform
a full defrag (both files and free space). 

In order to run Defragmenter to only
consolidate free space, click Advanced,
click Consolidate Free Space Only, and then
click OK. When Defragmenter completes,
do not quit: instead, click Advanced, click
Defragment Files Only and then click OK.
Once again, do not quit when
Defragmenter completes—click Advanced,
click “Full defragmentation (both files and
free space),” and then click OK. This
should solve your problem. 

If it does not, contact the manufac-
turer of your computer or hard disk to
enquire about additional workarounds
that may correct the problem.

Menu Names In Photoshop CS Show
Up In A Foreign Language

I have installed Photoshop CS as well as
ImageReady. The problem is that Photoshop

does not show menu names in English, while
ImageReady does. How do I solve the problem?

Cyril Barot

You need to add or modify the following
registry keys. Copy the following lines into

Notepad and save the file with a .reg extension.
Close the .reg file, then double click on it. This
will add the lines to the registry. Photoshop
should now be OK.
HKEY_CLASSES_ROOT\Interface\{9414F179-C905-
11d1-92CC-00600808FC44} =
IPhotoshopApplication
HKEY_CLASSES_ROOT\Interface\{9414F179-C905-
11d1-92CC-00600808FC44}\TypeLib = {4B0AB3E1-
80F1-11cf-86B4-444553540000}
HKEY_CLASSES_ROOT\Interface\{9414F179-C905-
11d1-92CC-00600808FC44}\ ProxyStubClsid32 =
{00020424-0000-0000-C000-000000000046}

It’s Just The Battery

My processor is a Pentium 4 2.4 GHz. When I
turn on my computer, the first screen shows

up the following error: “CMOS CHECKSUM ERROR-
Defaults Loaded. Press F1 to Continue.”

When I press F1, the system boots up and works
properly, but the clock tells the wrong time. When I
change the CMOS settings from the BIOS and
restart the system after some time, it displays the
same error message.

Is this a jumper setting problem? What can I do
to make the error screen go away?

Sanjeev Nehra

The CMOS checksum error flashes on the
screen when the CMOS batteries drain out.

Just replace the CMOS battery.

RAM Stick Compatibility

I have a P4 1.7 GHz, 128 MB of PC133 SDRAM,
and a GeForce 4 Mx-420 64 MB video card. I

want to attach another 128 MB SDRAM stick of
the same speed (PC133). But every time I put it
in, no  programs work properly, especially

games. But when I use only the new stick,
programs work fine.

Sandeep

There is a compatibility problem
between your older and recently

purchased memory modules. The speed
of the memory modules being the same
does not necessarily mean they have
identical characteristics at the chip level.
For example, check the CAS latency of
the two memory modules. We recom-
mend that you replace your old memory
module, and use a brand new set.

Low 3DMark 2003 Score

I have a P4 2.8 GHz HT (LGA775 Socket), an
original Intel 915GAV, a 512 MB Hynix DDR

400 MHz RAM stick (single channel), and an 80 GB
Seagate Barracuda hard disk. The OS is Windows
XP with SP2, and with all the latest patches and
updates. I’ve updated Norton AntiVirus 2004 with
Norton Internet Security. Despite having the
latest hardware and software updates, my 3D
Mark03 score is only 265. 

Will upgrading to dual-channel memory be
worth the money?

Sandip Padte

A score of 265 in 3DMark 2003 is low. We
think there may be a settings problem or

a driver problem. Also, when you were bench-
marking the system, what programs were
running in the background? Norton
AntiVirus and Internet Security should
ideally not be  running—they take up a lot of
resources. Check the driver version of the
onboard graphics adapter and see if Intel has
released any new versions. If it has, download
and install them. There is also the possibility
that SP2 is responsible for the low 3DMark
2003 score. 

E-mail us your 
computing problems,
and we may answer
them here! Since we get
more mails per day than
we can handle, it may
take some time for your
query to be answered.
Rest assured, we are 
listening!

sos@jasubhai.com
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The Cellphone Buyers’ Guide l Introduction

October 18, 2004 could have been just
another day for Indians—hot, humid, and
dehydrating. But, three events took

place that day, and each had the potential to
turn history around.

The rains at Chennai exposed the pathetic
water draining systems at Indian stadia, and
denied India a much-needed victory against
Australia in the second Test of the Border-
Gavaskar trophy. Later in the day, murderer,
smuggler, kidnapper, and national nuisance
Veerappan was shot dead in the
Satyamangalam forests on the Karnataka-Tamil
Nadu border.

But perhaps the most important news event
of the day almost went unnoticed. For the first
time in history, the number of mobile phones
exceeded the number of landlines in the coun-
try. While cellular subscribers crossed the 44
million mark, fixed lines were at 43.82 million.

It is as much an evidence of India's fast
growth to becoming a telecommunications
giant, as much as the fact that the cellular
phone growth has been led by a fundamental
need of any growing economy— cheap, effec-
tive communication that is accessible to 
every person.

It is only natural, then, that Digit, India's
most trusted source on personal technology,
would publish the country's most exhaustive
cellular phone buyers’ guide for its readers. 

Twenty-one pages of all the information
you would ever want about buying cell phones
in India.

When the Digit team started compiling
information for the products available in the
market, we thought it would as easy as apple
pie. It was not. Company web sites were
woefully inadequate, sales representatives and

dealers were not forthcoming (or worse, igno-
rant), and there was no single source of infor-
mation on even the number of phone models
currently available in the market.

We scoured shops, visited company web
sites, called up company helplines, spoke to
readers, and even traced long-lost friends, to
source information on the 100-plus cellular
phone models officially available in India. The
result is the 21 pages you would read now.

Navigating through the Buyers' Guide is
child's play. Neatly headlined, and divided into
various categories like basic, mid-end, high-end
and PDA phones, the Guide is not just a listing of
tabulated data. We have also included value-
added features like tips and tricks, a primer on
mobile etiquette, questions you simply must ask
the dealer before you a phone, etc.

We hope the Buyers'
Guide would be a
useful reference
document for
both first-time
buyers, as well as
for those who
want to upgrade. 

It would be a
travesty if Digit
publishes a one-time
Cellphone Buyers'
Guide. Digit will
publish the Cellphone
Buyers' Guide with as
much regularity as new
models keep coming in
the market. 

This is one document
you just don't want to
misplace, do you?

Let’s Talk!
We scoured shops, visited company web sites, called up company helplines, spoke to
readers, and even traced long-lost friends, to source information on the 100-plus cellu-
lar phone models officially available in India. 
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GSM

1G (First Generation Wireless) First generation of wireless technology
(analog cell phones). The systems were designed only to carry voice
technology.
2G (also known as PCS—Personal Communications Services) Second
generation of wireless technology (digital cell phones). 2G converts

voice to digital data for transmission over the air and then back 
to voice. 
3G (Third Generation Wireless) Next generation of wireless technology
which provides high speed data transmissions (up to 2Mbps) and the
ability to roam globally.

BASIC PHONES

Alcatel

One Touch 320

Dualband

106 x 45 x 20

80

Bar

Internal

Mono

112 x 64

2-Way

100

SMS

NA

Polyphonic

Li-lon (700 mAh)

7

120

2,800

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✔

✔

✔

✖

✖

✔

✖

✖

✖

✖

Alcatel

One Touch 331

Dualband

98 x 42 x 20

77

Bar

Internal

Mono

96 x 65

3-Way

250

SMS, EMS

NA

Polyphonic

Li-lon (600 mAh)

6

280

3,100

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✔

✖

✔

✖

✖

✖

✔

✔

✖

✖

✔

✖

✖

✖

✖

Alcatel

One Touch 332

Dualband

98 x 42 x 21

77

Bar

Internal

4,096

96 x 65

3-Way

NA

SMS, EMS

NA

Polyphonic

Li-lon (600 mAh)

6

230

4,599

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✔

✖

✔

✖

✖

✖

✔

✔

✖

✖

✔

✖

✖

✖

✖

Benq

M100

Triband

102 x 44 x 18

86

Bar

Internal

65,536

128 x 128

5-Way

500

SMS

NA

Polyphonic

Li-Ion (760mAh)

3

120

iTap

NA

NA

5,990

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Benq

S620i

Dualband

84.9 x 46 x 19.2

90

Clamshell

External

Mono

98 x 64

2-way

100

SMS

NA

NA

Li-Ion (659 mAh)

5

210

NA

T9

4,990

✖

✖

✖

✖

✖

✖

✖

✔

✔

✔

✔

✔

✔

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gm)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price (in Rs)

Web Site

Alcatel

One Touch 535

Dualband

106 x 47 x 20

87

Bar

Internal

4,096

128 x 128

5-way joystick

800

SMS, MMS, EMS

NA

NA

Li-lon (800 mAh)

7

300

6,250

✔

✔

✖

✔

✔

✖

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖
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www.my-onetouch.com
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4G (Fourth Generation Wireless) Communications systems that offer
data rates at 20+ Mbps, suitable for high-resolution movies and tele-
vision. Initial deployment is anticipated in 2006-2010.
Air Interface A wireless network’s operating system, enabling com-
munication between a cellular phone and its carrier.

Automatic Answer Allows users to answer incoming calls without
pressing any keys.
Backlit Illumination Illuminates a wireless device’s display and key-
pad for better low light viewing.
Bluetooth A wireless Personal Area Network (PAN) specification that

Benq

S630i

Dualband

84.9 x 46 x 19.2

NA

Clamshell

External

Mono

98 x 64

NA

100

SMS, EMS, NMS

NA

NA

Li-Ion

5

210

4,990

✖

✖

✖

✖

✖

✖

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Benq

M560G

Dualband

106 x 45 x 20

80

Bar

Internal

Mono

NA

NA

500

NA

NA

Polyphonic

Li-Ion

3

210

4,200

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✖

✖

✖

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Benq

M820C

Dualband

87 x 45 x 19

98.5

Clamshell

External

4,096

128 x 160

NA

500

SMS, EMS, MMS

NA

Polyphonic

Li-ion (580 mAh)

NA

NA

NA

✖

✖

✖

✔

✖

✖

✔

✔

✖

✔

✖

✖

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Bird

S288

Dualband

103 x 44 x 12

65

Bar

Internal

Mono

112 x 80

NA

300

SMS

NA

Polyphonic

Li-Ion (550 mAH)

2.5

220

3,999

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✖

✔

✔

✖

✖

✔

✖

✖

✖

✖

Bird

S1160

Dualband

85 x 44 x 19.6

83

Clamshell

External

Mono

112 x 64

NA

NA

SMS

NA

NA

Li-Ion (550 mAH)

2

100

3,400

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

Bird

S1190

Dualband

85.3 x 44.2 x 20.8

78

Clamshell

External

4,096

102 x 80

NA

200

SMS

NA

Polyphonic

Li-Ion (800 mAH)

5

150

4,500

✔

✖

✖

✖

✔

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

What is the guarantee/war-
rantee period and type?  

Where is the nearest service
center?

Is the hands-free set, really
free with this phone?

Does the phone have any
reception issues?

Is this model still in produc-
tion by the company?

Remember to always back
up your SIM card or CDMA
phone's data. If either of these
are damaged, and have to give
it in to a service centre for
days, you will be lost without
all your contact information.

When travelling, if you know
that you will be away from a
power socket for a long time,
switch off the phone's vibrator
as it uses a lot more power
than the ringer.

A Word Of Caution!

When you are roaming, your
battery is used more, because
when ever you are out of
range, your phone continuously
searches for a signal.

Each phone has a specific
point that should not be
covered, because beneath this
point lies its inbuilt antenna.
You may also face reception
problems if you place your
hand over this point while on a
call. 

Did You Know?

www.benq.com www.chinabird.com

Questions you
must ask your

dealer before buying
a cell phone
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

Kejian

K288

Dualband

107.5 x 46.5 x 20 

76

Bar

Internal

4,096

102 x 80

4-Way

200

SMS, EMS, MMS

Normal

40-chord

Li-Ion

3

200

NA

5,580

✔

✖

✔

✔

✖

✖

✔

✖

✖

✖

✔

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

LG

G1500

Dualband

107 x 43 x 22

85

Bar

Internal

Mono

128 x 64

2-way

200

SMS

NA

Standard

Li-Ion (850 mAh)

4

250

T9

3,250

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✖

✖

✖

✖

✔

✔

✔

✖

✖

✔

✖

✖

✖

✖

LG

G3100

Dualband

107 x 43 x 22

85

Bar

Internal

4,096

NA

3-way

150

SMS, EMS

NA

Standard

Li-Ion (760 mAh)

2

200

4,800

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✖

✔

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

BASIC PHONES

Nokia

3315

Dualband

113 x 48 x 16 

114

Bar

Internal

Mono

NA

NA

NA

SMS

NA

Standard

Li-Ion (825 mAh)

3

250

NA

NA

NA

3,399

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

Nokia

2100

Dualband

105 x 44 x 20 

85

Bar

Internal

Mono

96 x 65

2-way

100

SMS

NA

NA

Li-Ion (720 mAh)

3.2

150

NA

T9

4,449

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✔

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

www.kejian.com.cn www.lgezbuy.com www.motozone.yahoo.co.in
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Motorola 

C350E

Dualband

NA

85

Bar

Internal

4,096

96 x 65

NA

100

SMS, EMS

NA

Polyphonic

Li-Ion (600 mAh)

4.8

215

NA

NA

iTap

NA

Na

4700

✔

✖

✖

✔

✖

✖

✔

✖

✖

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

connects phones, computers, appliances, etc, over short distances
without wires by using low power radio frequencies.
CDMA (Code Division Multiple Access) A type of digital wireless tech-
nology that allows large amounts of voice and data to be transmitted
on the same frequency.

Cellular Service A wireless telephone service that provides two-way
voice and data communications through handheld, portable, and car-
mounted phones via geographic areas called cells.
CLI (Calling Line Identification) A feature that shows you the number
and sometimes the name of an incoming caller.G
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Nokia

2300

Dualband

107 x 46 x 20

92

Bar

Internal

Mono

97 x 65

4-way

NA

SMS

NA

Polyphonic

Li-Ion

4.3

400

T9

5,289

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✔

✔

✖

✖

✔

✔

✖

✖

✖

Nokia

3120

Triband

102 x 43 x 15

99

Bar

Internal

4,096

129 x 128

4-Way Keypad

NA

SMS, MMS

NA

Polyphonic

Li-Ion (850 mAh)

4

288

NA

T9

NA

6,799

✖

✖

✖

✔

✖

✖

✔

✔

✖

✖

✔

✔

✔

✔

✔

✖

✖

✔

✖

✖

✖

✖

Nokia

3100

Triband

102 x 43 x 15

85

Bar

Internal

4,096

128 x 128

4-way

300

SMS, EMS, MMS

450 KB

16-chord

Li-Ion (850 mAh)

6

410

NA

NA

NA

NA

NA

T9

6,499

✔

✖

✖

✔

✖

✖

✖

✔

✖

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

Panasonic

G51

Triband

80 x 43 x 18

74

Bar

External

4,096

128 x 96

NA

255

SMS, EMS

NA

40-chord

Li-Ion (780 mAh)

2.5

200

NA

NA

NA

T9

NA

6,990

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

Nokia

1100

Dualband

106 x 46 x 20 

86

Bar

Internal

Mono

96 x 65

2-way

50

SMS

NA

Polyphonic

Li-Ion (850 mAh)

4.3

400

T9

NA

3,499

✖

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✔

✖

✖

✔

✔

✖

✖

✖

✖

✔

✖

✖

www.panasonic.com www.philips.comwww.nokia.co.in

Sagem

MyC-1

Dualband

99 x 45 x 21

89

Bar

Internal

256

101 x 80

4-way

250

SMS, EMS

NA

Polyphonic

Li-Ion

5

340

NA

NA

NA

T9

NA

NA

NA

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✖

✖

✖

✖

✖

Philips

330

Dualband

79 x 43 x 18.5 

82

Clamshell

External

Mono

101 x 80

5-way 

NA

SMS, EMS, MMS

4 MB

32-chord

Li-Ion (600 mAh)

2.3

400

T9

4,400

✖

✖

✖

✖

✖

✖

✖

✔

✔

✔

✖

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Philips

630

Dualband

83 x 43 x 22

78

Clamshell

External

4,096

128 x 128

4-way

300

SMS, EMS

NA

32-chord

Li-Ion (560 mAh)

2.5

200

NA

T9

8,395

✔

✖

✖

✔

✖

✖

✖

✔

✖

✖

✖

✔

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Cloning A crime whereby criminals capture identity codes from analog
phones and create “clone” IDs allowing them to charge calls to your
cell phone account. Digital phones cannot be cloned in this way and
are also less vulnerable to eavesdropping than analog phones.
Dual-Band A wireless device that operates on both 800 MHz and 1900

MHz digital networks to send and receive calls; basically, the phone
operates in either digital cellular or PCS frequencies.
GPRS (General Packet Radio Service) A technology standard for high-
speed data transmission over GSM networks. GPRS sends data over
packets rather than via circuit switch connections on cellular networks

G
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

Sagem

MyX3-2a

Dualband

100 x 45 x 21

89

Bar

Internal

4,096

101 x 80

4-way

500

SMS, EMS, MMS

NA

Polyphonic

Li-Ion

5

340

NA

NA

NA

T9

NA

NA

6,199

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

Sagem

MyX-2

Dualband

99 x 45 x 21

89

Bar

Internal

256

101 x 80

4-way

250

SMS, EMS

NA

Polyphonic

Li-Ion

5

340

NA

NA

NA

T9

NA

NA

5,199

✖

✖

✖

✖

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✖

✖

✖

✖

✖

Samsung

SGH-C100

Dualband

111 x 45 x 17

76

Bar

Internal

65,536

128 x 128

4-way

500

SMS, EMS

300 KB

Polyphonic

Li-Ion (780 mAh)

2.5

90

NA

NA

T9

NA

NA

NA

NA

NA

NA

5,800

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Sony Ericsson

T105

Dualband

99 x 44 x 18

75

Bar

Internal

Mono

101 x 67

2-way

100

SMS, EMS

NA

Standard

Li-Ion (700 mAh)

4

200

T9

NA

3,495

✖

✖

✖

✖

✖

✖

✔

✖

✖

✔

✖

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Sony Ericsson

T230

Dualband

101 x 43.9 x 19

79.2

Bar

Internal

4,096

101 x 80

5-way joystick

NA

SMS, EMS, MMS

NA

Polyphonic

Li-Ion( 670 mAh)

12

300

T9

NA

NA

4,990

✖

✔

✔

✖

✖

✔

✖

✔

✔

✔

✖

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

BASIC PHONES

Samsung

SGH-X100

Dualband

110 x 45 x 19.9

85

Bar

Internal

65,536

128 x 128

4-way

1000

SMS, EMS, MMS

9 MB

Polyphonic

Li-Ion (900 mAh)

5

360

NA

NA

T9

NA

NA

NA

NA

NA

NA

NA

6,769

✖

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

which allows for “always on” wireless data connections and speeds up
to 115Kbps.
GPS (Global Positioning System) A system of 24 satellites, computers,
and receivers that is able to determine the latitude and longitude of a
receiver on Earth. By triangulation of signals from three of the satel-

lites, a receiving unit can pinpoint its current location anywhere on
earth to within a few meters.
GSM (Global System for Mobile Communications) A type of digital
wireless network which has been widely deployed throughout the
world. GSM currently operates using three frequencies: 900MHz,

Siemens

A60

Triband

110 x 47 x 23

85

Block

Internal

4,096

101 x 80

4-way

100

SMS, EMS

550 KB

Polyphonic

Li-Ion (700 mAh)

5

250

T9

5,390

✔

✖

✖

✔

✔

✖

✖

✔

✖

✖

✖

✖

✖

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

www.sagem.com www.samsumg.com/in www.sonyericsson.com www.siemens.com
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

Alcatel

One Touch 735

Dualband

106 x 47 x 19.5

89

Bar

Internal

4,096

128 x 128

5-way Joystick

800

SMS, EMS, MMS

NA

Polyphonic

Li-Ion (800 mAh)

7

300

NA

8,990

✔

✔

✖

✔

✖

✖

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Benq

M300

Triband

102 x 44 x 18

85

Bar

Internal

65,536

NA

5-way Joystick

NA

SMS, EMS, MMS

NA

Polyphonic

Li-Ion

5

150

NA

NA

NA

NA

NA

8,900

✖

✖

✖

✔

✖

✖

✖

✔

✖

✖

✔

✖

✔

✔

✖

✖

✖

✖

✖

✔

Benq

S670C

Triband

80.5 x 44 x 22

80

Clamshell

External

65,536

128 x 128

5-way Joystick

500

SMS, MMS, EMS

300 KB

Polyphonic

NA

3

120

NA

NA

NA

NA

NA

12,500

✔

✖

✖

✔

✔

✖

✔

✔

✖

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

Benq

S660C

Triband

80.5 x 44 x 22

75

Clamshell

External

65,536

128 x 128

5-way Joystick

500

SMS, MMS

500KB

Polyphonic

Li-lon

2

100

6,750

✔

✖

✖

✔

✔

✖

✔

✔

✔

✖

✖

✖

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Benq

S830C

Dualband

87.5 x 44.9 x 20.7

98

Clamshell

External

4,096

128 x 160

5-way Joystick

400

SMS, EMS, MMS

NA

10-Tones

Li-lon (700mAH)

3

150

NA

✔

✔

✖

✔

✔

✖

✔

✔

✔

✔

✖

✔

✖

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

MID-RANGE PHONES

1800MHz and 1900MHz.
HSCSD (High Speed Circuit Switched Data System) Enables data
transmission over current GSM networks at speeds of up to 43.2 kbps.
HSCSD does this by using multiple channels.
iDEN (Integrated Digital Enhanced Network) A wireless technology by

Motorola that combines two-way radio, telephone, text messaging 
and data. 
IrDA (Infared) Allows cell phones, PDAs, and other devices to connect
to each other for various purposes. IrDA requires line-of-sight trans-
mission like a TV remote control.

www.my-onetouch.com www.benq.com NA
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Geo

GV500

Dualband

98.5 x 47 x 19

87

Bar

Internal 

65,536

30 x 40

Joystick

NA

SMS, EMS, MMS

NA

Polyphonic

Li-Ion

Na

Na

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

9,900

✔

✖

✔

✖

✔

✔

✔

Geo

GC688

Quadband

85 x 44 x 23.5

80

Slider

Internal

262,000

36 x 28.5

5-way

NA

SMS, EMS, MMS

NA

64-chord

Li-Ion (550 mAh)

NA

NA

NA

NA

13,200

✔

✖

✖

✔

✔

✖

✖

✔

✖

✖

✖

✖

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✔
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NA www.lgezbuy.com www.lgezbuy.com

LG

G5300

Dualband

106 x 44 x 22

85

Bar

Internal

65,536

128 x 128

2-way

NA

SMS

NA

Polyphonic

Li-Ion

3

200

7,900

✖

✔

✖

✔

✖

✖

✖

✔

✖

✖

✖

✖

✔

✖

✖

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖

LG

G5400

Dualband

86 x 46 x 22

85

Clamshell

External

65,536

128 x 160

NA

200

SMS, EMS, MMS

1.3 MB

NA

Li-Ion (760 mAh)

3

230

8,800

✖

✔

✖

✔

✖

✖

✔

✔

✖

✔

✔

✔

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

LG

G5600

Dualband

105 x 43 x 19

90

Bar

Internal

65,536

128 x 160

NA

500

SMS, EMS, MMS

NA

Polyphonic

Li-Ion (760 mAh)

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

10,550

✔

✔

✔

✔

✔

✔

✔

✔

LG

G7100

Dualband

89 x 46 x 24

99

Clamshell

External

65,536

128 x 160

4-Way

200

SMS, EMS, MMS

1.3 MB

32-Tones

Li-Pol (780 mAh)

2

200

NA

14,000

✖

✔

✖

✔

✖

✖

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✔

Nokia

6100

Triband

102 x 44 x 13 

76

Bar

Internal

4,096

128 x 128

4-way

300

SMS, EMS, MMS

669 KB

Polyphonic

Li-Ion (720 mAh)

4

235

T9

10,589

✔

✔

✔

✔

✖

✖

✔

✔

✔

✖

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✖

✖

✖

✖

J2ME (Java 2 Micro Edition) A technology that allows programmers to
use the Java and related tools to develop programs for wireless and
mobile devices such as cellular phones and personal digital assistants
(PDAs).
Lithium Ion (Li-Ion) A type of rechargeable battery for cell phones

generally lighter weight than earlier battery types, has a relatively
longer cycle life, and generally does not suffer from “memory” effect.
Memory Effect A battery problem caused by repeated charging before
a battery is fully drained. This results in deterioration and prevents
batteries from accepting a full charge. It occurs most often in NiCd

Kejian

K698

Dualband

84 x 44 x 21

91

Clamshell

externa

260 KB

128 x 160

4-Way

500

SMS, EMS, MMS

32 MB

Polyphonic

Li-Ion

2

120

NA

16,650

✔

✖

✔

✔

✖

✖

✔

✔

✔

✖

✔

✔

✖

✖

✔

✔

✔

✖

✖

✖

✖

✔

✔

✔

Motorola

C650

Triband

103 x 44 x 20

92

Bar

Internal

65,536

128 x 128

2-way

1000

SMS, EMS, MMS

1.8 MB

Polyphonic

Li-Ion (800 mAh)

6

215

NA

iTAP

9,500

✔

✖

✖

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✖

✖

✔

Motorola

E365

Dualband

107 x 45 x 20

93

Bar

Internal

65,536

128 x 160

5-way 

300

SMS, MMS, EMS

2 MB

Polyphonic

Li-Ion (700 mAh)

3

150

NA

NA

NA

10,500

✖

✖

✖

✔

✖

✖

✔

✔

✖

✔

✖

✔

✖

✔

✔

✔

✖

✖

✖

✖

✖

✔
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

Nokia

6220

Triband

107 x 45 x 19

92

Bar

Internal

4,096

128 x 128

4-Way

300

SMS, MMS

NA

16-chord

Li-Ion (721 mAh)

3

192

IMAP and POP

T9

NA

NA

12,149

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✖

✖

✔

Nokia

6610

Triband

106 x 45 x 18

84

Bar

Internal

4,096

128 x 128

4-Way

300

SMS, EMS

625 KB

4-chord

Li-Ion (720 mAh)

5

300

T9

9,959

✖

✔

✔

✔

✖

✖

✔

✔

✖

✖

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✖

✖

✖

Nokia

6610i

Triband

106 x 44 x 19

87

Bar

Internal

4,096

129 x 128

4-Way

500

SMS, EMS, MMS

NA

Polyphonic

Li-Ion (780 mAh)

3

300

NA

T9

NA

10,799

✔

✔

✔

✔

✖

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✖

✖

✔

Nokia

6800

Dualband

119 x 55 x 23

122

Clamshell

Internal

4,096

128 x 128

4-Way/QWERTY 

500

SMS, EMS, MMS

5 MB

4-chord

Li-Ion (1000 mAh)

4.5

240

T9

1.2.1

12,999

✔

✔

✔

✔

✖

✖

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✖

✖

✖

Nokia

7250i

Triband

105 x 44 x 19

92

Bar

Internal

4,096

128 x 128

NA

500

SMS, EMS, MMS

4 MB

Polyphonic

Li-Ion (720 mAh)

5

240

NA

T9

11,439

✔

✔

✔

✔

✔

✖

✔

✔

✖

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✖

✖

✔

Nokia

N-Gage QD Game Deck

Dualband

118 x 68 x 22

143

Sideways

Internal

4,096

176 x 208

4-Way/8-Way

NA

SMS, EMS, MMS

3.4 MB

MIDI/WAV

Li-Ion (1070 mAh)

3.5

240

T9

9,999

✔

✖

✔

✔

✖

✔

✔

✔

✔

✖

✖

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✖

✖

✖

MID-RANGE PHONES

batteries, is less of a problem with Nickel Hydride batteries and even
less with Lithium Ion batteries.
MMS (Multimedia Messaging Service) a further extension of SMS and
EMS. MMS is designed to make use of newer and quicker mobile trans-
mission methods such as GPRS, HSCSD, EDGE and UMTS, involving the

attachment of multimedia extensions to messages, such as video 
and sound. 
Multiple NAM Allows a wireless phone to operate on multiple phone
numbers and establish accounts with service providers in more than
one service area.

www.nokia.co.in
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Phillips

535

NA

101 x 44 x 19

95

Bar

Internal

65,536

128 x 128

5-way 

NA

SMS, EMS, MMS

8 MB

32-chord

Li-Ion (720 mAh)

6

300

T9

11,995

✔

✔

✖

✔

✖

✖

✖

✔

✔

✔

✖

✔

✖

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✔

Phillips

755

NA

106 x 46 x 18

89

Bar

Internal

65,536

128 x 160

NA

NA

SMS, EMS, MMS

16 MB

32-chord

Li-Ion (720 mAh)

5

250

NA

T9

NA

10,500

✔

✖

✖

✔

✖

✔

✔

✔

✔

✖

✔

✖

✔

✔

✔

✔

✖

✖

✖

✖

✖

✔

Samsung

SGH-S500

Dualband

83 x 43 x 22

80

Clamshell

External

65,536

128 x 160

4-way

500

SMS, EMS

NA

Polyphonic

Li-Ion (800 mAh)

2.5

160

NA

NA

NA

T9

NA

NA

NA

NA

NA

NA

10199

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Samsung

SGH-X600

Dualband

102 x 42.5 x 20

80

Bar

External

65,536

128 x 128

4-way

NA

SMS, EMS, MMS

NA

Polyphonic

Li-Ion (900 mAh)

4

300

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

10,999

✔

✔

✔

✔

✔

✖

✖

✖

✖

✔

✔

Sony Ericsson

K500i

Triband

102 x 46 x 14

80

Bar

Internal

65,536

128 x 160

5-way joystick

NA

MMS, SMS

NA

Polyphonic

Li-Ion (670 mAh)

7

300

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

13,995

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

NAM (Number Assignment Module) A circuit chip located inside a
phone which stores your telephone number, lock code, timer reset
code, network information and other operational data. The NAM is
programmed by the service provider when a device is activated.
Today's phones have EPROM type NAM and are keypad programmable.

OTA (Over The Air) The downloading of ring tones, picture messages,
and other content to your mobile phone wirelessly.
PDA (Personal Digital Assistant) A portable, handheld computing
device typically used for managing addresses, appointments, to-do
lists and notes, but some newer models support wireless Internet

www.panasonic.com www.panasonic.com www.samsung.com/in www.sonyericsson.com

Samsung

SGH-X430

Dualband

80 x 42 x 20

73

Clamshell

External

65,536

129 x 128

4-way

500

SMS, EMS, MMS

NA

Polyphonic

Li-Ion (720mA)

2.5-3.5

150-260

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

8,769

✔

✔

✔

✔

✔

✔

Panasonic

X70

Triband

87 x 47 x 23.9

92

Clamshell

External

65,536

132 x 176

5-way

500

SMS, EMS, MMS

4 MB

16-chord

Li-Ion (680 mAh)

5

250

NA

NA

T9

13,500

✖

✔

✖

✔

✖

✔

✖

✔

✖

✔

✔

✔

✖

✔

✔

✔

✖

✖

✖

✖

✔

✔

Panasonic

X66

Dualband

75.5 x 44.5 x 27

82

Clamshell

External

65,536

128 x 128

5-way

300

SMS, EMS, MMS

NA

16-chord

Li-Ion (680 mAh)

5

230

NA

Na

NA

T9

NA

NA

NA

9,700

✖

✔

✖

✔

✖

✔

✖

✖

✖

✖

✔

✔

✔

✖

✖

✖

✖

✔
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Keep Quiet: Put your phone on
Silent mode when in a meeting.

Whisper: There's no need to
shout into your phone when in pub-
lic places, the other person will hear
you fine if you use your normal
voice. If not, cup your hand over the
microphone, but never scream into
your phone. It’s rude!

Xcuse me pleeeazze: When with
others, always excuse yourself
before answering your cell phone,
and keep the conversations short.

Escape: If you must take an
important call when in a theatre,
library, or place of worship, answer
your phone quietly, ask the calling
party to hold, and exit silently. Wait
till you are outside before continuing
the conversation.

Are you listening to me?: When
the reception is poor, no amount of
shouting will help. In fact, words
may sound more garbled to the
caller due to your screaming.

Don’t disturb: Ignore incoming
calls when in business meetings with
clients or customers 

Shhh…!: Switch off your mobile
when you enter a hospital. 

No noise: Mute or switch off your
mobile phone when you are offering
condolences at a funeral

Danger… Ahead: Do not talk on
your cell phone when driving. Even
using a hands free headset is dis-
tracting, and could put you and the
vehicles passengers at risk. It is also
illegal in most Indian cities. 

BRB: If you are on a call when in a
queue of any sort, ask the caller to
hold or cut the call when your turn
comes.
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

MID-RANGE PHONES

Sony Ericsson

Z200

Triband

96.4 x 52 x 25.4

98.3

Clamshell

External

4,096

128 x 128

4-way

300

EMS, SMS

NA

Polyphonic

Li-Ion (700 mAh)

4

200

T9

8,495

✖

✔

✖

✔

✖

✖

✖

✔

✖

✖

✔

✖

✔

✖

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Siemens

CF62

Triband

82 x 45 x 22

85

Clamshell

External

65,536

130 x 130

Key

500

SMS, EMS, MMS

550 KB

Polyphonic

Li-Ion (600 mAh)

5

220

T9

T

NA

NA

8,990

✖

✖

✖

✔

✔

✖

✔

✔

✔

✖

✖

✔

✔

✔

✖

✖

✔

✖

✖

✖

✖

Siemens

C65

Triband

105 x 45 x 16

86

Bar

Internal

65,536

130 x 130

Key

NA

MMS, EMS, SMS

3 MB

Polyphonic

NA

5

410

NA

NA

NA

T9

NA

NA

NA

NA

NA

9,000

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✖

✖

✖

✔

✔

Sony Ericsson

T610

Triband

102 x 44 x 19

95

Bar

Internal

65,536

128 x 160

4-way Joystick

512

SMS, EMS, MMS

2 MB

Polyphonic

Li-Ion (770 mAh)

11

315

T9

NA

9,995

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✔

Mobile Etiquette

access, e-mail, and other interactive applications.
PIN (Personal Identification Number) A numeric code or password
that may be required by a service provider in order to make outgoing
calls or obtain access to certain applications and data. This code is
always associated to a SIM card, not a phone and is designed to help

guard against cellular fraud.
Predictive Text Input Software built into some cell phones and mobile
devices that make typing words on a keypad easier. Instead of press-
ing each key one, two or three times, just to press it once and a built-
in vocabulary will attempt to guess the word that you are spelling.

www.siemens.comwww.sonyericsson.com
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

HIGH-END PHONES

Alcatel

One Touch 835

Dualband

87.7 x 45.9 x 20

88

Clamshell

External

2,62,000

128 x 160

5-way joystick

NA

SMS, EMS, MMS

3 MB

Polyphonic

Li-Ion (785 mAh)

7

160

NA

NA

✔

✖

✖

✔

✔

✖

✖

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✖

✖

✖

✖

✖

✔

✔

Motorola

E398

Triband

108 x 46 x 21

108

Bar

Internal

65,536

176 x 220

4-way

1000

SMS, EMS, MMS

5 MB

Polyphonic

Li-Ion (700 mAh)

7

210

NA

iTAP

NA

15,995

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✖

✔

✖

✔

Motorola

V303

Triband

89 x 49 x 25.3

123

Clamshell

External

65,536

176 x 220

4-way

1000

SMS, EMS, MMS

5 MB

Polyphonic

Li-Ion (700 mAh)

6.5

200

NA

NA

iTAP

NA

NA

14,995

✖

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✔

Using this system, SMS messages and sometimes e-mails are quicker
and easier to write. Often referred to as T9, the most popular type of
predictive text entry. The competitor to T9 is iTAP by Motorola.
PTT (Push-To-Talk) A two-way communication service that works 
like a “walkie talkie”. This feature allows communication in only 

direction at a time unlike a cell phone that allows for simultaneous
conversations.
PUK (Personal Unblocking Key) used to unblock a blocked SIM card;
this code is given during the subscription of a phone.
R-UIM (Removable User Identity Module) Introduced by the CDMA

www.my-onetouch.com NA www.motozone.yahoo.co.in
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Geo

G1

Dualband

88 x 46 x 23.2

90

Clamshell

External

2,62,000

128 x 160

5-way

300

SMS, EMS, MMS

4.5 MB

64-chord

Li-Ion

2

180

NA

T9

NA

NA

NA

18,000

✔

✖

✖

✔

✔

✖

✔

✖

✔

✖

✖

✔

✔

✖

✖

✖

✖

✔

✔

✔

Geo

GC800

Dualband

84 x 43.6 x 22 

87

Clamshell

External

2,60,000

176 x 220

NA

NA

SMS, EMS, MMS

NA

40-chord

Li-Ion (920 mAh)

2

300

NA

NA

T9

16,150

✔

✖

✖

✔

✔

✖

✖

✔

✖

✖

✖

✔

✖

✔

✔

✖

✖

✖

✖

✖

✔

✔

Geo

GV880

Dualband

52.3 x 57 x 22.5

75

Clamshell

External

65,536

128 x 160

5-way

NA

SMS, EMS, MMS

4.5 MB

40-chord

Li-Ion (620 mAh)

1.5

110

NA

NA

NA

T9

NA

16,500

✔

✖

✖

✔

✔

✖

✖

✔

✖

✔

✔

✖

✔

✔

✖

✖

✖

✖

✔

✔
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Motorola

V600

Triband

87.5 x 47 x 22.5

95

Clamshell

External

65,536

176 x 220

4-way

1000

SMS, EMS, MMS

5 MB

Polyphonic

Li-Ion (700 mAh)

7.5

230

iTAP

20,495

✔

✖

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✖

✖

✔

✔

Motorola

V878

Triband

82 x 42 x 21.5

85

Clamshell

External

65,536

128 x 160

4-way

NA

SMS, EMS, MMS

2 MB

40-chord

Li-Ion (600 mAh)

3

130

NA

NA

iTAP

NA

19,000

✔

✖

✖

✔

✔

✖

✔

✔

✖

✔

✔

✖

✔

✔

✖

✖

✖

✖

✔

✔

✔

Nokia

3300

Dualband

114 x 63 x 20

125

Bar

Internal

4,096

128 x 128

NA

500

SMS, EMS, MMS

4.5 MB

24-chord

Li-Ion (780 mAh)

2.5

228

NA

NA

NA

T9

NA

NA

NA

9,249

✔

✖

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

Nokia

3660

Triband

130 x 57 x 25

130

Bar

Internal

65,536

176 x 208

5-way

NA

SMS, EMS, MMS

3.4 MB

24-chord

Li-Ion (850 mAh)

3

220

NA

T9

NA

15,399

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✖

✖

✔

✔

Nokia

6230

Triband

103 x 44 x 20

97

Bar

Internal

65,536

128 x 128

4-way

1000

SMS, EMS, MMS

9.5 MB

24-chord

Li-Ion (850 mAh)

5

300

T9

NA

17,349

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✖

✔

✔

Nokia

6600

Triband

109 x 58 x 24

122

Bar / Symbian OS 7.0

Internal

65,536

176 x 208

5-way Joystick

NA

SMS, MMS, EMS

6 MB

NA

Li-Ion (850 mAh)

4

240

T9

NA

19,309

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✖

✖

✔

✔

Nokia

6820

Triband

107 x 47 x 20

100

Bar

Internal

4,096

128 x 128

QWERTY 

NA

SMS, EMS, MMS

3.5 MB

16-chord

Li-Ion (850 mAh)

7

240

T9

14,899

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✖

✖

✔

✖

✖

✔

✔

Development Group, the R-UIM is similar to a SIM card but designed
for use with CDMA based mobile phones.
Roaming A service offered by most cellular service providers that
allows subscribers to use cellular service while traveling outside their
home service area. Roaming requires an agreement between opera-

tors of technologically compatible systems in individual markets to
permit customers of either operator to access the other’s systems. 
Satellite Phone A phone that connect callers via satellite. Satellite
phones give users a worldwide alternative to sometimes unreliable
digital or analog connections. 

www.motozone.yahoo.co.in www.nokia.co.in
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

HIGH-END PHONES

Nokia

7200

Dualband

86 x 50 x 26

115

Clamshell

Internal

65,536

128 x 128

4-way

500

SMS, EMS, MMS

4 MB

16-chord

Li-Ion (760 mAh)

5

300

T9

(EDGE)

20,209

✔

✔

✔

✔

✖

✖

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✖

✔

✔

Sony Ericsson

K700i

Triband

99 x 47 x 20

93

Bar

Internal

16-bit colour

176 x 220

NA

510

SMS, MMS

32 MB

Polyphonic

Li-Ion (670 mAh)

7

360

NA

NA

NA

20,995

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

Nokia

9210i Communicator

Dualband

158 x 56 x 27

244

Bar

External

4,096

640 x 200

NA

NA

SMS, EMS, MMS

40 MB

RNG, WAV, AU, WVE

Li-Ion (1300 mAh)

6

230

NA

NA

NA

NA

NA

NA

NA

31,499

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Nokia

7610

Triband

109 x 53 x 19

118

Bar/Symbian 7.0s

Internal

65,536

176 x 208

5-way

500

SMS, EMS, MMS

8 MB

48-chord

Li-Ion (900 mAh)

3

250

T9

NA

26,299

✔

✖

✖

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✖

✖

✔

✔

Sony Ericsson

T630

Triband

102 x 43 x 17

92.5

Bar

Internal

65,536

128 x 160

4-way

500

SMS, EMS, MMS

2 MB

Polyphonic

Li-Polymer (750mAh)

9

300

T9

NA

14,995

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✔

Screensaver A picture or animation which appears on a cell phone’s
display when it is idle.
SDMA (Space Division Multiple Access) A variation of TDMA and CDMA
that potentially will be used in high-bandwidth, third-generation wire-
less products.

SIM (Subscriber Identification Module) A removable plastic card
found in GSM phones that stores pertinent information about a phone
such as your phone number, account information, phone book, PIM
data, etc. The card can be plugged into any GSM compatible phone and
the phone is instantly personalised to the user. 

Nokia

7600 GSM/WCDMA

Dualband

87 x 78 x 19

123

Bar

Internal

65,536

128 x 160

5-way

NA

SMS, EMS, MMS

29 MB

Polyphonic

Li-Ion (850 mAh)

4

170

NA

NA

NA

NA

NA

NA

NA

NA

NA

26,939

✔

✔

✔

✖

✖

✔

✔

✔

✔

✖

✔

✔

✖

✖

✔

✔

www.nokia.co.in www.sonyericsson.com
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Wet ‘n’ Wild? Not Quite!
Keep your phone away from moisture at all costs. All the components of a cell
phone are corrodible and non-repairable. During the rainy season, when humidity
is high, it’s better to keep your cell phone in a moisture proof phone cover. When
travelling in hilly areas, where you find fog and clouds, keep your phone off, or use
a phone cover to protect it from moisture. And remember, using a cell phone with
wet hands is a big no-no!

Thanda-Thanda Cool-Cool
Keeping cool is good for your cell phone! Very long calls may cause your cell phone
to overheat, resulting in a permanently damaged battery. Avoid making or
receiving calls while charging your phone. Don’t stick it in the refrigerator,
however, because extremely low temperatures will cause temporary loss of
display.

To Be Hanged Until…
No key seems to respond; you don’t get any signal; the screen is stuck like a
Windows 95 PC; it’s been calling for hours but refuses to connect or disconnect;
what’s wrong with your phone? Yes, even cell phones can hang. Don’t worry, just
remove the battery for about five seconds and then reattach it. In most cases, it
just boots up normally again, but sometimes you may need to remove the SIM card
for a few seconds as well. It should work fine after that.

Khuljaa SIM SIM!
When handling the SIM card, remember that you shouldn’t bend it, scratch it, boil
it, freeze it, or allow it to get close to any magnetic fields. A SIM, like any other
electronic component, is fragile. Treat it well. If you have activated your handset
security feature, you will be asked for your PIN (Personal Identity Number) when
you insert your SIM card. Enter this four digit code carefully. You may be asked for
your PIN whenever you start your handset, change the SIM, or even before making
a call (PIN2)-depending on the security settings you chose. The security feature of
the SIM causes it to lock up after someone successively enters the wrong PIN three
times. Now you will be asked to enter the PUK (Personal Unblocking Key), which
only your service provider knows. The same applies to the PIN2, and if you lock
your PIN2, you will be asked for a PUK2 code. Though most service providers will
help you unlock your phone, it’s not worth the hassle of being disconnected from
the world. The moral of the story? Be careful when entering your PIN codes.

You also need to remember that entering the wrong PUK or PUK2 codes 10
times, will cause your SIM to be permanently damaged. This security feature
makes the SIM unusable to prying eyes, and will need you to get your SIM replaced
by your service provider. Depending on your provider, you may be charged for a
new SIM, so be even more careful when entering PUK or PUK2 codes.

Battery Life
Lithium-Ion batteries are getting better day by day, but are still far from perfect.
Remember that partial-discharging of the battery followed by charging is better
than fully discharging these batteries. It’s fine to do this once in a while, but
frequent complete discharges will reduce your battery’s life. You also don’t need to
switch off a Lithium-Ion battery-based phone when charging.

You also need to remember that a fully charged battery should be kept in a cool
place, and most definitely not on the car dashboard in the day.
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Sony Ericsson

Z600

Triband

90 x 48 x 27

110

Clamshell

Internal

65,536

128 x 160

4-way

500

SMS, EMS, MMS

2 MB

Polyphonic

Li-Ion (780 mAh)

9

300

T9

15,995

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✔

Siemens

S65

Triband

109 x 48 x 18

98

Bar

Internal

65,536

132 x 176

Joystick

1000

SMS, EMS, MMS

11 MB

Polyphonic

Li-Ion (750 mAh)

5

250

NA

NA

T9

NA

NA

21,000

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✔

✔

Siemens

M65

Triband

109 x 49 x 19

89

Bar

Internal

65,536

132 x 176

4-way

NA

MMS, EMS, SMS

NA

40-chord

Li-Ion (750 mAh)

5.5

300

NA

NA

T9

18,000

✔

✔

✖

✔

✖

✖

✔

✔

✖

✔

✖

✔

✔

✔

✔

✖

✖

✖

✖

✖

✔

✔

Tips and Tricks Handling And Caring For Your Cell Phone

Speakerphone Enables conversation to take place hands-free.
Enhances safety and convenience and can be used to conduct confer-
ence calls. There are two distinct types of two-way speaker-phone
functionality: Half-Duplex and Full-Duplex.
Standby Time The amount of time a battery lasts when a wireless

device is turned on but is not in use. When the phone is switched on
and waiting for a call it is on ‘standby’. A cell phone will consume 
battery power when on standby, but far less than when talking on 
the phone.
Symbian A venture formed by Nokia, Ericsson, Motorola, and Psion to

www.sonyericsson.com www.siemens.com
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BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

CPU Speed (MHz)

CPU Type

Antenna

Screen Colours

Screen Resolution

Navigation

OS

Memory

Memory Expansion Support

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

WAP

Java Support

Bluetooth

Data Cable

GPRS

HSCSD

Infrared Port

PC Sync

Price

Web Site

GSM

Anextek

SP230

Triband

109 x 68.5 x 21.6

158

400 MHz

Intel® PXA255

External

65,536

240 x 320

NA

Pocket PC 2003

64 MB

SD/MMC

Li-Ion (1480 mAh)

5

150

NA

NA

NA

NA

NA

NA

NA

29,500

✔

✔

✖

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

iMate

Pocket PC

Triband

130 x 70 x 19

190

400 MHz

Intel® PXA263 

Internal

65,536

240 x 320

5-way

Pocket PC 2003

128 MB

SD/MMC

Li-Ion (1200 mAh)

3.5

160

NA

NA

NA

39,000

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

Palm

Tungsten W

Triband

122 x 79 x 18

181

33 MHz

Dragonball VZ

External

16-Bit

320 x 320

5-way

Palm OS 4.11

16 MB

SD/MMC

Li-Poly (1500 mAh)

NA

NA

NA

NA

NA

21,999

✔

✔

✔

✔

✖

✖

✖

✖

✔

✖

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

Sony Ericsson

P910

Triband

115 x 57 x 24

150

NA

NA

Internal

65,536

208 x 320

Touchscreen

Symbian OS 7.0

48 MB

MemoryStick Duo

Li-Poly (1260 mAh)

16

480

NA

NA

NA

NA

NA

30,995

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

PDA PHONES

O2

Xda II

Triband

130 x 70 x 19

190

400 MHz

Intel® PXA263 

Internal

65,536

240 x 320

5-way

Pocket PC 2003

128 MB

SD/MMC

Li-Ion (1200 mAh)

NA

NA

NA

NA

NA

35,999

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

create easy to use operating systems for wireless devices and person-
al digital assistants (PDAs). The first operating system is called EPOC.
SyncML An open data synchronisation protocol enabling data syn-
chronization between mobile devices and networked services. SyncML
is a transport, data type, and platform independent technology based

on Extensible Markup Language (XML).
T9 Software inbuilt in wireless phones and PDAs that makes typing
words on a keypad easier. The competitor to T9 is iTAP.
TDMA (Time Division Multiple Access) A family of second-generation
digital wireless technologies (GSM, TDMA, iDEN, PDC and PHS) that

www.anextek.com www.carrierdevices.com www.myxda.com www.palmone.com www.sonyericsson.comwww.motozone.yahoo.co.in
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Motorola 

A760

Dualband

100 x 53 x 21

120

206MHz

NA

NA

Mono

NA

2-way

Linux

32MB

NA

Li-Ion

NA

NA

NA

NA

NA

NA

NA

NA

20,495

✔

✔

✖

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

Motorola 

MPx200

Triband

89 x 48 x 27

118

130 MHz

TI ARM OMAP710

Internal

65,536

176 x 220

Key

Windows Mobile

32 MB

SD/MMC

Li-Ion (850 mAh)

4.25

104

NA

25,295

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖
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AT A GLANCE

BRAND

Model

Network

Dimensions (L x W x D) (mm)

Weight (gms)

Design

Antenna

Screen Colours

Screen Resolution

Navigation

Phonebook Capacity

Messaging (SMS, MMS, EMS)

Memory

Ring Tones

Battery Type

Talk Time (Hrs)

Standby Time (Hrs)

Camera

Video Capture

Flash (Y/N)

FM Radio: (Mono or Stereo)

Loudspeaker

MP3 Player

Push-To-Talk Radio

Alarm Clock

Calculator

Calendar

Email

Mobile Chat

Predictive Text

To-Do List

Ringtone Composer

Voice Recorder

Voice Commands

Java Support

Bluetooth

Data Cable

Infrared Port

PC Sync

Price

Web Site

Kyocera

KX440

Dualmode

114 x 49 x 28

122.2

Bar

External

4,096

104 x 80

NA

NA

SMS, EMS

NA

Polyphonic

NA

3.3

96

NA

NA

NA

NA

NA

NA

NA

eZi

DIALING

NA

NA

NA

NA

NA*

✔

✔

✔

✔

✔

✔

✔

✔

✔

Kyocera

Rave KE434C

Trimode

113 x 48 x 23

100

Bar

External

NA

NA

NA

NA

SMS, EMS

NA

Polyphonic

NA

3.5

180

NA

NA

NA

NA

NA

NA

NA

eZi

DIALING

NA

NA

NA

NA

NA*

✔

✔

✔

✔

✔

✔

✔

✔

✔

Kyocera

Phantom KE414C

Trimode

113 x 48 x 23

100

Bar

External

4,096

104 x 80

NA

NA

SMS, EMS

NA

Polyphonic

NA

3.5

180

NA

NA

NA

NA

NA

NA

NA

NA

eZi

DIALING

NA

NA

NA

NA

NA*

✔

✔

✔

✔

✔

✔

✔

✔

Kyocera

7135

Trimode

101 x 62 x 30

187

Clamshell

External

65,536

160 x 160

NA

NA

SMS, EMS

16 MB

Polyphonic

NA

3.5

160

NA

NA

NA

NA

NA

NA

eZi

NA

NA*

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

Kyocera

KWC 2235 CDMA

Trimode

120 x 48 x 24

123

Bar

External

Mono

NA

NA

200

SMS, EMS

NA

Polyphonic

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

eZi/T9

NA

NA

NA

NA*

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

CDMA

Kyocera

Blade KE424C

Trimode

113 x 48 x 23

100

Bar

External

4,096

104 x 80

NA

200

SMS, EMS

NA

Polyphonic

NA

3.5

180

NA

NA

NA

NA

NA

NA

NA

eZi

DIALING

NA

NA

NA

NA

NA*

✔

✔

✔

✔

✔

✔

✔

✔

✔

Nokia

2280

NA

108 x 50 x 21.5

99

Bar

Internal

Mono

NA

NA

250

SMS, EMS, MMS

NA

Standard

BL-5C (850 mAh)

3.3

192

NA

T9

PC Suite

2,999

✖

✖

✖

✔

✔

✔

✖

✖

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

divides conversations into packets of data according to time. This
allows large amounts of voice and data to be transmitted on the same
frequency. 
Tri-Band A phone capable of operating on three different digital fre-
quencies—900MHz, 1800MHz and 1900MHz.
Voice Activated Dialing A feature that allows a user to dial a phone
number by spoken commands instead of punching numbers in physi-
cally. The feature contributes to convenience as well as safe driving.

VoIP (Voice over Internet Protocol) A technology for transmitting
voice, such as ordinary telephone calls, over the Internet using pack-
et-switched networks. Also called IP telephony.
W3C (World Wide Web Consortium) An international industry consor-
tium founded in 1994 to develop common standards for the World
Wide Web. 
W-CDMA (Wideband Code Division Multiple Access) A third-genera-
tion (3G) wireless technology that supports high-speed data transmis-

www.kyocera.com www.nokia.co.in
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*Available with Tata Indicom
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Nokia

3105

NA

102 x 43 x 22

86

Bar

Internal

4,096

NA

4-way

500

SMS, EMS, MMS

NA

Polyphonic

BL-5C

4

330

NA

NA

NA

NA

NA

NA

NA

NA*

✖

✖

✖

✔

✔

✔

✔

✔

✖

✖

✔

✖

✖

✖

✔

LG

RD2030

800MHz 800 AMPS

109 x 44 x 20

81

Bar

External

Mono

120 x 80

Key

299

NA

32 MB Flash

Polyphonic

Li-Ion (850 mAh)

3

160

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA*

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

LG

RD2130

NA

103 x 43 x 19

80

Bar

Internal

Mono

120×80

NA

250

NA

32 MB Flash

Polyphonic

Li-Ion (850 mAh)

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

3,499

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

LG

RD2230

800 MHz

108 x 43 x 20

85

Bar

External

Mono

NA

Key

299

NA

Na

Polyphonic

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

2,499

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

LG

RD5130

NA

106x44x20

99

NA

NA

65,536

128 x 128

NA

300

NA

64 MB

Polyphonic

Li-Ion (950 mAh)

2.5

140

NA

NA

NA

NA

NA

NA

NA

NA

NA

4,999

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

LG

RD7230

NA

87x43x23

NA

Clamshell

External

262,000

128 x 160

NA

NA

NA

256 MB

Polyphonic

Li-Ion (950 mAh)

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

9,999

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✔

✔

sion (144 Kbps to 2 Mbps), “always-on” data service, and improved
network capacity (more people can use each tower at the same time)
in GSM systems by using CDMA instead of TDMA. 
Wallet A cell phone software application that enables users to make
Internet-type payments via a WAP-browser, where card information is
transferred from the customer to the Internet merchant.
WAP (Wireless Application Protocol) A set of standards that enables
a wireless phone or other mobile device to browse Internet content

optimized for wireless phones. 
Wi-Fi (Wireless Fidelity) The popular term for the 802.11b wireless
Ethernet standard. It has been subsequently upgraded to the 802.11g
standard.
Wireless Internet A technology that enables a wireless device to
access specially formatted Internet content via wireless networks. 
Wireless Local Loop(WLL) Wireless service systems that compete with
or substitute for local wireline phone service.

Samsung

SCH-N356

800 MHz

104 x 42 x 13

80

Bar

Internal

Mono

128 x 64

Key

2000

SMS

NA

Polyphonic

Li-Ion (800 mAh)

2.5

160

NA

NA

NA

NA

NA

NA

NA

NA

NA

NA

2,999

2,999

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

www.nokia.co.in www.lgezbuy.com www.motozone.yahoo.co.in www.samsung.co.in

Motorola

C131

CDMA 1x 800 MHz

112 x 46 x 21.5

90

Bar

Internal

Mono

96 x 64

Key

100

SMS

NA

Standard

NA

3

200

NA

NA

NA

NA

NA

NA

NA

NA*

✖

✖

✖

✔

✔

✖

✔

✔

✖

✖

✖

✖

✖

✖

✖
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Ad

Size matters?

Do you hate carrying a heavy cell

phone in your pocket?

Do you want a colour screen?

Do you yearn to play games,

especially when travelling?

Are you an amateur 

photographer?

Are you a music freak?

Do you like to share your conver-

sations with the family?

Do you travel often to low net-

work areas?

Are you in a cash crunch?

Do you want special services, and

prefer a specific service provider?

Are you buying a new phone only

because your friend has got a 

better one?

Is your phone a fashion 

statement?

Do you want a phone that will

help you make some order out of

the chaos that is your life?

Do you need some simple 

computing capabilities on 

your phone?

Do you want a phone that will

help you stay connected to the

Internet when on the move?

Would you like to be able to

transfer data between your phone

and your PC?

Do you want to record 

conversations with your 

sweetheart/boss/ client?

Are you an SMS junkie?

Do you have hundreds of 

contacts?

Are you constantly on the 

move, and almost never near a

power socket?

Questions to select the 
perfect phone for you

Your Specification Go For...

...Smallest phone

...Lightest phone

...Colour phone

...Gaming phone

...Camera phone

... Inbuilt FM or MP3 player

...Speaker phone

...Phone with a signal booster

...Cheapest phone

...GSM/CDMA

...The phone that has better features

...Stylish phone

...Smart Phone

...PDA phone

...GPRS/WAP enabled phone

...IR/Bluetooth enabled phone

...Voice recorder

...QWERTY type keypad phone

...Large storage capacity

...Long lasting battery

Cellphone Buyers’ Guide l Features Listing
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nformation Technology (IT) has today
become an integral part of governance,
especially in India.  It is viewed as a tool

that will help deliver services, both in the
public and the private sector, to the 
common man.  

E-governance, as a concept, is leveraging IT
to streamline the administrative process—it
involves computerisation of records, facilitating
efficient transactions between various govern-
ment departments, networking offices, and
using Web sites and e-mail to bring administra-
tors closer to people.

In the past decade, e-governance has
emerged a popular buzzword among Indian
politicians and bureaucrats alike. One quasi-Gov-
ernment organisation in Tamil Nadu, has
decided to go the distance, by implementing e-
governance at a micro-level—their office is now
completely paperless and file-transfer takes place
in an electronic format. 

Using a tool titled “e-Administration”,
Chennai-based Electronics Corporation of Tamil
Nadu Ltd (ELCOT), with the help of an Informa-
tion and Communication Technologies (ICT)
organisation called Life-Line to Business
(LL2B.com Pvt Ltd), has introduced a workflow
and document-management process sans phys-
ical movement or use of paper.

ELCOT was designated by the Government of
Tamil Nadu to promote IT industries statewide.

Apart from supporting IT entrepreneurs, it also
promotes joint ventures in electronics, 
communication and IT. They also help develop
infrastructure for the software industry by pro-
viding effective communication backbones and
IT parks. 

LL2B’s “e-Administration” tool allows ELCOT
officials to electronically sanction purchases,
approve official activities and transfer files as
well. All the files processed are made available
on a central server, and the status of pending
files can be obtained at any stage as well. Thus,
the workflow is quite transparent. The only 
documents printed and filed are the final 
order copies.

The Nuts And Bolts
As part of its e-governance initiative, the Gov-
ernment of Tamil Nadu embarked on a paper-
less office drive for introducing transparency
and accountability in its internal and external
transactions.

ELCOT decided to introduce “e-Administra-
tion”—a paperless file-management system,
which ensures speedy disposal of files. The entire
process—creation, movement, monitoring,
and approval of files takes place
electronically, resulting in better
utilisation of manpower. “This
helps avoiding delays, which
leads to better governance,”
according to Sudeep Jain,
(IAS) MD, ELCOT.

I

To many, e-governance and a paperless office are Utopian ideas. Not for the Tamil Nadu government’s IT
Department, which uses software to create a transparent transaction process

IT Cuts Red Tape
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nodes (on an average) connected to it 
as clients. 

Says K Appuswamy, general manager (e-Gov-
ernance), “Many organisations conducted 
trials but only LL2B’s model worked successfully
at ELCOT.”

LL2B.com’s product was one of the three
LAN based solutions tried out—the front-end
was based on Visual Basic while Microsoft
Access running on a Microsoft Windows 2000
server was used as the back-end. This tool was
initially installed in ELCOT’s marketing depart-
ment for about five officers. Seeing its 
efficiency, other officers and staff voluntarily
came forward to use the tool. Once the number
of users increased, the solution was 
upgraded to a browser-based Web version to
eliminate the dependency that existed on
client systems.

Currently, e-Administration connects about
150 users, in three different locations across 25
km, including ELCOT’s corporate office at Nan-
danam, their communication division at
Perungudy, and ELCOT Chairman Vivek Hari-
narain, who is also IT Secretary, Govt of Tamil
Nadu, at the Secretariat, through a dedicated
powerful four-way Xeon dual processor with
RAID facility, running a versatile Oracle 9i
database as backend, on a Linux-based
advanced server, centrally located at the cor-
porate office. 

The tool simplified the process of gener-
ating files and enabled moving note sheets
electronically: instead of physically carrying

120 DIGIT NOVEMBER 2004
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e-Administration is the brainchild of ICT
specialist, VDG Krishnan, founder president,
LL2B.com Pvt Ltd. He has 25 years of manage-
rial experience and has worked in the Indian
public sector as well as in a leading MNC based
in the Americas. He intended to develop a
simple yet effective solution, to enable govern-
ments, corporates, SMEs and NGOs implement
e-governance, in developing countries such as
India.

e-Administration is a Web-enabled, plat-
form-independent, paperless solution devel-
oped on an Open Source platform, for
paperless communication within and outside
an organisation. It uses offerings such as J2EE,
JBOSS and PGSQL.

The tool, according to Krishnan, has reduced
the file approval cycle from an average of two to
three weeks to one week. This has also resulted
in considerable reduction of paper-usage within
an organisation. (See the Digit DVD for a presenta-
tion on LL2B’s e-administration tool)

Krishnan says LL2B’s tool empowers every
employee in the organisation to discharge his or
her duties efficiently. Dependencies on subordi-
nates has also reduced and the organisation is
now more system-oriented than people-centric.
This is likely to result in increased productivity.
Its Linux platform also makes it easy to add local
language content. 

Any organisation that deals with multiple
agencies can use this tool for a simultaneous
review-and-action process. e-Administration
also aids knowledge management and integra-
tion in NGOs, self-assessment, decentralised
field updating and centralised review 
and monitoring.

The Process Involved
ELCOT conducted trials with products 
offered by three SMEs—for independent evalu-
ation, with a view to adopt the best tool. The
SMEs were asked to implement the necessary
customisations, to suit the requirements 
of ELCOT. 

Trials were conducted over three months,
with equal opportunity given to all solutions.
For the purpose of testing, each department
had a system configured as the server and five

Why ELCOT took the plunge
The number of major departments: 4
The average number of files generated per department per
year: 150
The average number of note movements (cycles) per file: 20
The average time taken to generate a note and get 
approval - 4 to 6 days
The average number of physical movement for each cycle: 8

The total number of manual entries / file movement from 
desk-to-desk per year: 4x150x20x8 = 96,000 manual 
entries or file movements per year.
The workload is not evenly distributed as it depends on a

hierarchy to grant sanction and/or approve files. The
Managing Director (MD) typically has to view and approve
approximately 200 files per week. That is an average of 40
files per working day! This is apart from the various
meetings he has to attend. Files pile up when he is on tour

and he is forced to carry work home. Files are kept pending
while the office is away. The officer may not even know that
there are files pending, even if they are urgent. These
problems cause inordinate delays in the workflow process.
A tool such as e-Administration ensures prompt disposal of
files and access to a central database, where the status of
files can be monitored at every stage, thus ensuring
efficiency and transparency. 

Sudeep Jain, MD, ELCOT confirms that the implementation
of the electronic system has brought down the average file
approval cycle to five to seven days. Earlier on, the process
took 15 to 21 days.

The biggest
advantage of ‘e-
Administration’ is
that it enables us
to view, at any
stage, the status of
a pending file  
K Appuswamy
General Manager, e-
Governance, Tamil Nadu

Source: ‘E-ADMINISTRATION THE KEY FOR E-GOVERNANCE - INITIATIVES FOR CREATING A
PAPERLESS OFFICE’, by Sudeep Jain, IAS, Managing Director, ELCOT, Chennai-35, presented
at the 7th National e-Gov Conference in Nov 2003, conducted by the Department of
Administrative Reforms and Public Grievances, Ministry of Personnel, Public Grievances and
Pension, Govt. of India.

The e-Administration tool is accessed via a browser
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note sheets for approval, from table to table,
the employees used the tool. Pop-up alert 
messages acknowledged the receipt of 
the e-document.

All letters received from external agencies are
now scanned and converted into electronic docu-
ments, which are then added to the repository on
the LAN. This system enables a user to check the
status of a file, at any stage. More importantly,
delays are minimised as the files can be traced
over the LAN—employees can now know which
officer has kept the file pending.

“The biggest advantage of e-Administration
is that it enables us to view, at any stage, the
status of pending file. The details are available
on a central server and can be accessed by
anyone. This way, workflow is simplified,” says
Appuswamy.

LL2B’s e-Administration tool not only effects
a dramatic reduction of stationery usage, and
time taken to process documents, it also serves
to introduce transparency in the working of any
organisation.

ELCOT employees also took to the system
rather well. Says Appuswamy, “Our employees
became more and more comfortable with using
the tool as the trials progressed. It’s quite user-
friendly and doesn’t require a lot of technical
expertise. I myself began using the system
without any formal training, and have been
using it successfully for eight months now.” 

The Accolades Have Been Coming
At the 7th National e-Gov conference held in
Chennai in November 2003, ELCOT received a
merit citation award from the Government of
India, for implementation of e-Administration
as a tool for e-Governance. 

The Industrial Guidance Bureau of the Gov-
ernment of Pondicherry has implemented an
integrated e-Platform, a quickly customised
solution of  ‘e-Administration’, to automate the
activities of the Directorate of Industries and
Commerce.  Being attempted for the first time
in India, 21 departments—including munici-

palities and panchayats are connected on a
simple dial-up. The central repository server is
located at the District Industries Centre,
Pondicherry. All this forms a dedicated elec-
tronic network. that allows the Government to
grant permission, for example to set up an
industry; it can also help a manufacturing unit
obtain a licence to commence production,
among other things.

Says Krishnan, “This will save a lot of time,
effort and cost to industrialists and citizens as
well as officials of various departments. 
As opposed to submitting 10 copies of docu-
ments in the manual system, the electronic
system, only needs one signed copy to be sub-
mitted, thereby helping save paper. It can help to
fuel investment in the State and generate
employment for local people.”

Various Central and State Government
departments and undertakings including the
Andhra Pradesh Technology Services, the Gov-
ernments of West Bengal, Orissa, Manipur, Goa

etc. State Bank of India, the Canadian Consulate
in Chennai, British Trade Office (Bangalore), Min-
istry of Industrial Development, Malaysia and
the State of Sarawak, Malaysia have shown
interest in implementing e-Administration. 

Far from  resting on their laurels, LL2B plans
to reach out to the various Government Depart-
ments as well as corporates, SMEs and NGOs by
offering the basic solution for free and charging
only for customisation, installation, training,
annual maintenance and upgrade support, either
directly or through ELCOT, with whom LL2B has
a marketing tie-up. This is expected to benefit Gov-
ernments in India and the developing world, by
saving on e-Governance expenditure. “We are cur-
rently holding discussions with the Chennai Met-
ropolitan Development Authority and The Tamil
Nadu Dr. MGR Medical University, to implement
‘e-Administration’ in their offices or institutions
across the city,” says Krishnan.

ELCOT has received the mandate from the
Tamil Nadu Government, to implement LL2B’s
solution in as many offices as possible in the
state, with a view to reduce as many bottlenecks
as possible in the administrative machinery.

While it’s naïve to believe that paperless office
solutions like LL2B’s, may just be the panacea for
our red-tape ridden bureaucracy, it certainly is a
step in the right direction.

meera_vankipuram@thinkdigit.com

[The tool is] likely
to save a lot of
time, effort and
cost to
industrialists and
citizens as well as
officials of various
Departments
VDG Krishnan
Life-Line to Business
(LL2B.com) Pvt. Ltd

How e-Administration works

e-Administration can transparently prioritise  a task

At the most basic level, 
e-Administration is a paperless solution
for managing files. It digitises scanned
papers and worksheets, and stores the
digital files on a central server. The files
can then be accessed from a Web 
interface using any Web browser
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One of the most imperative choices you will make
for your company is deciding its printing solution.
We help you make an informed decision

Laser-SharpLaser-Sharp
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rinting solutions offer too much of a
good thing—with options galore, the
trick lies in choosing the best one for

your business. The entry of colour laser printers
has further enriched choice. Is the marriage of
colour with the speed of a laser solution a fruit-
ful one? We try to find out. To make things even
more interesting, we also test some inkjet print-
ers meant for business use.

The Printers
Printing solutions have evolved a great deal from
the dot-matrix technology of past. A 
dot-matrix is a low-cost, low-maintenance solu-
tion for sure, but due to noisy operation and sub-
par print quality, it is rarely seen outside
accounts departments.

Inkjets and lasers have moved on to become
the preferred choice for almost all office
departments. Inkjets offer superb colour 
resolution but do not print as sharp as a laser
printer does—the output tends to bleed and
smudge. Lasers, on the other hand, provide
sharp printouts, but until not long ago, they
simply lacked colour.

Companies therefore had inkjets for colour
printing and lasers for black and white printing.
There was one problem though—inkjets were
proving to be a costly affair compared to laser
printers. For perspective, consider that the accu-
mulative cost incurred upon replacing the third
successive ink cartridge surpasses the initial cost
of the inkjet printer.

However, advertisers, design houses, and
people in marketing departments  had no option
but to use inkjets for printing in colour.

Colour lasers were introduced a year ago in
India, but they were simply too expensive as an
option. As with many technologies, the price of
lasers has come down to a level where they
become a viable solution to small business

houses. Today, most colour lasers fall in the
range of Rs 34,000 to Rs 50,000. 

Further evolution has seen colour lasers shed
their weight and lose their bulk in favour of a
slimmer profile. The new breed of colour lasers
can match mono lasers in speed, and are a little
more expensive then their black and white
counterparts. Older colour lasers took each docu-
ment through four passes, one for each colour,
which slowed them down. Now, a paper goes
through just a single pass. 

Though the new breed is classified as “laser”
solutions, the underlying technology has
changed, making them more compact and less
expensive. Instead of a laser, these new printers
have an array of LEDs that writes on the OPC-the
organic photoconductive drum, the heart of a
laser printer.

For this test we had colour lasers from the
five top vendors: Canon, HP, Lexmark, Samsung
and Wipro, with one model each. Xerox does
have a model but we were not able to procure it
on time for the test. 

Along with these laser colour printers, we
also tell you about some inkjet printers fresh out
of the stables with unique features, strutting as
business solutions. This mix of lasers and inkjets
will give you a comprehensive look at available
options for your business.   

P
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Our test-bed comprised an Intel Pentium
4 3.2 GHz processor plugged on to an

Intel 875PBZ motherboard, with 512 MB of
Corsair 400 MHz DDR SDRAM, an MSI
Ti4800 display card and a 40 GB, 7,200
RPM, ATA IV Seagate Barracuda hard drive. 

We used Microsoft Windows XP with
SP1 as the operating system, with the latest
chipset and graphics drivers. The USB
patch for Windows XP was installed, too,
and the devices were connected on the USB
2.0 port for optimum performance. We
used 100 gsm (gsm is grams per square
metre—this measures the paper thickness)
paper for the tests, except for the drain
test, were we used 75 gsm papers. For
photograph printing, we used NovaJet’s 130
gsm inkjet photo paper across all the
printers, since they are widely available
across the country.

All the printers were tested on the

same test suite, which comprised a text
document, a combi-document, a
continuous document and an image file.
The test files were chosen to reproduce
every possible printing scenario.

The combi-document has many
sections, with text of varying point sizes,
lines drawn in a circle, seven coloured bars
of decreasing colour gradients, and a small
picture at one corner. Each of these
subsections tests the printer’s ability to
reproduce detail. The varying text point
size tests a printer’s ability to reproduce
the smallest possible text—the spatial
resolution of the printer. The circle of lines
tests a printer’s ability to reproduce lines
without jarring at the edges. Similarly, the
seven-colour bar tests the colour
reproduction capabilities of the printer’s
cartridges.

The continuous document is a 

small report with bar graphs, pie charts,
line graphs, images and text, all spread
over six pages. This reproduces real-world
usage.

The image document is made up of
several elements with varying contrast and
brightness areas. This document tests a
printer’s colour reproduction capability on
photo paper.

The text and the combi-document file
were printed at Normal and Best quality
settings, and the image file was printed at
the Best setting.

Scores granted to Features, Build
Quality, Performance and Price were given
weightages. An overall score out of 100
was then calculated. The product that
scored the highest was adjudged the
winner of the Digit Best Buy Gold award for
its category. The runner-up was awarded
the Digit Best Buy Silver award.

How We Tested

The Canon LBP-2410
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Canon sent us their Laser Shot LBP 2410,
while HP turned up with the LaserJet 2550L.
Both printers use the same internal technology,
which has the colour toners mounted on a rotat-
ing carousel. Lexmark sent us their C510,
Samsung sent in their Ace CLP 500, and Wipro
turned up with the 4160 model. 

The Features
Printers are often defined by the resolution they
support. The Canon, HP and Wipro are rated to
provide 600 x 600 native resolutions. This is the
native resolution, but you will often find the
interpolated resolution mentioned at over 2,400
dpi. Samsung’s CLP-500 is rated at 1,200 dpi,
whereas Lexmark rates their C510 at 2,400 dpi;
these are interpolated resolutions. These
numbers are often misleading and should not
be considered as yardsticks to support your
buying decision-we recommend that you take
test prints before a purchase.

The interface that connects a printer to a PC
or network is of the utmost importance and
should not be overlooked. Most laser printers
now support the widely popular USB standard. A
printer with an inbuilt Ethernet adapter is also
a good thing. 

Canon’s LBP-2410 comes with just a USB 2.0
port and an optional network adapter that you
can later upgrade to. HP’s LaserJet 2550L and 
Lexmark’s C510 provide a Parallel and a USB 2.0
port for PC connectivity; they, too, have the
option of adding an Ethernet card later on.
Wipro’s 4160 colour laser printer was the only
one with the slower USB 1.1 interface. It does
provide a Parallel and an optional Ethernet
adapter port for later upgradation. 

The Samsung CLP-500 comes with the usual
Parallel and USB 2.0 interface, and the Ethernet
adapter is optional. However, Samsung has gone
one step forward, and has provided optional
capability for wireless 802.11b connectivity—a
boon for laptops users.

Onboard memory is an important element
to consider. To speed up the print process, more

memory always helps—it reduces hard disk
access and spooling.

The Samsung CLP-500 and the HP LaserJet
2550L had 64 MB of onboard memory, which can
be upgraded to 192 MB. The Lexmark C510, with
64 MB, offers additional room for up to 320 MB.
Canon’s LBP-2410 has 8 MB of onboard memory,
but it uses Canon’s proprietary technology—
CAPT: Canon Advanced Printing Technology,
which permits the printer to use system memory
for spooling a print job. This, according to
Canon, speeds up data processing, but only if
your system has a faster CPU and a decent
amount of RAM. 

The most common problem with a shared
resource, such as a printer is the inability to
know how much stationery is available on the
printer, before you fire a print request. You thus
get irritating “Out of paper” lights blinking at
you, instead of the expected printout. Hence,
consider paper capacity when you buy a new
printer, especially if you expect heavy demands
to be placed on the device. 

Lexmark’s C510 and Samsung’s CLP-500 have
deep paper trays that can hold 250 paper sheets,
followed by the Wipro, which can hold 200
sheets. The Canon and the HP hold 125 sheets
each. For additional paper requirements, the
Samsung provides an optional 500-sheet paper
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New Canon inkjets For Business Use 

Canon recently introduced the Pixma
range of printers, and we received

two of them—the iP3000 and iP4000.
They sport revolutionary design—they are
appealing, compact and haven’t
compromised on performance or
features. 

The iP3000 has four separate ink
tanks, whereas the iP4000 has five
separate ink tanks. That’s the
basic difference, apart from the
speed ratings. 

Both these printers
are PictBridge-
compliant, so it is
possible to print directly
from a digital camera.

Duplex printing
support is native on

both printers, and is a boon in
business environments—duplex
printing saves on paper. It not
only reduces costs, it also
takes care of your
responsibility towards the
environment.

One feature that Canon
has been pushing hard over
the last two generations of

printers is CD-R
printing support—it allows you to
print a CD face directly on a CD.
This feature is useful for people
who market material via CD-Rs.

Both the iP3000 and the
iP4000 have a dual paper

feeding mechanism—one via a
paper cassette, and the other via a

top-loading sheet feeder.
During our tests, we did not
come across any paper jams
or multiple sheet pickups. 

The Pixma iP4000
turned out to be the fastest
inkjet we have seen thus far,

while the iP3000 is
marginally slower. In terms of
quality, they live up to the
expectations when it comes to

text as well as complex documents with
charts and line graphs. Photo printing is
deceptively good for these printers;
however, for best results, you will need
to use the recommended media. Sensibly
priced at Rs 6,600 and Rs 7,000
respectively, the IP3000 and the IP4000
are good buys. The Canon Pixma IP3000

The Canon Pixma IP4000

The Wipro 4160
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cassette, while the HP, Canon and Lexmark offer
an optional 250-sheet cassette.

Duplex printing allows you to print on both
sides of the page without having to manually
turn the paper around. This feature can save a lot
of paper, which is always a good thing.
Samsung’s CLP-500 was the only printer to offer
duplex printing. Lexmark offers it as an optional
unit, and we recommend buying one. 

The drivers that came with the printers were
thorough in their ability to set printer parame-
ters and tweak options. The Wipro 4160 has some
catching up to do when it comes to the driver
interface.

Aesthetically, HP’s LaserJet 2550L looks
better than the rest. The Samsung CLP-500
sports a distinct design, while Canon and
Lexmark have styled their printers in the clas-
sic manner—boxy! The Wipro 4610 is a design

mystery—the front of the unit cannot be

A Look At Available A3 Printers

A3 printers have their own niche. They find customers in design houses,
architecture firms, publishing firms, etc. Every printer vendor has at least one
A3 model in their portfolio. We tested the latest from Canon—the i9550.

Canon’s i9550 is a top-of-the-line A3 model. Being an A3, the printer takes
up lots of desk space. Canon has fitted it with foldable paper feeders and
output trays to decrease the footprint. Build quality 
is top-notch, and despite a heavy use of plastic, the printer shows no flimsiness 
in its design.

The key highlight of the i9550 is its eight-cartridge system. It is an
optimised photo-printing device capable of 4800 x 2400 dpi. In our tests, it
proved to be an excellent solution, reproducing finer details especially well—
thin lines were drawn with a minimum of jaggedness, for example. Similarly,
when it comes to colour reproduction, it is quite accurate, and the output is
vibrant.

The i9550 also offers CD-R printing, for printing those promotional CD
faces. It can be interfaced using USB 2.0 or the FireWire port and is 
PictBridge-complaint.

A3 printers can cost as little as Rs 20,000, but for the features and print
quality of the i9550, you will have to pay Rs 34,500.

differentiated from the back; the overall design
leaves one frustrated.

To conclude, the Samsung CLP-500 provides
more features than most in this league. It was
closely followed by Lexmark’s C510. The HP and
Wipro are on par on the features front.

The Performance
To evaluate the performance of these colourful
beasts, we adhered to the same benchmarking
procedure that we used to evaluate inkjets.
Performance evaluation was done on two
parameters, speed and quality. 

In Terms of Speed
Ideally, the time taken by each of these printers
should not show much variation, but that was
not the case. In the text printout test, at the
normal setting, Samsung’s CLP-500 finished in
13 seconds, while the Lexmark was hot on its
heels at 14 seconds. Wipro, at 15 seconds, came
in third. The Canon and HP were left behind at
18 and 28 seconds respectively. 

The HP, Canon and Wipro have a different
setup of colour toners as opposed to the Lexmark
and Samsung, which could be a reason for the
speed difference.

Score Board

Canon
LBP 2410
8.98
600
No / 2.0 / Optional 
8 MB / CAPT
125
250
No 
36.78

18
32
104
41
13

3.5
3.1
2.9
12.00
49,995
57.76

BRAND
Model
Features
Resolution
Interface ( Parallel / USB / Ethernet )
Input buffer ( Installed / Expandable )
Paper capacity (Pages)
Optional Tray support
Dual-side printing support
Performance
Speed 
Text Document ( Seconds )
Combi-Document ( Seconds )
Continous Document ( Seconds )
Photograph  ( Seconds )
PPM ( Seconds )
Quality 
Text ( Scale of 5 )
Combi-Document ( Scale of 5 )
Photograph ( Scale of 5 )
Price Index
Price (Rupees)
Overall Score (Out of 100)

HP
Laserjet 2550
10.00
600
Yes / 2.0 / Optional 
64 MB / 192 MB
125
250
No
33.21

27
52
124
160
12

3.5
3.6
3.0
17.14
34,999
60.36

Wipro 
4160
9.24
600
Yes / 1.1 / Optional 
32 MB / NA
200
NA
Optional 
36.90

14
38
105
60
13

3.5
3.3
3.0
18.19
32,990
64.33

Samsung 
CLP 500
13.26
1200
Yes / 2.0 / Optional 
64 MB / 192 MB
250
500
Yes
38.01

18
36
82
48
15

3.5
3.0
2.9
15.00
39,990
66.27

Lexmark 
C510
12.70
2400
Yes / 2.0 / Optional
64 MB / 320 MB
250
250
Optional 
39.02

14
68
60
156
24

3.5
3.3
2.9
14.63
41,000
66.35

The HP Laserjet 2550
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In the Lexmark and Samsung, the toner cartridges are lined
up vertically, over which the paper passes, whereas in the HP,
Canon and Wipro, the toner cartridges are mounted on a rotat-
ing carousel, and move to apply the specified colour on the
paper. This results in added time to complete the same task.

In the text printout, under Best mode, all the printers,
except for the Samsung CLP-500, returned the same time.
Samsung came out on tops here.

In printing the point-size document, the results remained
the same; the Samsung CLP-500 came out tops, followed by
the Lexmark C510. Wipro did well, keeping ahead of the HP
and Canon printers.

The results of the combi-document test were interest-
ing: the document is heavy in terms of colourful graphical
elements, and hence taxes most printers to the max. It also
does a fair job of emulating real-world printing scenarios.
The Samsung was the fastest with 24 seconds—25 per cent
faster than the runner-up, the Canon LBP-2410, which
clocked 32 seconds. Canon’s CAPT technology works in its
favour here.

The Lexmark took the longest time, a result that was
repeated in tests where we used large or complex documents.
The reason is the slow spooling-time; once a document is
spooled, the C510 from Lexmark is a firecracker. HP’s Laser-
Jet 2550L was marginally faster than the C510.

When we printed the combi-document in Best mode, the
Samsung lost the top slot by a small margin to Canon’s steady-
performing LBP-2410. The other printers followed with simi-
lar times, to complete the job.

The Business Behemoth

Alook at HP’s 2300 DTN ought to change your perception
of a business printer. This giant means business and is

designed to reflect that attitude—from its core components
to its looks. 

The 2300 DTN has separate ink tanks and replaceable
print heads. The ink tanks by themselves are voluminous
compared to those on other HP models, and models from
other vendors.

Paper capacity is humongous, and apart from the
inbuilt paper tray, HP provides an additional paper
cassette. In total, 650 sheets can be fed into this giant at

once. Duplex printing is a welcome
feature. The 2300

DTN comes with 64
MB of onboard
memory,
upgradeable to
320 MB.

The 2300 DTN
has both a Parallel

and a USB 2.0 port.
For hooking it up on

your internal LAN, it has
a JetDirect internal print

server, which is easy to install.
The printer is not the fastest. On an average, it takes

four seconds more than the Canon Pixma iP4000, which is
the fastest printer we tested this time. As for quality, the
output is not very good; HP’s DJ-5652 inkjet has far
superior print quality and costs five times less.

The 2300 DTN will set you back by Rs 50,000. It is
worth noting that the printer is a relatively old model. We
would advise that you evaluate this printer more carefully,
keeping in mind that the HP 2550L laser printer might
make more purchase sense for your organisation.

1/2 pg V AD

The HP 2300 DTN
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To tax the printers further, we printed a
report with graphs, photos and text. Lexmark’s
C510 took the top slot, and was followed by
Samsung’s CLP-500. Lexmark was 50 per cent
faster than the slowest printer, the HP LaserJet
2550L, in this particular test.

Our final test was the high-resolution photo-
graph printout; this test would clearly crown the
colour-printing king. We used a 37 MB file—large
enough to test a printer’s onboard memory
performance. 

As expected, Canon’s LBP-2410 came out tops,
taking only 41 seconds. The reason for this is
simple—the Canon uses CAPT, which does data
processing using the PC. The better the PC, the
faster the printouts. Samsung’s CLP-500 should
be lauded for its equally good speed, and as was
the case earlier, the Lexmark lost out due to its
high spooling time. The Wipro took 60 seconds
and was third-best.

When it comes to pages printed per minute
(called PPM), the Lexmark C510, at 24 PPM, was
the fastest of them all, followed by the Samsung
CLP-500 at 15 PPM.

To conclude, Samsung’s CLP-500 finished
most of the tests fastest. Lexmark’s C510, on the
other hand, is much faster for small loads, but as
the file size increases, the spooling times goes
through the roof and slows down overall printing
speed. The Canon and Wipro tied for third place.

The Printout Quality
While HP’s LaserJet 2550L was never up there in
terms of speed, it did produce some quality
printouts to make up for lost ground. 

In the combi-document, it reproduced the
finer details perfectly, without distortion.
Colour differentiation was perfect, and the
range of seven colours in the combi-document
was reproduced perfectly. Yellow text on a black

background tests the contrast level, and this
was crystal clear. All this put the HP 2550L
ahead of others in the quality comparison.
Wipro’s 4160 came in third, closely followed by
the Lexmark C510.

The Samsung CLP-500, to some extent, sacri-
fices quality at the expense of speed. Graininess
was visible where there was colour gradation, as
with background colour. Colour shades were
also lighter than normal. All this resulted in
lower scores.

When we printed photographs, all the print-
ers failed to match the results from an inkjet
printer. The printed photographs completely
lacked the vibrancy of colour. This is one area
where inkjets score over colour laser printers.
Amongst this bunch of lasers, HP produced the
best photographs, but even these were not of
acceptable quality. 

Thus, although colour lasers have come of
age, they fall behind when it comes to printing

photographs. Your best bet for photographs

would be photo-printers for professional require-
ments. However, most inkjets meant for desktop
use, will do a good job at printing photographs
for casual use.

Putting It Together
To summarise, the Samsung CLP-500 wins on
features, followed closely by Lexmark’s C510. On
the performance scale, Lexmark’s C510 is a hairs-
breadth away from Samsung’s CLP-500. However,
it should be noted that as far as quality goes,
Lexmark’s C510 is much better than Samsung’s
CLP-500. However, HP’s LaserJet 2550L is undoubt-
edly the best when it comes to quality of printout.
Wipro and Canon are pretty much on par, both in
terms of speed and quality of output.

Insert price into the equation, and the Wipro
4160 is the cheapest colour laser. However,
Lexmark’s C510 and the Samsung fight it out for
the crown. Considering the Lexmark’s good
speeds and marginally better output quality, we
award it the Best Buy Gold award. 

The Samsung CLP-500, with its future-proof
feature set and decent performance, is a good
buy, and wins our Best Buy Silver award. 

HP and Canon have some catching up to do
with the competition. 

sanket_naik@thinkdigit.com

Telephone E-mailCompany Web siteBrand

Contact Sheet

Canon 
HP
Lexmark
Samsung 

Wipro 

Canon India Ltd
Hewlett Packard India Ltd
Lexmark International (I) P. Ltd
Samsung Electronics India
Information &
Telecommunication Ltd
WeP peripherals

011-26806572
0124-2906283
022-26057755/45
011-51511234

080-22270359/
22270360

rajeev.singh@canon.co.in
saranya.rustogi@hp.com
sandeepk@lexmark.com
farrukh_quazi@samsung
india.com

helpdesk@wepindia.com

www.canon.co.in
www.hp.com
www.lexmark.com
www.samsung.com

www.wepindia.com
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he season of festivities is here.
With Diwali, Id, Weddings,
Christmas, New year forming

the integral element of calendar for
the forthcoming days, needless to say-
the celebrations will be galore! 

It's a time to create memories and
also time to preserve those precious
memories. Thankfully, with the
advent of digital cameras, you don't
have to wait for a roll to finish or
print all images. Save what you like
and delete what you don't. Double up
your digital camera with a worthy
photoprinter- and you have your very
personal photolab. So cut out the
waiting time, cut out the inconven-

ience of going to
some obscure lab to
develop the photo-
graphs and share
instant pictures with
your loved ones. Get
ready for the revolu-
tion in photo solu-
tions- get ready for
DIGITAL PHOTO-
ISM.

At the forefront of
this revolution is
Canon- the leading
manufacturer of digital cameras
and photo-printers which offers
complete digital photography solu-
tions and hence is a force to reckon
with in this arena. This concept of
digital photoism can succinctly  be
explained in three simple steps of
SHOOT the picture with a digital
camera, CONNECT the digital camera
to the photoprinter, fire the PRINT
command and share the stunningly
beautiful pictures with your loved
ones instantly. So now you can print
still images from your digital camera/
camcorder, camera phones at the click
of a button.

To share some industry statistics,
the current year is the boom year for
digital imaging and companies have
been really focused on driving the
outcome from this trend which will

be the emergence of a new culture -
the personal printing culture. One
out of every three people who own a
PC will buy a printer. The PC market
is approx 30 lacs and the market for
inkjet printer in India is 8 lacs. The
printer attachment ratio will increase
with expanding digital camera oppor-
tunity and mobile camera phone
booming market.

Talking about Canon, its impres-
sive product lineup aims at encourag-
ing the "Print-it-yourself" culture. In
a photo workflow, the camera cost
accounts for just 11%, film and print-
ing take up the rest 89%. Canon's new
digital cameras are powered by
Canon's DiG!C image processor chip
and equipped with its world-
renowned lenses for the capturing of
sharp and true-to-life images. These

Shoot And Print Like A Pro 

T

Digital Photoism
CCaannoonn PPrreesseennttss



print photos directly with Canon's
PictBridge-enabled printers, mul-
tifunctional machines without
PC, that produce stunning images
that rival studio photos in sharp-
ness, color and fade resistance
(archival quality of 100 years when
printed on Canon Photo Paper Pro
and with BCI-6C ink cartridge).

To be at the helm of the digital
photoism revolution, all you need is
the right Digital camera and the
right photo-printer but choosing the
same could be a tedious task with
plethora of options available. In our
endeavour to give our readers infor-
mation that they can use, here are
some handy snippets:

Choosing your right Camera

The most crucial aspect is under-
standing your level of usage. If you
are a professional- look for the lat-
est, feature equipped, heavy-duty
SLR cameras with effective
megapixel rating for high-precision,
high-speed performance. But if you
are a beginner or an occasional user,
investing in high-end cameras
might not be a very good idea. You
would probably be better off choos-
ing an entry-level fixed-lens cam-

era. A mid-
range camera,
on the other
hand, could
be a good
buy for occa-
sional pho-

tography like
travel and outdoor sports. 
Choosing the right digital camera is
really all about getting one that fits
your lifestyle. It doesn't have to be
equipped with the best features or
has to be the coolest design. Rather,
it should be one that fits your budg-
et and feels right in your hands.

Broadly, there are three kinds of cam-
era buyers and once you identify
your type, everything else becomes
relatively easy.
Budget Buyer: If you are buying a
digital camera for the first time,
have a limited budget, looking for a
camera without a lot of fussy fea-
tures and just want a unit for the
occasional photo mement, then the
minimum specifications you can
look for:
Recommended resolution: 2
megapixels 
Minimum Storage: 16MB
Extras: Video recording with audio 
Home shutterbug: You might be
looking for a digital camera that's
stylish but won't break the bank or
looking for one that can capture
great pictures for family album or
you need one camera with audio
and video recording/playback to
share with family and friends. So
here's the specification you can 
opt for:
Recommended resolution: 2
megapixels 
Minimum Storage: 32 MB
Extras: Direct connectivity to print-
ers, 2x optical zoom
Traveller: Whether it's a three-day
trek in Malaysia or a three-week tour
of Europe, the camera you bring
along should be compact enough to
slip into your bag or backpack. Yet, it
should be sufficiently rugged to
withstand the bumps and knocks
you are likely to encounter on the
road. A vacation camera should be
equipped with a good set of point-
and-shoot features for those candid
spur-of-the-moment shoots. Last
but not the least, a good vacation
camera is with great battery life and
sufficient memory. The minimum
specs:
Recommended resolution: 3
megapixels 

Minimum Storage: 64 MB
Extras: Additional Battery and
Memory Card, Pouch, Optical Zoom
lens.
Business User: Do you wish to
spend more money for an advanced
camera? Is style less important than
high-end features and resolution? Is
superior battery life high on your
wish list? If you find yourself asking
these questions then here's the min-
imum specs you should take into
consideration:
Recommended resolution: 4
megapixels 
Minimum Storage: 64 MB
Extras: Built-in microphones and
speakers, Camera Case, 3x optical
zoom, hotshoe for flash unit.

Printing your Photos

Photography isn't just about shoot-
ing nice portraits and beautiful
sceneries. Many camera users agree
that the most gratifying experience
is printing their own pictures and
those of loved ones. In fact, one of

● Paint a mental image of the scene. This
will help you decide what you should
include in the frame while composing.
● Play with depth-of-field and aperture
settings on the camera. This will add some
zing to the picture. Since this is a digital
camera, experimenting does not cost a
thing! 
● Colours should be bright and should
depict contrasts.  
● While shooting motion at night, say
crackers during Diwali, ensure that the
exposure is timed right. Again try a few
settings before you get it right. 
● Decide the width of picture you are
going to click. Prepare a mental list of how
many elements you want to capture in the
picture.

Tips for Better Photography
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While Canon has always been on the forefront of cutting-edge
technologies, the PIXMA range of printers taps on Canon's
'Photo DNA' that comprises of three kinds of DNA. EOS Digital
Camera DNA with 70 years of know-how in professional photo
composition and capture, has been passed down, resulting in
excellent photo printing quality. The Bubble Jet Printing DNA
contributes to the engineering of PIXMA's exclusive FINE high
performance print-head. Finally, imageRUNNER Copier DNA
in efficient document handliing has been incorporated into
PIXMA providing great printing versatility. 
This series has nine printers of different capabilities and
strengths to satisfy you at any height of requirement. The
Canon PIXMA iP5000 printer offers you 25/17 ppm (mono-

chrome/color) speed as well as 9600 dpi resolution. If
you need more accurate colors than average offer
of 5 Think Tanks, then PIXMA iP8500 offers you
8 individual Think Tanks to satisfy you at low-
est running cost. If you wish to employ this
technology at your work place but confused
about connectivity then rest assured. Canon
PIXMA iP4000R has an answer to this ques-
tion also. It is Wi-Fi (802.11 g/b) enabled for
high-speed wireless network. But photo-printing is not the only
thing PIXMA printers excel in. You get equally good text prints
as well, thanks to this fantastic photoprinter range from
Canon.

The Pixma Difference

the fun things about digital photogra-
phy is printing photos. It's simple,
convenient and you can do it right in
the comfort of home or the office.
Decisions like choosing the right
printer to the right image format, can
affect how the final print turns out.

Choosing the right printer
When looking for a photo printer,
your decision will most likely come
down to buying a dye-sublimation
printer (dot-free printing) or an inkjet
printer. However there's a new con-
tender: The Camera-Direct Photo-
Printer. 

With the 'PictBridge' open indus-
try standard, the recent breed allows
you to connect directly to a digital
camera or read off a memory card
thereby comepletely bypassing the
need of a personal computer. The
PictBridge technology enables the
image from a PictBridge compliant
Canon digital camera to be printed
out directly by a PictBridge compliant
Canon photo-printer This technology
is for those who are daunted by PCs,
and for digital photographers who
plan to print a lot of photos quickly
and easily. All it takes is 3 easy steps
for you to see your photo prints:

1. Shoot: Canon's digital cameras
are not only incredibly stylish, but
also smart and user friendly. On fully
automatic mode, all you have to do is
point, shoot and let your camera han-
dle the rest Pictures are stored in a
memory card, and can be reused again
and again, saving you the cost of buy-
ing film.

2. Connect: Simply connect your
Canon digital camera to a Canon
direct printer and select the image
and size you want on the camera. 

3. Print: Hit the 'Print' command
and there you have it. Beautiful photo
prints of professional quality right
before your eyes. 

Relive every Memorable moment
with Photo Printers
No matter what the occasion is, you
will always have memories to cherish.
And what better way to print your
favorite shots than with Canon's lat-
est range of printers called "PIXMA".
These printers not only possess the
most headturning looks, but also
stunning features never before found
in printers. 

Now you can enjoy up to A4 size
borderless photos for a fraction of the
cost you would incur should you get

your prints developed in a profession-
al lab, credit goes to the new Canon
range of photo printers- PIXMA.
These amazing printers come with 2
way paper feeding facility, auto
duplex borderless photo printing and
can print on CDs and DVDs as well.
They have the ability to give high-res-
olution prints with Canon's FINE
high-performance prin- head, and are
equipped with many features like Easy
Photo Print that can enhance your
print. With PIXMA range of photo
printers you can brighten up the face
of your kid in the photograph, make
your wife's skin look flawless with
blemish remover feature and so on.

The Total Printing Solution -
Digital Photoism

In a nutshell this is the complete dig-
ital solution from image capture to
image output. You shoot your own
photos, so why not print them your-
self with Camera Direct? Its yet
another way Canon is making your
Digital life simpler. And given that
Canon is an expert in both fields you
can be sure that whatever Canon
comes up with next, is sure to turn
heads again.

Advertorial
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How A VoIP

Digital Voice
Your voice is first
converted into
digital signals, which
will be transmitted
over the Internet

Voice As Net Packets
Your digital voice in
transmitted as small
packets of information,
seen here as envelopes

Calling An IP Address
The number dialled is
converted into an IP
address by your phone

An IP phone uses the Internet to
transmit voice data between two
persons. This is what happens
behind the scenes
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Phone Works
Mailing Your Voice
Each voice “envelope”
contains your digital
voice, with the IP
address of the
destination number on
the outside

Call Placed
Your voice envelopes
traverse the Internet
from router to router,
finally reaching the
destination IP

Call Reception
The receiver’s
instrument extracts
your digitised voice
from the envelopes,
converting it into an
analog signal

Text Ahmed Sheikh Infogrphic Solomon Lewis
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Corporate Services That Work
Vikram Doshi, managing director, ATCO Tech-
nologies, Mumbai, puts things in perspective. In
his opinion, a corporate mobile service is an indis-
pensable tool for decision makers. Says he, “I am
connected 24 hours. Right now, I cannot imagine
existence without it.”

Most mobile service operators in India recog-
nise the way Small and Medium Enterprises sector
in India needs mobile services. Most of them there-
fore, have a similar way of approaching customers. 

Tata Indicom, BPL-Mobile and AirTel, all say
that they speak to the customers and try to iden-
tify the specific needs that the customer might
have. Typically, there is an attempt to identify the
usage pattern. 

Consequently, a usage analysis is done,
through a collaborative effort between the client
and the Service Provider. Once that is done, the
right communication plans are decided. Then,
depending on marketing policies, pricing struc-
ture is determined. Naturally, there is a possibility
to pick and choose between the various services
on the shelf.

Hutchison Max Telecom representative Amrit

Adjust your
business needs
to fit your
communication
plan? Or change
your strategy
altogether?
What you may
really need is
corporate
services from
your cellular
service provider

Suprotip Ghosh

ver wondered how a competitor can always
come up with the most current quotes, the
most competitive prices, and the show-

clinching deals? Or say, how many times have you
been caught in a quandary—asking clients to send
over e-mail and asking them to call you? “Wished
I could have cloned myself,” how many times have
you had this maddening feeling? If it is difficult to
actually locate where your business is going, it is
time to reach out for a few different flavours of
intra-office communication.

Mobile phones have been around for long.
However, it has not been too long since the services
offered were fine-tuned for the myriad business
needs of a Small and Medium Enterprise Segment
customer. Now with the war in the airwaves
heating up, service providers high and low have
woken up to the reality of marketplaces. The idea
is to expand, and where else to look, other than
the rapidly growing entrepreneurial segments.
Especially if it buildsrevenue figures and brand-
equity at the same time.

DIGIT NOVEMBER 2004

Business on
the Mobile

Digital Business l Smart Business
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Deo, however, differs. He points out that if a full
customisation is offered to the corporate or the
SME customer, it has to be offered to each and
every one of Orange’s subscribers. 

Instead, Orange offers certain bouquets of serv-
ices, from which the discerning customer can
choose. This makes things easier, though at the
cost of complete customisability. That, however,
doesn’t affect the quality of service, assures
Orange.

Customisation, however, is not the focus area
for Reliance IndiaMobile. Instead, they focus on
high-end data related services like the proprietary
R-Connect Data Card and PDA-phone support.
With their array of network and data services, says
Sandeep M Sawant of Reliance Infocomm, they are
looking at a scenario where they can provide the
client with a one-stop solution for all their mobile
telephony needs. 

Customisation is always there, he adds, and it
is in the hands of the customer.

Many Flavours To Choose From
Across all mobile service providers in the market
right now, there is a huge array of feature-rich
choices for the corporate customer. Apart from
standard Closed User Groups, service providers
offer value added services, keeping in mind the
needs of a wide range of businesses. 

One of these is national and global roaming. In
what Hutch calls its ‘single most important service
for businesspeople’, it has roaming tie-ups with
nearly 50 national and 300 international networks
giving easy access to travelling customers. 

The biggest USP of Airtel’s Mobile Office
service is that GPRS users can use this service,

seamlessly, even while roaming in any of its 15 cir-
cles. With features such as GPRS while roaming,
nationally and internationally, Airtel aims to pro-
vide subscribers with a Mobile Office while
roaming in networks in USA, Canada, Hong Kong,
Singapore and the Philippines.

Roaming has always been the forte for
Reliance Infocomm. It provides its Mobile Office
services, a part of its R-World bouquet, to roaming
professionals across the country. 

Tata Indicom too, provides roaming services
to its mobile corporate customers.

If a client needs to make more National (STD)
or International (ISD) calls, BPL Mobile helps the
client migrate from a land-line based STD/ISD plan
to a completely wireless package. A Fixed Cellular
Terminal, or FCT, is a replacement for an ISD land-
line, which is routed through the mobile network.

Mobile Sales Force Automation
A further useful feature for the corporate cus-
tomer is Mobile Sales Force Automation (MSFA).
To put it simply, here the mobile service aims to
replace the computer with the mobile as the front-
end of the ERP database. 

It is designed to provide mobile sales profes-
sionals access to continuous, timely information
by providing wireless access to the backend ERP
system. Sales people can stay updated with the
latest quotes, prices and also keep real-time track
of shipments and consignments, if their ERP data-
base supports global positioning-based tracking.
MSFA is offered currently in a SMS-based format,
though it can work with GPRS-enabled phones.

Or take customised SIM applications—this fea-
ture allows pre-designated users mobile access to

I am connected
24 hours, and
at amazing
speeds. Right now,
I cannot imagine
my existence
without it
Vikram Doshi
Managing Director, ATCO
Technologies

Hutch Services:
sms@wrk: allows managers and their
team members to feed and access
information to and from a central
server—the most popular user group
for this application being sales teams
Group messaging allows a team
member to send a single SMS to the
entire team in one go
Stock quote alerts for specific stocks—
delivered via SMS
Internet access through Hutch GPRS
for those who want to log onto the
Web on the go. Their services are
EDGE compatible by default. EDGE or
Enhanced Data rates for GSM
Evolution is essentially a technology in
the backend of mobile GPRS services
to assure faster access and
connectivity.
Customised SIM applications—that
allow pre-designated users mobile
access to specific enterprise
applications and databases
MS Outlook on Hutch—that allows 
checking of office mails through 
mobile phones, over SMS or GPRS

Airtel Services
Mobile Sales Force Automation 
solutions enable the company to 
provide timely and up-to-date 
information to its field force by 
providing wireless access to the 
already existing backend ERP 
system.  The information could 
range from a potential lead to 
giving information about the 
availability of a particular spare 
part in the warehouse.  
The Airtel Corporate Directory service
makes the entire list of company
telephone numbers available to the
employees via SMS.  This list can be
constantly updated from a central
location. Hence there is no need for an
employee to maintain and store all the
relevant phone numbers on the
mobile phone.
Airtel provides simple-to-use and 
efficient tools for broadcasting 
information to customers and 
employees.
General News and Business Alerts: 
Airtel customers can also 
subscribe for News and Business 

News alerts to be delivered to 
their mobile phones via SMS.

Reliance Services
Single mobile devise for mail and
office directory access. No need for
Laptop or PDA.
Enhanced productivity—faster,
anytime, anywhere information
access even while roaming.
Enhanced responsiveness—for
internal communication as well as
external communication
Ability to synchronise your desktop
mail with your mobile mail. User
friendly interface—similar to Outlook
Express
No capital expenditure on special
devices 
No capital expenditure for backend
enabling of mail servers
Connects to all types of mail servers
including Notes, MS Exchange, POP3 /
IMAP
Total privacy—no replication of mails
at Reliance’s end
Security—supports end-to-end 128-bit
encryption and SSL

What The Cellular Service Providers Offer
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Ragnarok Online (RO) is a massively
multiplayer online game (MMORPG) where
thousands of players can live and

adventure in real time over the Internet. RO
India joins 10 other countries in running a local
version of Ragnarok Online to suit its local
trends, culture, and of course, its own players.
This is the first online video game that will unite
players from all over India. All you need is a PC,
the game CD, and an Internet connection.

How you play (or live) the game is up to you.
You can choose any role you like—swordsman,
archer, thief, acolyte or merchant. Play
cooperatively or competitively. Join a clan or
guild to complete quests and defeat boss
monsters. Raise your own pet monsters. Create
and name your own items and weapons. Collect
treasures in order to complete quests or sell them
in the marketplace for profit. You can become

who you want to be. 
The world is ‘persistent’ which means it is always

there, so you can play the game at your own pace.
Each time you enter, your gaming experience will be
different simply because of the new people that you
interact with, new secrets you discover and new tips
and items you will get only by interacting with other
players across the country

The Objective
What’s the point? Well, “Why are we
here?” “What’s the meaning of life?” In
the end, it’s your choice. Will you be a
ruthless thief? A heroic swordsman? A
crafty merchant? Will you be the guild
master who leads your clan to glory? Will
you live a solitary life by the creek raising
pet monsters? Or will you simply pass the
day talking to passersby, making new
friends and bragging about your newly
found treasure?

How Do I Do These Things?
Everyone starts as a lowly novice player with a low
level, no skills, and well, no job. But as you progress
in the game, by defeating monsters, joining forces
with other players who can help you with better
weapons or items, you will reach a level high enough
(level 10) where you can choose your job class. You
must pass certain tests to earn your job class. Your

level and job class will determine the
special skills you have, the items you can
possess and the power you will wield in
the game. Good luck and we hope to see
you online.

Getting Started
Visit www.level-up-games-co.in to register,
ask for a FREE game CD, install and click
on Ragnarok icon on your desktop and
login. Alternatively, look for the nearest
café (using the Web site’s café locator) to
start playing the game.

Advertorial
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Play 
co-operatively

or competitively.
Join a clan or

guild to
complete quests
and defeat boss

monsters

LET'S ROK! Join the Community
of RAGNAROK Online
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Ragnarok Riot is an
all-India, Player
Vs Player

tournament. The
battleground is the nearest

internet enabled PC. Take
your team into tactical
combat against other
Ragnarok fanatics across
the country. The challenge
has been made. Create
your character, develop
your skills and build your
team. There's more at

stake than just pride
and prominence;
there's Rs.1,00,000 in

prizes for the top teams.
Ragnarok Online is India's first MMORPG , where

thousands of players can play together, in real time
over Internet. A game that appeals to most gamers
(and people who never played PC games seriously
before). The game allows you to choose your
profession as a swordsman, Mage, Archer, Thief,
Acolyte or Merchant and explore over 300 maps and
dungeons. The key to successful adventuring lies in
creating a diverse and well coordinated team 
of players. 

To get in to the game all you need to do is
visit www.level-up-games.co.in and register. Ask
for a FREE CD, install, click on Ragnarok icon on
your desktop and login. Alternatively look for the
nearest café (using the website's Café locator) to start
playing the game. 

Who can participate?
In order to qualify for the tournament, the team
must comprise of a minimum of 9 and a maximum
of 12 players (9 active players, 3 reserves). Each

individual player must
reach a minimum job level
of 30 in India Ragnarok
Online as on December 1
2th 2004. 

All job characters are
welcome but a team must
have at least 4 active players
with first job class
characters (swordsman,
Mage, Archer, Thief, Acolyte
or Merchant). Visit the
website for more
information.

The Riot starts Dec 21, 2004
The Ragnarok Riot will
continue until Feb 5, 2005.
Sign up now and
build your team as
registration closes
Dec 12, 2004. 

The “Riot” will
continue from
December 21st

2004 to
February 5th

2005, and has a
Rs. 1 Lakh Cash

prize for the 
Top Teams

“Ragnarok Riot”
India's first Online Tournament
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specific enterprise applications and databases.
This means customised content pertinent to the
client’s operations or services can be displayed as
menu items or otherwise as SIM items.

The Corporate Directory Service, provided
across the board by all operators, provides access
to the organisation’s Telephone Book and group
messaging facility to mobile executives. 

This lets executives view other intra-office
users in real-time, based on name, group, location
(city) or organisation hierarchy, and send SMSes
or e-mails to all or selected users. This means that
the time delay for locating and communicating
within an organisation is significantly reduced.

Not Just The Routine
All this leaves a client with an embarrassment of
choices. Other than a clutch of standardised serv-
ices, each service provider has its own unique
selling point for various services. Reliance, for
instance, provides solutions for large and medium
corporate entities with services such as Wireless
Vehicle Tracking Systems and Wireless Lottery Ter-
minals, which use its optical fibre backbone.
Orange provides Outlook on GPRS-enabled
mobiles and PDAs, as does AirTel.

Options such as closed user group SMS and
information services come in different flavours
from different service providers. They can be
moulded to the needs of every individual business.

Speciality Communication
“I need to download presentations and Excel files
from my server at office. All I need to do is connect
through my PDA phone—I do not need a laptop,”

says Doshi. “Ithas a huge effect on productivity—
it dramatically cuts down on response time.”

“SMEs look at how devices can increase pro-
ductivity. It is a slightly more demanding segment
than the full-fledged corporate segment. Here,
‘cost-effective’ is the keyword. However, services
depend on the demand. The technology is there,
and it is possible to give them the service,” says
Kunal Ramteke, marketing controller, BPL Mobile.

All service providers agree that the focus of
the user segment is value for money and produc-
tivity enhancement. As far as revenue is con-
cerned, the corporate segment is important on a
different plane—brand equity.

Harit Nagpal, chief marketing officer, Hutch,
says, “Wireless corporate solutions is one such cat-
egory of services that would be particularly
helpful to boost the productivity of corporate
executives by providing them access to informa-
tion while on the move, any time of the day. Wire-
less corporate solutions are extremely relevant for
this segment of mobile users, and thus form an
important part of our service portfolio.”

Towards A Perfectly Oiled Machine
Technology is an enabler, and to be perfect, it
needs to be invisible. Corporate mobile services,
fit this bill perfectly—they work discreetly in the
background; they ensure that no one is ever left
alone, out there, in the dark. Whether it is data,
feedback, or plain keeping in touch, these invis-
ible tendrils keep a business perpetually on-line,
literally, while filling in the blank spaces of the
corporate jigsaw. 

suprotip_ghosh@thinkdigit.com

In the SME
segment, ‘cost-
effective’ is the
keyword... The
technology is
there, and it is
possible to give
them the service

Kunal Ramteke
Marketing Controller,
BPL Mobile
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FROM making random viewpoints public to posting reviews about serious
business projects and industry events, Web Logs (blogs, for short) have come
a long way. A dynamic tool that fosters quick analysis and inputs from
clients and customers alike, they are an innovative way of accelerating
business. We spoke to five professionals who use their blogs for just that

Having been an Internet professional before I made a career
switch, I did plan on a chef blog as part of the Shiok Web site,
right from the design stages of my restaurant. From what I

have seen, I am the only restaurant chef in this country to post a
blog. Celebrities such as Sanjeev Kapoor and Tarla Dalal do have their
own Web sites, but these require paid membership. In contrast, my
blog is up there for free.

Professionally, it gives me credibility as a chef, especially since
Shiok is a chef-driven restaurant. It’s refreshing to get unfiltered,
useful information from a company's managing director directly. It
lowers my cost of retaining customers and helps brand recall. By
giving them something to come back to, Shiok’s brand stays fresh in
their minds and helps repeat business.

One of our main challenges is to educate the customer enough to
start appreciating new flavours and foods. This can only happen
when you are in touch with them regularly.

I have been reading blogs by Rajesh Jain and
other such eminent Indian and foreign IT
personalities for two years. Also, James Rick

Stinson, a client of my company and a blogger
himself, encouraged me to start my own blog.
So I began blogging in June 2004. I am a great
fan of photoblogging and Moblogging (mobile
blogging).

I use my blog as a medium to express my
opinion on new events, happenings, etc, in the
Internet industry. The Indian Online
Advertising Conclave 2004 saw me fly down
from Delhi to Mumbai so I could cover it on
my blog. Among the people impressed by my
coverage was Ajit Balakrishnan, CEO of
Rediff.com, who commended my job via e-
mail.

While talking business, Dave Vallauri, Chief
Executive Officer, LodgingInteractive.com,
another client, said that he has developed a
much better perspective about India after
reading my blog. A passion for IT saw me leave
my chartered accountancy studies halfway
through to pursue a career in this industry.
Blogging is now helping me keep this passion
alive and thriving.

Mohit Maheshwari
Web Strategist
Ishir Infotech

Madhu Menon
Head Chef
Shiok Far-Eastern Cuisine,
Bangalore
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Vikas Kamat
Independent Technology
Consultant

Kaushal Karkhanis
Senior Visualiser
Hungama.com

Back in 1988, I had my own Web site, way before the blogging
concept caught fire. I updated my pages manually and FTPed
them to the server. Needless to say, this was a painful process. And

so it was like manna from heaven when I stumbled upon Blogger.com
in 2001.

Being a technology columnist, I know the hassle of getting an
article published—the synopsis, the approval, the editing and the god-
knows-when-it-will-be-published quandary. Now, I can publish my
writings anytime. Also, the fact that I constantly feed in information is
reason enough for visitors to come back for more.

The number of contacts I have been able to make via blogging is
amazing. I have attended almost all the bloggers’ meets and met
interesting personalities. It’s amazing to see the number of job offers
that I get from visitors. It also helps me earn extra money: ever since I
included Google’s AdSense, my blog has earned me more than what I
had spent on the domain name and server space.

Kriba Shanker 
Documentation Engineer
Brooks Automation

Ibegan blogging in July 2001. The idea of incremental building of
thoughts attracted me to it, and so did the fact that it removed
editorial barriers. I have made a great number of (social) friends

via my blog AnthoBLOGy (http://www.kamat.com/vikas/blog.htm).
I read a couple of blogs, and feel I know the bloggers very well, even
though I have never communicated with them. Thus, I have built a
“silent networking relationship” with them.

My blog is a kind of personal incubator of projects. At the time I
started to blog, I had the attention of loyal readers (of
www.kamat.com)—many of whom liked the idea. I use my blog as a
“draft” of my ideas and projects. My readers quickly point out
mistakes or mis-steps. 

While I do not use my blog for professional development, the
software I developed to write my blog (called SimplyBlog) is being
used by many companies in India and across the world for
professional growth and idea percolation.

As told to Garfield D’Souza

posts
The first posts on my blog were in July 2003. Although much of my

blog is personal in nature, I figured it would make more sense
talking about professional life and my learnings (like designing

tips, etc), because it would have value for my readers—especially the
“community.”

Sure, it has helped me network with peers. A lot of people liked the
postings—especially the tips—and I have made several business,
professional and personal friends via blogging. It’s like a personal
sphere with a professional core to it. Personal homepages minus the
garb, but added value to the reader.

As for how the idea (to blog) materialised, well, it just happened.
When you share a passion with peers who are always in touch with
you, and everyone knows what each one’s been up to, it’s really an
upbeat environment. And enthusiasm is always contagious, blogs or
not. So when people visit my blog and discuss my posts, my thoughts,
it’s a very one-on-one interactive process of “mindsharing.”
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Restrict Web Access at Work?
Should your staff surf the Web with abandon or should you restrict access to certain sites?

“[ban has] increased productivity”

Sidharth Swarup
CEO, OctaWeb

Prabhakar Sarwade 
Corporate Head—Technical Infrastructure Management,
Mahindra British Telecom  

FACE-OFF
Photograph MM

eexxyy  XXaavviieerr

OctawebOnline is in the business of focused solutions
for the International Casino Industry. It is important
for us to allow our team to have access to any and all

resources to access relevant information and communicate
appropriately to all concerned. Also,we have other business-
es which are into mundane Web Development—where too,
we have seen that any sort of ban on Web sites acts as a hin-
drance to productivity. If someone has to waste time or
indulge in passing out time, he will do it either ways—
through a smoke or a walk in the corridor or office chit-
chat. So, why single out Web sites? Just because you have a
bad driver doesn’t mean that we ban cars on the road!

Yes, it was a move to maintain employee morale as well.
Our staff does appreciate the trust relationship they share
with the company management and the organisation itself.

We have a high-end radio frequency installed for band-
width, and as such, we haven’t experienced a dramatic
downfall in its availability. 

I believe banning Web sites is just a means for idle man-
agers to give themselves some task to manage. Banning of
content or any service is never an answer to a problem . The
perfect or near perfect solution is always simpler. Create
harmony in the office environment, recruit mature individ-
uals in your organisation and give them all the freedom in
the world: it’s that simple. They soar and the organisation
soars with them—hand in hand. Thus you create a win-win
situation for all involved!

Mahindra British Telecom (MBT) as a company is very
sensitive towards its customers’ need for security
and privacy and keeps in mind its employees’ inter-

ests as well.
Hence, while we ensure that the working environment is

better protected and productive, we also take steps to see that
the workplace is one that employees would love to work in.

That said, we decided to deploy Surf Control to effec-
tively control Web surfing. Our staff co-operated at each
and every stage of its implementation; they were very pro-
fessional in their response. This deployment had become
necessary as part of the security deployment. Moreover,
restricted access was also necessitated by the fact that our
project delivery team, which used VPN for access to their
projects, was complaining of slow response time. 

Post-deployment, there is a remarkable reduction in
Internet bandwidth utilisation. Surf Control blocked out
Web sites that pertained to glamour, dating, gaming, gam-
bling, etc. Web-based e-mail and chat sites (including MSN
messenger) were also in the list of blocked Web access. This
has helped MBT in securing the organisation apart from
bringing about the much needed increase in productivity.

We have an internal messenger system for employees to
connect and interact. We do allow our employees to access
Web sites that talk about technology, news, etc., which in
effect, does not curb their right to know and be up-to-date.

— As told to Garfield D’Souza

“Any sort of ban... acts as a
hindrance”
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Ram Mohan Rao

e travelled frequently to
Hyderabad to consult Dr 
R G about a kidney

problem that my father suffers
from. We no longer need to.
Thanks to telemedicine, we were
able to get him to examine my
father, and prescribe medication,
in Eluru itself. This facility saves
money and time. I am grateful to
Apollo.” That letter, dated August
5, 2004, was from a certain P J in
Eluru, Andhra Pradesh. For this
patient, as well as for thousands
of others—including a 32-year-old
Pakistani woman diagnosed as
suffering from a brain tumour—
Apollo Hospital’s telemedicine
links are a godsend.

The Pakistani woman received
expert advice from radiation

oncologists through the link. Dr S
Hukku, senior radiation oncolo-
gist at Apollo Hospital, saved her
the trouble of travelling to Delhi
by dispensing advice on the line
of treatment to the Apollo
telemedicine centre in Lahore.
This centre utilises Internet
connectivity of 128-256 KBps to
access Medintegra Web, a
telemedicine software, and full-
screen videoconferencing as well.
Dr Hukku later told the Tribune
News Service that Apollo had been
treating cancer patients from
Bangladesh, Pakistan, Sri Lanka
and West Asia. “Most of the cases
are of brain tumour. They opt for
treatment in India because
neurosurgery is well developed

Tech quo-
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Technology Beyond WorkTowards 
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Leisure
Digital

here,” he said. Dr Hukku said
that if the patient from Pakistan
had to come to Apollo, instead of
being treated via telemedicine,
she would have to pay anything
between Rs 1 to 1.5 lakh for
surgery.

Dr Puneet Gupta, another
cancer specialist at Indraprastha
Apollo Hospital, told the Tribune
News Service that the telemedi-
cine link between Delhi and
Lahore would “change the stan-
dard of cancer care in
(Pakistan).”

Apollo has 62 telemedicine
centres in India and has telemed-
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Dial-a-Hospital
Touched by Tech

Telemedicine can connect doctor to patient across continents in realtime. Here’s how the
Apollo Telemedicine Network Foundation implements its vision
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icine links with Colombo and
Dhaka. The hospital plans to
introduce telemedicine links with
Nepal, Kazakhstan and Bhutan.

The letters pour in: one from
Aragonda, a remote village in
Andhra Pradesh, reads: “My
daughter F B, three and a half
years old, was operated for a hole
in her heart at Chennai. We used
to travel to Chennai every six
months for checkups. Now,
through telemedicine, we can
consult the same doctor, from
Aragonda, instead of going all the
way to Chennai.”

Telemedicine does away with
distance barriers when it comes
to healthcare. It saves time and
money for those who are lucky
enough to be able to use it. So
what exactly is telemedicine, and
what does it involve?

The What And The How
Essentially, telemedicine involves
sharing and exchanging of
patient related data and medical
opinions between a medical
specialist and a doctor in a remote
location through telecommuni-
cation networks. Telemedicine
thus overcomes geographical
barriers, can make for quality and
effective healthcare, and is
eminently cost-effective.

Apart from the basic idea—that
telemedicine is used to reach out
to patients who do not have proper

healthcare facilities—what are the
applications? There are several, as
Dr D Lavanian, Business Manager—
Telemedicine, Apollo Telemedicine
Networking Foundation, Apollo
Hospitals Group, tells us:

Relief efforts during natural 
calamities
Continuing medical 
education through 
videoconferencing
Providing training to 
prevent/respond to typical 
disease patterns in remote 
areas
Adding to healthcare 
knowledge bases: 
telemedicine can be a 
communication tool 
to aid in the understanding 
of  the nature of ailments
In case of emergencies, a 
general practitioner can 
perform surgery with tele-
monitored specialist 
assistance
In second opinions, where 
the diagnosis can be 
confirmed and treatment 
planned

Objectives And Offerings
Apollo aims at nothing less than
reaching the masses in India
where healthcare is not available,
under the belief that every citizen
is entitled to advanced and quality
medical care. They aim to set up a
referral system as well. General
practitioners (GPs) are targeted
under their program: Apollo hopes
to develop and demonstrate
telemedicine for use by GPs. And,
Apollo strives to evaluate the
impact of telemedicine in terms of
economy and user satisfaction.

Apollo’s offerings include
consulting for telemedicine proj-
ects; telemedicine software; IT
hardware; medical hardware;
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hardware and software for secu-
rity; communication links; and
operational management and
remote support.

The Aragonda Project
Situated a little distance from
Tirupati in Andhra Pradesh,
Aragonda and six neighbouring
villages were part of a pilot project
by Apollo. The area is agricultural,
and consists of a 7,000 people in a
1,500 families. Aragonda had very
few facilities with only six general
practitioners, and one poly-health
clinic—30 kilometres away.  Apollo
set up a 50-bed hospital with state-
of-the-art telemedicine infrastruc-
ture in January of 2000. ISRO
provided the VSAT equipment
and free connectivity. This was
India’s first rural telemedicine
centre, and has helped signifi-
cantly in improving the health
status of the population. It is a
self-sustaining model, with each
family paying a rupee a day—
which covers medical treatment
up to Rs 20,000.

An Example Treatment
At the GB Pant Hospital in Port
Blair lay an unconscious
patient. Admitted following a
head injury, the nature of the
wound was uncertain.
Photographs of the pupil of the
patient were taken. These were
sent to Prof K Ganapathy, Senior
Consultant Neurosurgeon at
Madras, along with the CT
scans. The scans showed
primary injury to the brain, but
it turned out that the patient
did not require surgery. The
local doctor treated him with
the assistance of a tele-
consultant. The patient was
discharged in just 10 days.

Telemedicine works
The bottomline is, is telemedi-
cine effective? Is it worth the
investment? Can it actually save
lives? The statistics speak for
themselves: from January 2000
to June 2002, out of 3,986
consultations in all Apollo’s
telemedicine centres, 3,395 of
them—or 85 per cent—were
successfully treated at the
telemedicine centres. Only 15
per cent had to be referred to
specialty centres.

All it takes for telemedicine
to become big is some band-
width, some collaboration, and a
vision like Apollo’s.

ram_mohan@thinkdigit.com

Telemedicine  How The Setup Works

A live telemedi-
cine consultation

between
Aragonda and

Hyderabad

VSAT/ISDN/
Leased Line

CAT scan

Webcam

A typical telemedicine
setup. There is appropriate
software at each terminal,
and the setup involves
routers and peripherals at
the two ends
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Patients End Terminal
(Telemedicine Consulting Centre)

Expert Doctors Terminal
(Telemedicine Specialty Centre)
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Name the mysterious new chip
designed by engineers from

IBM, Sony and Toshiba, pitched as a
“supercomputer on a chip”. It will
find a place in Sony’s PlayStation 3.
a. Cell
b. Power5
c. Alpha
d. Crusoe

Which electronics giant, to
compete with Apple, has

announced plans to add native MP3
support to its music players?

a. Microsoft
b. Sony
c. Virgin
d. Yahoo!

Which biggie is believed to be
poaching developers from

companies such as Sun and
Microsoft in an effort to develop a

browser to contend with IE?
a. Google
b. Amazon
c. eBay
d. Yahoo!

Which popular American ISP
has decided to dump

Microsoft's anti-spam tool, Sender
ID, in favour of an open-source
alternative?
a. EarthLink
b. MSN
c. AOL
d. Compuserve

Set in NYC in 1939, this film
tells the story of giant flying

robots, and a reporter who teams
up with a pilot to thwart the plans
of a mad scientist bent on
destroying the world. Which film?
a. Resident Evil: Apocalypse 
b. Cellular 
c. Eternal Sunshine of the 

Spotless Mind
d. Sky Captain and the World

of Tomorrow

Xerox PARC is currently
developing a flexible fabric-

like material that can display
digital text. What is this product
better known as? 
a. OLED
b. Plastic view
c. Electronic paper
d. ElectroCon

Name India's exclusive
satellite for educational

services, that was launched
recently from Sriharikota.  
a. EDUSAT
b. INSAT-2E
c. IRS-1D
d. Kalpana 1

Name this unlikely entrant
into the Open Source arena,

which recently released the source
code for FlexWiki—software for
creating Wikis. 
a. IBM
b. Intel
c. Sun
d. Microsoft

9
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3
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Across
7. ‘M’ in CAM scatters the mod (6)      
9. Visual handle in chat forum is an

incarnation of a deity (6)                 
10. Earning before interest, and

taxes (abbr) (4)    
11. Questions and -------(7)                    
12. An array in data processing

upsets bleat (5)  
14. Union territory ‘A’ in region code

’AN’ in India (7)
17. Unit of temperature, -------

Fahrenheit(6)      
18. Carrier Sense Multiple Access

(abbr) (4)       
21. Symbolized ‘T’ wrongs slate (5)       
22. The four standard inks for

printing (abbr) (4)
23. High tech boss or leader? (6)
24. Unit of absolute

temperature invented by
British physicist (6)

Down
1. Input device (8)
2. ---- in the arm for

screen capture (4)
3. Concepts rearranges

aides (5)
4. This company’s logo is

an ellipsis that mimics a
planetary orbit (7)

5. Routers for entrances (8)
6. Short for upper case

letters (4)
13. ------- International

Swiss public digital
company (8)

15. Opposite of
synthesis (8)  

16. A lasting connection
between a user and a
peer (7)

19. Modify programs illegally
destroying shack (5)

20. Basic input/output system

(abbr) (4)
22. Computer Animation Movie

Language (abbr) (4)

Compiled by Nitaa Jaggi

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
editor@thinkdigit.
com

Mad Scientists, The War On Spam, And More 

L-I-N-D-O-W-S, the seven,
large letters that once

topped Lindows’ San Diego
campus, are currently up
for sale on eBay—for $641.
This Linux start-up was
recently sued by Microsoft for
using a name that the latter
believes infringes on the
Windows trademark. The
company has now been
rechristened Linspire.

Did you
know?

German security company Securepoint has
recently hired teenager Sven Jaschan,

self-confessed creator of two destructive worms.
Sven has been offered work as a trainee software
developer working on security products, such as
firewalls, despite an impending jail stint for creating
one of the most destructive computer viruses to
date. Name these worms.

a. NetSky, Sasser b. Sasser, Melissa
c. Melissa, “I Love You” d. Slammer, NetSky

10

Which world-
renowned

innovator is being
honoured at The
Economist's Third
Annual
Innovations
Awards, 2004,
held in San Francisco? This
innovator authored a revolution
while he was a student at the
University of Helsinki. 

a. Alan Cox
b. Linus Torvalds
c. Richard Stallman
d. Wichert Akkerman

1

Send in your answers to the quiz to
TQ@thinkdigit.com.
If you get all 10 answers
right, you
win a Canon
PIXMA
iP4000
printer!

Win!
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Wired, October 2004

Presenting The Digital
Photo Future
WITH MILLIONS OF pictures being shot
everyday by lakhs of people worldwide,
thanks to the flexibility provided by
digital cameras, where would these digital
memories be stored? Enter digital photo
archiving. In this excerpt from Wired
magazine, writer David Weinberger of
Wired demystifies the future for us.

A digital camera is an enticement to take
more snaps than you can keep track of. You
don’t even need to carry a camera; you can
squeeze off a stream of shots with your cell
phone and send them to your inbox. With the
price of digital storage plummeting even as
our time seems to become ever more
valuable, it’s cheaper to store the lot of them than to
weed out the clunkers. 

But having thousands of photos on a hard disk or DVD-
ROM is the equivalent of throwing Bettmann’s images (a
photo archiving company that stores millions of photographs)
into the air and letting them flutter to the ground. Our only
hope is that the army of engineers laboring in labs around
the world can come up with a better way. 

The situation at the Bettmann Archive may be
discouraging, but Corbis, a stock photo house that happens to
be Bettmann’s corporate owner, is groping toward a solution.
For one thing, the 3.2 million images stored in Corbis’ Seattle
headquarters have been digitized. For another, they’re being
annotated with keywords that make it possible for customers
to log on to the company’s Web site, sift through more than 62

terabytes of photo data, and pinpoint
images that meet their needs.

Inside the company’s airy office,
media cataloger Nick Fraser sits in
front of two screens. On the right is a
photo of a strawberry, perfectly lit
and very red. On the left is an in-
house software app that lets him
browse through a list of keywords.
Fraser’s job is to tag images with
appropriate terms so that when
customers search using a keyword,
they find photos that match. Fraser’s
palette offers 60,000 choices,
arranged in a hierarchy; the top level
is the “Top of the World.” Under the
category unaccountably called
“Anatomy,” he clicks on “Fruit.” He
adds “Red,” and the photo is tagged. 

A photo of a businessman sitting in a small chair facing
two other chairs of increasing size is harder to tag. It is
vague and evocative. Deciding what words to use means
figuring out what the photo might mean to others:
Decisionmaking? Disappointment? Downsizing? There is no
right answer. “You just have to look at it long enough to see
what the metaphor is,” Fraser says.

In computer parlance, these tags are metadata -
information about information. But metadata as it relates
to imagery is a slippery thing, and tagging is a craft, not 
a science. 

To read the complete article, visit www.snipurl.com/photofuture

Wired, October 2004

The World of Halo 2
DAVID KUSHNER OF Wired magazine walks us through
the offices of Bungie Studios, the company behind Halo 2,

the world's most anticipated game.

“Behold!” proclaims Pete Parsons, manager
- Bungie Studios, as he steps into the game
company's most exclusive room. “We call this
the LRS.”

The living room simulator is where Bungie's
developers are beta-testing the year's most
anticipated videogame, Halo 2. 

The original Halo, a first-person shooter
released for the Xbox in 2001, dazzled the
gaming world with its cinematic sweep. Taking
a page from the movies, it featured car chase
scenes, stunning locations, and smart sci-fi
suspense. It sold more than 4 million copies,
making it the biggest Xbox blockbuster yet. 

Halo 2 brought down the house in May at E3, the videogame
industry's mammoth trade show. It garnered the most award
nominations and won Best Console Game, Best Action Game, and
Best Online Multiplayer Game - and that was just for the demo.

Now, with only a few weeks of production time left before
Halo 2's November 9 release, the LRS looks more like an abused
frat lounge than the incubator for a multimillion-dollar game. 

When Bungie designers began working on Halo 2 in 2001,
they quickly realized that making a new game for an old
console (the Xbox turns three this year) requires that you tap
human power rather than the latest videocard or motherboard.
So they took the moviemaking idea behind Halo one step
further and staffed their development team like a full-blown
Hollywood production. An architect designed the sets. A
thespian wrote the script. A composer penned the score. 

The result: a meticulously engineered, gorgeously
textured, and explosively fun game that feels like your own
damn action flick. In fact, at some movie theaters this
summer, the Halo 2 teaser drew wild applause. Here's a look
at some of the creatives who toiled behind the scenes.

“This is bullshit!” barks Joe Staten, Cinematics Director,
as he twitches in his chair. He isn't complaining about a bug
in the code, he's reciting one of the 17,000 lines of dialog he
wrote for Halo 2. (The script is 10 times longer than the first

game's.) This particular outburst comes when a player's
rocket launcher gets stolen by another player, who swaps it
for a far wimpier weapon - a stunt you couldn't pull off in
the original game.

Want to read the entire feature? Visit www.snipurl.com/halo2team

MediaWise



The New York Times, October 14, 2004

What Women Want?
WOMEN AS GAME developers? For many, this would
sound as weird as male nannies. But male nannies exist,
and so do women game developers. Still don’t believe us?
Here’s what Katie Hafner of The New York Times has to

report on the women behind
some of the world’s most
popular games.

Denise Fulton spent much
of her childhood playing
computer games. At 8, while
growing up in Ohio, she was
already playing Zork, Adventure
and other text-based games.
And the fascination continued
into her adult years.

So it is not surprising that
today Ms. Fulton, 34, is an executive producer at Ion Storm, a
video game company in Austin, Tex., where she is overseeing
the next installment in the popular Deus Ex series.

The surprising part is how rare Ms. Fulton is. Behind the
computer screen, as in front of it, video games are a man’s world.

Informal estimates put the percentage of women in the
industry at around 10 percent, and even then, most tend to be
in jobs in customer service, marketing and quality assurance.
Relatively few women work as game designers and producers,
and even fewer are programmers.

“It’s not so much that women look at the industry and
discard the idea,” said Sheri Graner Ray, a senior game
designer at Sony Online Entertainment. “It’s that the game
industry just never even comes up on their radar.”

The reason has to do with a truism about the computer
game industry. Those who work in the industry tend to enter
their jobs as avid gamers. And playing video games, especially
those loaded with graphic violence, has been a male pursuit.
According to the NPD Group, a market research firm based in
New York, some 81 percent of video-game players are male.

“It’s a chicken-or-egg thing,” said Ms. Fulton, who sees a lot
of résumés in her job, almost all from men. “If more women
were playing games, they might get interested in games as a
medium and might choose to pursue that as a career. But it’s
still stigmatized as a boy thing.”

Now, though, manufacturers are starting to think about
making games that are more appealing to women, like the
Sims, a role-playing game that is viewed as one of the most
popular games among women.

“Do women not play games because the games that are out
there are designed for men, or is it just that women really don’t
like computer games?” said Elizabeth Sweedyk, an assistant
professor of computer science at Harvey Mudd College in
Claremont, Calif. “My guess is they don’t like the games that
are out there.”

Manufacturers understand there is a huge untapped
portion of the market. “They’ve realized they have to appeal
to women,” said David Riley, senior manager at NPD. And as
more games are marketed to, and played by, girls and
women, more women eventually may end up choosing a
career in the industry.

Until then, though, people like Ms. Fulton, and like Nicky
Robinson, a programmer, will be the exceptions.

To read the entire story, please visit, www.snipurl.com/gamewomen
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The Disappearing Act...
is what the guys at Apple have successfully brought about.
The iMac amalgates the display and the processing unit into
one body. The slim ‘model’ here in the ad does make quite an
impression!   

Sharp Attack
The message hits home loud and clear— that the Epson
projector just has a one-point mission—mind-blowing
entertainment that’s crystal clear in this ad’s depiction. 



Technology Paradise Lost is hell-bent on
proving that the computer industry
has sputtered somewhere down the
1990s and is in no mood to regain its
power. Eminent IT consultant and
speaker Erik Keller cites several
examples and offers hard facts to
back his claim. And he does it well.
Keller has done his homework—he
was a technical journalist for 10 years
and worked for research company
Gartner as a technology analyst.

Keller reasons that it all had to do
with irrational spending on software,
and other such factors. Companies
realised that they had better pull up
their socks and ask for reasons for spending on IT.

The pace does slacken in between all the
business and figures that Keller doles out. However,
it does pick up as he takes you through
conversations in boardroom meetings and
luncheons that vividly portray how IT spending
charted its course in American IT corporations. 

Keller takes the example of
companies such as Merrill Lynch
which did cut IT spending and gained
competitively. And he positions
offshoring as one of the key factors
that have fuelled the cut. He says that
with its cheap-labour-more-skill tag,
offshoring is here to stay.

Keller does not write off IT
completely. His viewpoint is that it
will remain the focus of
competitiveness as companies
spend less to get more out of IT. He
doles out survival tips for companies
that are downsizing IT departments
and implementing cheap IT solutions. 

Technology Paradise Lost is worth a
read. Read it to know where and how

companies stumble and how they can avoid
stumbling blocks as they chart their IT expenditure.

Garfield D’Souza
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Spiderman 2

Activision’s Spiderman 2 starts with a
cut-scene—a direct lift from the movie.
Then, no drama, no tension, nothing!
Training levels are a piece of cake. You
control Spidey with the standard mouse-
keyboard combination. As for the
controls, you can shoot webs, swing from
poles, punch, zip around, entangle
enemies in your web, and snatch their
guns. Basically, the left-mouse button
does it all.

There’s not much you can do as far as
combat goes. If you get bored, jump and
kick, and then get back to punching.
Variety-wise, Spidey can shoot webs to
pull guns away from enemies, who don’t
even know what they are supposed to do.

All baddies can be taken care of by
clicking the mouse button at warp
speed.

The graphics are just about
acceptable; not so with the sound. With

no freedom to speak of, inane gameplay,
a pathetic control system, flawed combat
and dull voice acting, this game deserves
to be buried real deep in the earth.

Courtesy SKOAR! 

FUYL is definitely for those above 18. It features
frontal nudity and some “nasty” scenes as well.
The simple “Point ’n Click” interface has a 360-
degree camera. Your only objective is to get your
character to do the nasty.  

FUYL relies on the intricacies of human
relationships. Normal Mode places you in an
apartment, and you start life with a small
amount of money. Earning more money is as easy
as [Ctrl] + [P]. Start-From-Scratch gives you an
empty flat to insert walls into and add furniture
too. You unlock the Villa Mode as you finish the
Story Mode, to build your own mansion. Once

you’ve “scored,” the game gets repetitive—you just
gotta flirt-eat-earn-flirt-sleep.

The graphic effects are sharp, with perfect
character animation. Sound effects are realistic—
the groans and grunts of copulation have been
carefully recorded.

The game excels from the graphics and sound
points of view. However, it loses its replayability
due to its monotony. Sex and good special effects
alone do not a good game make. 

Richard Roy
Singles: Flirt Up Your Life!

Publisher Eidos Developer Rotobee
Web site www.singles-the-game.com

Price $ 29.99 (Rs 1,370)

1. The Sims 2
Rs 1,299
Gayatri Impex Pvt Ltd

2. Spiderman 2
Rs 1,299
World Wide CD Roms

3. Shellshock: Nam’ 67
Rs 1,299
Milestone Interactive Software Pvt Ltd

4. Spy Kids - Mega Mission Zone
Rs 1,199
Times Multimedia

5. Jumpstart
Rs 699
Express Interactive Software P Ltd

Spiderman 2
Publisher Activision  
Developer The Fizz Factor
Web site www.activision.com/microsite/spider-man
System requirements 600 MHz CPU, 128 MB RAM,
DirectX 9.0b compliant 32 MB video card, 
827 MB free space
Price Rs 1,299
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IT Will Not Fuel The Future

Flirt Up Your Life!
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Books

Games

Technology Paradise Lost
Publisher Dreamtech Press

Author Erik Keller
Web Site www.wapitillc.com

Price Rs 399
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Based upon an eponymous Korean comic,
Ragnarok Online (RO) is set in the mythical
Viking kingdom of Rune-Midgard, where a

long-kept peace between the gods, humans, and
demons has been broken for reasons best known to
themselves. The lands are now in turmoil, and the
people are crying out for help. This is where you
come in. Starting off as just another babe-in-the-
woods, your aim is to rise among the ranks, growing
in power until you're feared by your opponents and
respected by allies.
From this point on,
you can begin taking
an active part in the
politics of the land, forging
alliances and bringing your
clan to a position of
power.

The game allows
you to choose your
profession as a Swordsman,
Mage, Archer, Thief,
Merchant or Acolyte. Each
character class has its innate
strengths and weaknesses,
so choose one that befits
your playing style.
Irrespective of your choice however, you would do
well to remember that you won't get too far into the
game unless you team up with other players,
preferably from other classes. The key to successful
adventuring lies in creating a diverse and well co-
ordinated team of players.

Key to the Ragnarok experience is the people
you'll encounter in the game - people like yourself,
looking for some adventure and a whole lot of fun.
The strength of any MMOG (Massively Multiplayer
Online Game) is the sense of community you get

while interacting with other players. After teaming
up with a few other characters, you'll be able to take
on very tough monsters without any hesitation. And
the level-ups - well, they'll just keep on coming.

The game is a first-generation MMOG released
nearly five years ago, and it has seen phenomenal
success in all the countries it's been released in so
far. Its mass appeal and usage is thanks to its low
system requirements, with only a 400 MHz CPU
required for playing the game. Despite its age, the

special effects used for
spells manage to be
spectacular. Rest

assured, Ragnarok will
use your PC to the fullest

extent while displaying
graphics you wouldn't have
thought possible from an RPG

such as this.
Unlike a shooting or

racing game where you
can just pick up the

controls and play,
Ragnarok requires you
to learn a bit about the
game first. However, if

you give it a little time, you'll find a
great game that doesn't take itself too seriously. A
huge user base of nearly 12 million across South-
East Asia is testament to the popularity of the game.
In fact, in a rather bizarre development some time
back, the Thai government had laid a curfew on the
number of hours Ragnarok's servers were allowed to
run. This game will appeal to most gamers (and
even people who've never played PC games
seriously before). The word that really summarizes
Ragnarok Online, at least in my opinion, would
have to be addictive.

Game Review: The World Of
Ragnarok Online

Impact Feature

Adventuring is hard work. Time for a
small rest and catching up on some
gossip

Help is easily available - both from
the in-game Kafra Staff and other
players

Hunting monsters is much more fun
when you do it with friends
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Japanese daily Shukan
Gendai reports that well-
known counsellor Hideto

Tomabechi has developed a
ring tone that promises to
increase women’s breast
sizes. The best part is that
he doesn’t seem to be
bluffing! “I listened to
the tune for a week
expecting all the time
that I was being duped,”
said Chieri Nakayama, a
19-year-old pin-up model
speaking to Shukan
Gendai. “But, incredibly,
my 87-centimetre bust
grew to 89 centimetres!
It was awesome!”

We don’t know if
Nakayama’s experience is
awesome or psychological,
but women in Japan are
lapping up the tune. It
attracted a fabulous 10,000
downloads the first week it
was made available.

Tomabechi first made
headlines a decade ago

when he cured brainwashed
members of the AUM
Shinrikyo doomsday cult. 

Tomabechi already has
plans for ring tones aimed
at improving memory,
increasing attractiveness to

the opposite sex, making
hair sprout and quitting
cigarettes. He told Shukan
Gendai about his breast-
enhancing ring tone, “Most
would think it’s a lie, but
the techniques involved in

the process have been
known for some time and
are the result of research I
carried out in the ’80s and
’90s. I use sounds that
make the brain and body
move unconsciously. It’s a
technique involving
subliminal effects. I
suppose you could call it a
kind of positive
brainwashing.” 

That may not sound
very convincing, but the
statistics are: the ring tone
has been doing very well on
the charts. The final word
probably comes from a
spokesman for Mediaseek,
which offers Tomabechi’s
tune online: “We’ve even
received an e-mail from a
user who said she listened
to the tune every night
before going to sleep and it
made her (breasts) bigger.”

Looks like Tomabechi is
well on his way to
millionairedom.

OBSCENITY WATCH

No Camera
Phones In
Saudi 

Saudi Arabia has banned
the use of cell phones
with inbuilt cameras,

blaming them for “spreading
obscenity.” Camera phones
have prompted concerns
about various things: privacy
in places where people
undress, theft of reading
material at bookstores and
newsstands, and of course,
corporate espionage. They

Think you have the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit shall publish the most 
eye-catching of them every month.

FEELING BLUE: We don’t know what is going on here, but it
sure looks pretty! Hooray for transparencies!
Sent by Sohil M Abdul

My Desktop

indianwebsites.com

Too many links on this site
are irrelevant, or are

broken. Just do a search on
“hotel.” Looks cool at this
point—you're presented with
lots of sites. Now try clicking
on the first “site”—”The
Emerald Apartments Hotel.”
What you get is a blank
page. Try the next one—
”Pride Hotel.” You're
confronted with links to
sauna kits, odour control,
wire partitions, and the like.
OK, hit the back button and
head to the “Taj Mahal
Hotel.” Page not found this
time. And on and on—the
next click brings up ads for a
real estate company. Rather
unusable, this one!

Fuel Cells For Laptops
NEC showed off, late October, a prototype laptop
powered by its own fuel cell unit. It’s a very long way
from commercialisation, even though last year, NEC
had scheduled a machine capable of 40 hours’
continuous operation to appear by the end of 2005.

U2 Album To Appear On iPods
In a precedent of sorts, Irish rock band U2, were slated
to announce in the last week of October a deal to sell
custom iPods. iPods sold beginning the week of
November 23 would have the band’s upcoming album
“How to Dismantle an Atomic Bomb” preloaded.

RING TONE THERAPY

Listen Your Way To Bigger Breasts

The winning entry will win a
KUSBDTI/128FE USB stick
worth Rs 1,300. This month’s
winner is Sohil M Abdul.
Sponsored by
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have, as a result, been
banned by gyms, retailers
and other companies in
several countries.

The concern over their
use goes even further in
conservative Muslim
societies, where religious
authorities
complain that
cameras in
phones are
misused for
such things as
photographing
women
without their
knowledge—
young men
in malls in
the UAE have
been warned
by police about just this.
And in Egypt, a women-only
beach on the northern coast
bars cameras—and all cell
phones are checked to make
sure they don’t have
cameras. But so far, only
Saudi Arabia has taken the
seemingly drastic step of
totally banning camera
phones, and declaring them
religiously forbidden.

The ban notwithstanding,
the phones are still available
in the country—they are
smuggled in from
neighbouring countries such
as Bahrain and the UAE.

Sheik Abdul Aziz bin

Abdullah Al al-Sheik, Saudi
Arabia’s highest religious
authority, announced the
religious edict on
September 28 in remarks to
al-Madina daily. The devices,
he said, were “spreading
obscenity in Muslim society.

“All citizens should
renounce this (the use of cell

phones with
cameras) ...
for it can
harm
everybody
without
discrimination.”
Violators
“should be
strictly
confronted and
punished.”

THE ET CONNECTION

Banned From
The Net

Here’s the latest on the
extraterrestrial front:
Reinhard Mueller, 61,

an Edmonton, Canada,
resident, claims he is linked
to extraterrestrials. He is
working to bring Earth
under the United
Federation of Planets, but
his work has been
interrupted by an order

from a Canadian judge 
that bans him from using
the Internet.

The ban is part of his
bail agreement: Mr Mueller
has been charged with hate
crimes. Canadian cyber-
police found his site, which
prosecutors claim promotes
hatred against Jews. The
police asked the self-
proclaimed prophet a few
questions about his views,
and took away his hard disk
as well. They say that a few
writings they found were
possibly illegal. Mueller
denies the charges.

Mr Mueller goes by
several names, including
“Reni Sentana-Ries”, “Grand
World Councillor”, “Lion of
Judah”, and “Guardian of
the Arab Prophetess
Uthrania Seila”.

The Grand World
Councillor’s objection to his
ban from using the Internet
is that Net access is “a right
of all citizens of earth,” and
that he needs it to research
his defence.

According to court
documents, the Lion of
Judah will claim, in his
defence, that there was no
problem with his site until
he demanded the removal
of the monetary system,
and insisted that people—
human beings, that is—

A Day In The Life Of An Apple

This month’s
winner is Binny
Manikoth from
Kerala

Sir Tim Berners-Lee
invented the World Wide

Web. Period. Most
inventions are the result of

teamwork; the WWW is the
brainchild of just one
person. In 1980, Berners-Lee
was looking for a way to
organise his notes. Time
Magazine reports that he
“devised a piece of software
that could…  keep track of
all the random associations
one comes across…”

One “hypertext”
document would be
sufficient to access all the
documents on his computer:
but what about the material
on someone else’s
computer? He thought up a
way to link others’ material
to his document; and he
eventually thought up a way
of linking documents
everywhere, over the
Internet. Berners-Lee then
designed HTML; then URLs;
then HTTP; and then the
WWW’s first browser. The
WWW brought order to the
Internet.

Sir Tim always took the
academic, non-profit route.
Some say if there were a
category for the work Sir
Tim did, he would have won
a Nobel. He laments the way
the Web has turned out,
though—“It’s not supposed
to be a glorified television
channel,” he once said. “I
thought the Web would be a
tool for understanding each
other.”

Sir Tim
Berners-Lee

People Who
Changed

Computing

WIN!
A book by Michael Urban & Brian Tiemann on
FreeBSD, just by sharing an amusing picture
with a tech angle to it.

Send your picture to digipick@thinkdigit.com.
A prize-winning picture will be published each
month.

SAMS Teach Yourself
FreeBSD in 24 Hours

By Michael Urban &
Brian Tiemann

Published by Pearsons
Education



comply with the universal
order of stellar economics.
What a shame that he will
have to submit to an
earthly court…

PEOPLE DUMB DESPITE NET

Surfers Go
Online Just
For Kicks

Here’s something we
knew all along: that
despite the current

extent of Internet
penetration, despite
broadband and everything
that comes with it, most
people do not use the Net
for self-improvement and
expansion—they prefer to
use it for such things as
“casual surfing related to
hobbies and music.”

This was the conclusion
reached by a recent Cardiff
University study, which
polled 1,001 people across
the UK. It shows that the
concept of “lifelong learn-
ing” online doesn’t exist in
most peoples’ heads. The
number of UK adults partici-
pating in ongoing education
has not increased much
since the Net came by. Less
than half of UK adults make
use of the WWW despite its

widespread deployment in
public buildings in the UK
and elsewhere.

The author of the report,
Neil Selwyn, says that just

eight per cent of the UK pop-
ulation does not have
Internet access, and yet, sur-
prisingly, 48 per cent had not
used it during the last year.
He gives an example repre-
sentative of this sad finding:
one man had “only used the
Internet to book his holidays
twice a year and that was
done on his behalf by a com-
puter-literate friend.”

Selwyn concludes his
report with this: “It’s good
to make access to the
Internet as wide as possible,
so that no one is left
behind, but we have to
accept that not everyone
needs it in their lives.” If
Internet usage patterns all

over the world are similar to
those in the UK—which is
quite likely—we will just
have to accept that the
Internet has not done more

for us, in terms of
learning and self-
advancement, than
the printed word has.
And with people read-
ing less than ever
before, there is cause
for global worry.

RENT-AN-IPOD

Hotels
Serve Up
Portable

Devices

Here’s something Steve
Jobs would love to
listen to: the latest

trend in hotels is making
iPods available for guests.
One among these is Las
Ventanas al Paraiso in Los
Cabos, Mexico, which lets
guests chill out on the
poolside with their own
iPods. The devices are
served full of over a 1,000
songs, ranging from Latin
jazz and classic rock to hip-
hop. Reports have not
indicated whether one can
add to the preset list. 
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Talking Elite
Elite, or “l337,” is the language of
hackers, crackers, and those who
think they are hackers and
crackers. It’s rarely spoken out
loud, and we suggest you leave it
that way—speaking l337 has
become so common that it’s
considered “l4m3.”

Generally, while l337-ing, you
can safely substitute ‘ck’ or ‘cks’
with an ‘X’ (h4x0r, r0x0r, etc.).
Any ‘F’ sound becomes ‘Ph’, like
p|-|34r (Fear). Use a 0 (zero) for
‘o’, a ‘7’ or ‘+’ for ‘T’, ‘4’ for ‘A’, ‘3’
for ‘E’, ‘8’ for ‘B’, ‘5’ for ‘S’, 1 for
an exclamation, etc.

For practical examples,
ph34r +his:

l4m3r / L4|\/|3R (Lamer):
Generally an insult.
Usage: “OMG1 you’re such a
l4m3r, go away before I h4x0r
you.”

d00d (Dude): Anyone or
anything remotely human,
whether male or female.
Usage: “d00d, remember that
d00d we met the other day? The
friend of the d00d with the
yellow car! d00d, that d00d is
such a l4m3r1”

H4x0r / |-|4><0r (Haxor):
Meaning “Hacker.”
Usage: “That d00d says he
h4x0r3d the FBI, either he’s l337
or really l4m31”

r0x0r / r0><0r (roxor):
Meaning “Rocks”
Usage: “That new Linkin’ Park
song r0x0r51”

n00b (Noob / Newbie):
Another insult
Usage: “lol n00b1111”

w007 / w00t / \/\/00+
(Woot!): An exclamation of joy,
like “Whoo Hoo!”, or “Yay!”, but
cooler!
Usage: “w00t1 My AMD Athlon 64
FX just arrived; eat your hearts
out l4m3r51”

Ph47 / p|-|4+ (phat): This
means you are cool and “with it”.
Usage: “d00d, thatz some serious
programming skillz you got. Very
ph47 d00d1”

YoU MaY aLsO tRy TyPiNg
LiKe ThIs, UsInG aLtErNaTe CaPs,
EsPeCiAlLy FoR yOuR
nIcKnAmEs!

When Digit decided to create a special
issue on communication for

November, we were a bit undecided on
the cover. We certainly can’t have a
mobile phone on the cover, can we? It
just too inanimate.

Before we went into metaphysical
manifestations of communication, and
what it means to mankind,
we hit upon a brainwave.
About 10 km from the Digit
office lies a 140-acre
complex that goes by the name of
Dhirubhai Ambani Knowledge City. The
man in charge here is Mukesh Ambani—
Founder, Chairman, and Managing
Director of Reliance Infocomm, a
company that has emerged as India’s
largest communications company, just 18
months after it was launched.

To put Ambani on the cover,
therefore, was a no-brainer. He has the
stature, he has the vision, and he is

technology savvy enough to make India a
world communications superpower. The
big question? Who will bell the cat? As it
happens on all such occasions, this fell
upon Sachin Kalbag, our Executive Editor.

Last year, when Sachin was working in
Mid Day, he casually called up the then
finance minister Jaswant Singh on a

number he got from a
government Web site. Mr
Singh himself picked up the
phone! No such luck with

Mr Ambani; contacting him was tougher
than climbing Mt Everest—he is almost
always out of the office, out of town, or
out of the country!

However, Sachin persevered. Hundreds
of calls later, two days before deadline,
success! The result of the blood, sweat, a
few tears and not to mention big phone
bills (OK, OK, just painful dialling and
typing fingers!), is this month’s cover, and
the Lead Feature in Digital Passion.

Duniya Mutthi Mein?



Other hotels have also
jumped on the iPod-serving
bandwagon—Le Meridien

Cyberport in Hong Kong
and the One & Only Ocean
Club in the Bahamas.

INTERNET SUICIDE PACT

Seven Kill
Themselves
Over The
Internet

According to a Reuters
report, seven
Japanese people are

believed to have killed

themselves following an
Internet suicide pact. The
four men and three
women were found in a car
near Tokyo. They sealed
the windows from the
inside, and lit charcoal
burners—then succumbed
to carbon monoxide
poisoning, which is the
end-result of burning
charcoal.

There are many Web
sites that cater to Japan’s
chronically depressed.
Services range from
bringing together those
wishing to die, to
recommending the best
locations to do it.

Police say that one of
the seven sent an e-mail on
October 11 to a friend
declaring his intention to
kill himself. A police
spokesman said that they
believed that the seven
people “got acquainted
through the Internet.”
Japansese Authorities report
that since police became
aware of Internet suicide
pacts in early 2003, 34
people had died. It is a
trend they would certainly
want to stop.
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Jonathan Schwartz
http://snipurl.com/9x3v

Jonathan Schwartz defends Sun on
OpenOffice.org
Here’s some legal stuff. Dave Rosenberg posts on a ZDNet
blog—http://snipurl.com/9x3u—“In what seems to be one
of the more bizarre and confusing aspects of the unholy
alliance between Sun and Microsoft, Sun’s recent 10k filing
includes previously unseen legalese from the settlement
agreement.” OpenOffice.org is important for Linux distros,
and Sun seems to be abandoning it.

Sun’s new position seems to create “the sort of legal
uncertainty that could dampen corporate enthusiasm for
one of desktop Linux’ most promising open source
projects as well as any Linux distros that are bundled with
it.” Read: Red Hat. And Rosenberg wonders what Jonathan
Schwartz, Executive Vice-President of Software at Sun,
has to say about this.

Schwartz’ response is at the URL mentioned above.
He implores, “Please do not listen to the bizarro
numbskull anti-Sun conspiracy theorists.”

David Weinberger
http://snipurl.com/9x3w

Bayesian Spell-checkers?
Now here’s a bright idea. One of those “Why didn’t we
think of it before” ones. Weinberger talks about how we
could have Bayesian spell-checkers, which would work
just like Bayesian spam filters do. If it hasn’t struck you
yet: the word “cheast” is more likely to be corrected to
“cheats” if used near the word “game,” but if it’s near
the word “heart,” say, it’s more likely to be “chest.” 

Boing Boing
http://snipurl.com/9x3y

Arrested for providing VoIP!
Boing Boing has things ranging from news about a free
tooth flosser to headlines like “What’s happened to George
W Bush’s brain after 10 years?” One post we’re looking at
right now is about American citizen Ilya Mafter, who
started a VoIP service in Belarus. He was arrested for
“damage to the country’s communication providers.” Read
about this at the URL mentioned above. There’s lots of cool
stuff on Boing Boing - for example, check out Mark
Frauenfelder’s links at http://snipurl.com/9x40, and John
Battelle’s beta “Thoughts on the intersection of search,
media, technology, and more,” at http://snipurl.com/9x41.

Anonymous
www.IsBushWired.com

Is Bush Wired? Is he prompted through an
earpiece?
That’s the headline on this cool blog, entirely devoted to
finding out what the squarish lump on Dubya’s back—seen
during his first presidential debate on September 30—is.
We don’t know how long interest in this blog will last,
though, but right now there’s a lot of people gravitating to
IsBushWired.com. Is Bush really wired, the blog asks. Posts
discuss the entire range of theories. Generally, the site is of
the opinion that Bush is indeed wired all the time. Head to
IsBushWired for views by Secret Service Agents, prominent
newspapers, technical experts, and so on, all on the same
subject.

Here’s taking a look
at a few riveting
posts from the world
of blogs. This month,
a serious look at the
benign (?) lump on
Dubya’s back—in
great detail; why an
American was
arrested in Belarus; a
novel idea that seems
obvious once you
think of it—Bayesian
spell-checkers; and
Jonathan Schwartz’
defence of Sun in re
OpenOffice.org. 

You are nearing 30; you
refuse to admit you are
balding; your skills and

qualifications include Martial
arts, breakdancing, chess,
channel surfing, people skills
and a Bachelor of Fine Arts
from the College of Design,
Los Angeles; you want to write
scripts for Hollywood block-
buster flicks, but directors and
producers just don’t under-
stand your need to eat! 

“So that’s the way it’s going to be? Alright, if you can’t
join ’em, kill ’em! By the powers of Shaolin, I will avenge my
dishonour!” You can actaully hire your very own personal
Ninja assassin at Ninja4Hire.com! Cool service, huh?

You throw down your Ninja ball-that-causes-much-smoke
thingy, and disappear from public life—for a few days. You
binge on certain banned substances, damage your brain, are
forced into re-hab, and decide to reform yourself.

The plan takes shape gradually in your head, while you
wait for the hallucenogens to wear off. You buy a domain, you
boast about your achievements and talent, but the cincher is
the fact that you are a Ninja—fast, silent, unseen; you can be
in and out of a building before someone says “Ah So!”; you
can fly, break boards with your bare hands, and have
watched Crouching Tiger, Hidden Dragon 6,872,345 times!

You offer to exact vengeance on behalf of those who are
too chicken to do so themselves. You wait for the calls to
come, for the hits on your Web site to soar, and your Inbox to
fill up with death requests! Four years later, and you’re 
still waiting. 

whatweretheythinking.com

www.Ninja4Hire.com



For Better Or For Worse
I have been reading your magazine for
close to 18 months now. I have always
been impressed by the quality of your
magazine—the text and CD content, and
the constant innovation, which is what
it takes to be the king of the hill.

Digit has always been loyal to its
subscribers—the December ’03 bonus
issue with Ice Age, the June ’04 issue with
the freeware and PDF CDs, and then the
free DVD, and the revised content and
layout of the magazine from August.

The places you have improved are
many. The magazine content is much
better. The articles have greater
relevance for us lesser geeks. Many of the
technologies have reviewed are more
relevant to home users or small
businessmen and SoHo users, rather
than the lengthy articles on gadgets and
technologies that would take a long time
to make an impact in the Indian market.

The clear demarcation of the articles
under ‘Digital Passion’, ‘Digital Tools’,
‘Digital Business’, etc, is very useful. New
columns such as ‘30 days with...’, ‘Old
Way Tech Way’, are quite innovative and
fun to read. 

And obviously, the DVD is a big boost
because you can give us more software,
games, whitepapers…

The Digit Patron Programme is an
excellent step in cementing our
relationship. It’s a win-win situation. The
quality of response by the Digit staff has
always been amazing and should
continue to be so.

And now for the downside. I really

think that your product reviews are
steadily becoming worse. Not only are
they not as detailed as before, the
replacing of the ‘Best Value’ and ‘Best
Performance’ awards with ‘Best Buy’
does not help the reader. 

Even though you have employed
better colours and fonts, the new layout
of the magazine is definitely much more
cluttered.

I hope Digit continues to innovate,
and at the same time, learn from
feedback to forever retain their place as
India’s best tech magazine. Best of luck,
Digit.

R Harshavardhan,
Hyderabad

When My Landline Is Listed,
Why Not My Mobile?
With reference to Sachin Kalbag’s
editorial in the October issue (‘I Got Your
Mobile Number’), I would like to say this:
Think of landlines. Do all the numbers
find mention in the directory?
Furthermore, how regularly is the
directory published? 

The companies supposed to operate at
the cutting edge of communications
technology do not have a system to
ascertain outstandings! They are adept at
sending you your bills, but cannot use
couriers to deliver your directory. Perhaps
the bottom-heavy ‘nigams’ find this a way
of saving on stationery and printing!

Why do the mobiles not make a
beginning by making numbers available
on their Web sites? The argument that
not all users are net-savvy does not hold
water. Surely the mobile user is more
savvy than the plain landliner!

Mobile spam is nothing new.
Advertisers can send spam to numbers in
a simple, unitary progression starting
with, say, 00001, prefixing the service
provider’s code for the town, which is a
constant anyway. It is the option of being
able to mask the sender’s ID that needs to
be prohibited.

When the US can do it with their “do
not call” registry, why can’t we?

All said and done, a mobile is only a
telephone without wires. So where is the
hassle? India needs sensible laws, smart
and unfettered law enforcement, a
sensitive judiciary and most of all,
national pride in being law-abiding
citizens.

Ram G Prasad,
Chennai
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Subject How English is a 
Language for Nuts

saROMan
Resident Techie
Location: b4 my PIII

English is the most widely used language in
the history of our planet. But let’s face it—
English is a crazy language. There is no egg
in an eggplant nor ham in a hamburger;
neither apple nor pine in a pineapple.
Sweetmeats are candies while
sweetbreads, which aren’t sweet, are meat.

You have to marvel at the unique
lunacy of a language in which your house
can burn up as it burns down, and in
which you fill in a form by filling it out.

English was invented by people, not
computers, and it reflects the creativity of
the human race (which, of course, isn’t a
race at all). That is why, when the stars
are out, they are visible, but when the
lights are out, they are invisible. And why,
when I wind up my watch, I start it, but
when I wind up this essay, I end it.

****************************************

Kl@w-24
Digitized!
Location: HTTP:404 Not Found!

Goto : source 
[Ctrl+A] 
[Ctrl+C] 
Goto : forum 
[Ctrl+V] 
Source=?

*****************************************

diab0lic666
In-House Geek

*yawns*
Don’t have time to read whole post. 
Whatever is written, we still gotta
communicate in English

****************************************

klinux
Resident Techie

In a couple of years, the number of people
speaking Indian English, with all
Indianised accent, which has mostly come
down to neutral, would outgrow the
number of English speakers like the
Americans, Brits and Aussies. 

Hinglish / Tamlish would be dominant
in just a few years. There was a joke where
we had outsourced our call centres and
had Americans helping solve our probs
over the phone. They would have all Indian
names, and classes on how to talk Hinglish.

For the Tamil guys: think abt American
call centre agents having alias names like
Kandaswamy, Munniamma, etc. and having
to learn Tamil slang. That would be fun.

From The Digit Forum

To post your comments on the Digit Forum, 
visit www.thinkdigit.com/forum



Room For Improvement
I am a regular reader of Digit, and I am
delighted with your new way of
presentation. I would like to thank your
crew members for making Digit the #1
magazine. 

I guess you may even be called the No
1 magazine across all segments, but only
the fact politics in India takes precedence
over technology prevents one from doing
so. 

Having said that I shall be obliged if
you could make further improvements to
Digit. My list of improvements: 

Include 10 pages for game reviews,
reviewing 10 games that have been
released or are yet to be released

Decrease the length and width of the
magazine, so it will be easier to hold

Give us, along with the DVD, the two
best full-version games, one of 1.4 GB and
the other of 700 MB

Include recent developments, and
interview IT companies’ representatives
to explore their vision

Continue with the MoserBaer CDs to
ensure durability

Do not hike the price, please
Bobin M Koshy,

On e-mail

Poster Boy
I like the new stuff you keep doing all
the time. However, there are certain
things that can involve reader
participation. I would like you people to
include wallpapers, themes, skins, as
you used to earlier. I think if you could
give out a couple of posters each month,
more people would be part of the Digit
family. Include posters of games,
celebrities, cars, bikes.

Siby Mathew,
On e-mail

Two Thumbs Down To Digit
I stopped buying Digit a long time ago.
However, I fell for your DVD offer with
the September issue. Great DVD
content, I must say. But whatever
happened to your magazine and CD
design? They are pathetic, to say the
least. I remember Digit advertising for
prospective employees with a slogan
“where very good is not good enough”
or something like that. So if the
excellent employees of Digit manage to
come up with a magazine of this
quality, I guess excellent is really “not

good enough.” To all the excellent
employees of Digit then, here’s a big
thumbs down for the crappy magazine
you have come up with.

Srijan,
Nepal

Gimme Two CDs!
All the way from the old-look Digit to the
revolutionary new Digit, you guys have
given us so much. It’s just amazing. By
the way, where have your Annual Web
Awards disappeared? 

Also, I know that after some time
there will only be DVDs in place of CDs,
but let that happen after DVD players
become common enough. I renewed my
subscription this June and was dead sure
of two CDs of great infotainment for the
next 12 issues, but I am very disappointed
to see that I am getting only one CD.
Please think about it. But I guess, we will
have to move with the times, just as
magazines moved from floppy disks to
CDs six years ago.

As for gaming, why there is nothing
about Max Payne 2—The Fall of Max Payne?
Please include some tips and tricks on it.

Nitin Agarwal,
On e-mail

Cluttered Reviews
I love your magazine. I am amazed that I
wait for the next issue of the Digit each
month. Though not a subscriber, I never
fail to buy it. The new revolution in the
magazine design is superb, but it would
be more convenient if the reviews are of
individual type as in the past. It would
help buyers decide fast. The current
reviews seem to be cluttered, and
individual product details are given less
importance. Here’s hoping you would
take up the issue.

R X Marshall,
Tuticorin

Inbox

In the October 2004 issue, the Net
Gain article was on page 54, not on

page 52 as mentioned. Also, Tips &
Tricks was on page 55, and not on
page 54 as mentioned. We apologise
for the error. 

Pointed out by Chaitanya
Notice any goof-ups? 
Write to goof@jasubhai.com

Goof-ups

Write To The Editor
E-mail editor@thinkdigit.com

Snail Mail The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate,  Nerul, 
Navi Mumbai 400 706.  

Digit will publish the best letters on these pages.
Letters may be edited for clarity.

For subscription queries, call the Help Desk at 
022-27629191/9200 Fax 022-27629224, or send an e-
mail to help@jasubhai.com
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The Journey Is The Reward
I have been following with interest
the many changes brought about in
Digit, as also the reactions to them
published in these pages. I want to
talk about the magazine, however,
from a non-techie perspective.

I am a chartered accountant, and
to me, PCs were nothing but glorified
typewriters, since I used them for
nothing apart from Microsoft
Word, and at times, Excel. 

It was in July 2001 that I
was introduced to Digit by my
father. I had missed the
anniversary issue in June 2001, and
it would be my eternal regret. In fact, I
missed the next anniversary issue too.
All this motivated me to turn
subscriber. I used to install the entire
CD, read the mag from cover to cover,
cut out relevant articles and put the
CDs in a holder... I used to apply every
Tip & Trick, and became a 30-Minute
expert many times over.

My learning has reached amazing
levels and the kinds of tweaks I do or
suggest to my friends shock them to
such an extent that they look at me as
though I were somewhere between a
geek and a hacker. 

Among the other changes is that
Digit has had four editors since then,
and has lost, I think, four wonderful
people. For some strange reason, I miss
them all even though I didn’t know any
of them. With each change, new people
with new ideas and concepts have
come. Some I like and some I don’t. I
like the contents of the CDs (DVDs
now), but I  don’t like the over-
emphasis on games.

What I would like to see more is...
an issue dedicated to building Web
sites or creating Web pages. The
software that can be used; who allows
hosting of Web pages for free and for a
charge; how to use and upload the
pages in public communities, how to
make small Java applets; the Tips and
Tricks section, you know, the works. Or
an issue related to MS Office
applications—especially advanced
functions in Excel. 

On the whole, though, it’s been an
affair that has changed me inside out,
and the journey has been my reward.

Basant Venugopal,
On e-mail

Letter 
of the
Month



What’s the best way to
avoid attending a

wedding—especially that of
your ex-girlfriend’s? Sell the
invitation on eBay, of course.
That’s exactly what a UK man
did recently. His ad read:
“...She’s a dog. No really.

I haven’t seen them since
I told her she’s a dog...
They’ve stupidly invited me
to their wedding, but I don’t
want to go.”

The bidding reached a
fabulous $18,200 before
frivolous bets were cancelled.
But after three revisions to the
posting, the man cancelled the
item, and here’s the happy
ending it finally got to:

“I still love the old dog,
despite what she did to me. ...
I’m going to pull the auction...
see whether she’ll... marry me
instead...”

Now Here’s
Serious Tech
Support

Microsoft Chief
Executive Steve
Ballmer said at a

press briefing in London on
October 3 that the
future of digital
technology in the
home rests with
Microsoft and not
with Apple. He also
said that the
majority of the
music stored on

Apple’s portable music
players was “stolen.”

Ballmer firmly believes
that the majority of music

stored by customers on
iPod and iPod Mini
devices is illegally
copied. “The most
common format of
music on an iPod is
‘stolen’,” he said.
“Most people still steal
music.” The war is on.People And Events That Grabbed Headlines—For Better Or For Worse

It was all about a mysterious
bulge—a boxy kind of lump—
under Bush’s suit jacket

during the first Presidential
debate in October. Still photos
of the debate show up the
bulge, between the President’s
shoulder blades. the election
may be over, but speculation
was rife that Bush was wired;
that he got cues from, say,
national security adviser
Condelezza Rice, through a
wireless device attached to his
back. In other words, the
President was being prompted
during the debate. “The Mystery
of the Bulge in the Jacket” was the
headline of the item in The New
York Times.

Assuming Bush was wired,

what was the
device? Some say
it was an audio
transceiver. On
October 13,
salon.com
quoted technical
expert Alex
Darbut: “There’s
no question
about it. It’s a
pretty obvious
one—larger than
most because it
probably has
descrambling capability.” For
more, head to
www.IsBushWired.com.

All we have to say about
this is, if it’s legal, Bush
should do it. He needs it! And

not just in presidential
debates—he needs a
prompting device on just
about any occasion. In fact, he
shouldn’t leave home without
one, should he?

Was That Lump Benign?

Bush at the debate, with that boxy lump on his back
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Head to docs.info.
apple.com. That’s, of

course, the place for
documents containing
information on Apple
computers. Including the
iMac G5. If you look closely,
this page comes under the
“Support” tab. At this point,
make the URL  http://docs.
info.apple.com/article.html?
artnum=86816. And hey,
what have we here? A tech
support document on how
to transport your Apple iMac
G5. Sound too simple? Wait
till you read what’s on the
page:

“Don’t know how to pick
up and carry your iMac G5?
It’s easy. Before moving your
computer, make sure all
cables and cords are
disconnected.

“Pick up the iMac G5 by
grasping both sides of the
computer. Carry it to
wherever you wish.”

We are not kidding! This
really is from a tech support
document. Where’s the link?
Hold this magazine still in
your hands, then move your
eyes a little to the top. Look
at what’s there, and read it.
Simple, huh?

And we thought Apple
users were supposed to be
sexier and more tech-savvy
than the rest of us. Until
this bit of tech help came
along...

David Beckham has joined
the ranks of Britney

Spears, Anna Kournikova and
others, in an odd sort of way.
There’s a Trojan-horse kind of
virus out there that comes
wrapped in an e-mail that
promises pictures of Beckham.
Not of him scoring a goal,
though. The pictures the e-mail
claims to lead to are those of
him “caught by photographers
with his pants down...pho-
tographed with a Spanish
(prostitute) in a rather compro-
mising position.”Invitations to a “dog’s” wedding

iPodders Are Thieves!

The Beckham
Code

One Wedding And An Auction


	Editorial
	Enter
	Digital Passion
	The Man Who Saw Tomorrow
	Take A Crack
	Banks on Technology
	The b3nding ov the rul3z
	Greek Dreams
	Masters of the Game

	Digital Tools
	Making Sense of the Mad Ad World
	Second Chances
	New & Notable
	A-List
	10 Great Things Your Fixed wireless terminal offers
	Net Gain
	Tips & Tricks
	www.mybusiness.com
	Old Way Tech Way
	Q & A
	Buyers Guide

	Digital Business
	IT Cuts Red Tape
	Laser-Sharp
	Dial IP for Internet
	Business on the Mobile
	Trend
	Face-Off

	Digital Leisure
	Dial-a-Hospital
	TQ
	MediaWise
	TechCritique

	Escape
	Digit Forum
	Tabloid Tech



